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Welcome to Using Dashboard

This guide describes how to work with Mercury Business Availability Center
Dashboard.

How This Guide Is Organized

Part |

Part Il

Part Il

Part IV

The guide contains the following chapters:

Dashboard Overview

Introduces the Dashboard concept and describes how Dashboard fits into
the Mercury Business Availability Center architecture.

Working with Dashboard

Describes how to work with Dashboard and the Dashboard views, how to
use the Top View tab, the Console tab, the Filters tab, the Geographical Map
tab, the Custom Map tab, the Topology Map tab, Mercury Dashboard Ticker,
and the Deep Transaction Tracing view.

Dashboard Reports

Describes how to view the Configuration Item Status Alerts, KPIs Over Time,
Raw Data Over Time, SLAs Summary reports, and how to use the report
repository.

Working with Real User Monitor Data

Provides detailed information about the content and structure of the Real
User Monitor views.
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Part V

Part VI

Part VII

Working with the SAP Solution

Provides detailed information about the specific tasks involved in using
Mercury Business Availability Center for SAP and about the content and
structure of the SAP Systems view.

Working with the Siebel Solution

Provides detailed information about the specific tasks involved in using
Mercury Business Availability Center for Siebel and about the content and
structure of the Siebel Enterprises view.

Working with Deep Transaction Tracing Data

Provides detailed information about the specific tasks involved in using
Deep Transaction Tracing that provides a monitoring layer for collecting
information about the behavior of transactions within the target machine.

Who Should Read This Guide

This guide is intended for the following users of Mercury Business
Availability Center:

» Mercury Business Availability Center administrators

» Mercury Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using
enterprise applications, and be familiar with Mercury Business Availability
Center and enterprise monitoring and management concepts.
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Getting More Information

For information on using and updating the Mercury Business Availability
Center Documentation Library, reference information on additional
documentation resources, typographical conventions used in the
Documentation Library, and quick reference information on deploying,
administering, and using Mercury Business Availability Center, refer to
Getting Started with Mercury Business Availability Center.

xi
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Introduction to Mercury Business
Availability Center Dashboard

Mercury Business Availability Center Dashboard enables you to monitor the
system performance of your organization’s IT universe and to view the
results in several formats.

This chapter describes: On page:
About Dashboard 3
How Dashboard Works 6
View Explorer 8

About Dashboard

Mercury Business Availability Center Dashboard is an interactive digital tool
that enables you to assess real-time system performance and availability in a
business context. Dashboard provides extensive infrastructure monitoring
under a single umbrella, giving you a consolidated view of the current
operational status of your organization.

This section includes the following topics:

> “Collecting and Aggregating Data” on page 4

» “Prioritizing IT Operations and Maximizing Business Results” on page 4
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Collecting and Aggregating Data

Dashboard utilizes data collected by Mercury Business Availability Center
monitoring components, such as Business Process Monitor, SiteScope, and
Enterprise Management Systems (EMS) integration tools, as well as data
collected from external monitoring tools. Mercury Business Availability
Center collects metrics about the end-user experience from a range of
environments, including ERP, CRM, Web, and Citrix, and about system
performance from a range of back-end infrastructure components, including
Web, application, database, and firewall servers.

The collected and aggregated data is used by the Dashboard KPIs (Key
Performance Indicators) to provide quantifiable measurements that help
you monitor how well your business is achieving its objectives. The KPIs
provide a real-time assessment of the present state of your business and
processes, enable you to track critical performance variables over time, and
help assess the business impact of problems in the system.

At the top level, Dashboard provides an integrated view of critical
applications and business processes; from there, you can drill down to the
underlying IT infrastructure associated with these critical business processes.
This drill-down view can be laid out in any number of ways, such as by data
centers, by technology clusters, by geographical locations, and so forth.

Prioritizing IT Operations and Maximizing Business Results

Dashboard helps you to prioritize IT operations and maximize business
results by:

> presenting global system component data organized into a logical and
relevant framework.

» providing integrated, scalable, cross-application views that reflect the health
of mission-critical services and applications in real time. This enables IT
operations teams to continuously manage the health of mission-critical
services and applications from one central location.

» providing a common view of how IT operations are meeting line-of-business
goals. This enables better communication between the teams, and the
alignment of management and IT operations around customer-centric
values.
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» providing the ability to assess actual customer impact, so that IT teams can
prioritize response according to business impact and optimize resource
utilization to meet critical business objectives. The end result is better
quality of service for your end users.

» providing a big-picture perspective, enabling you to see how a performance
issue impacts the availability of any part of your business and allowing you
to quantify the business impact of a potential failure.

» providing operational-level service level management reporting. Dashboard
uses Service Level Management data to provide an indication of whether an
SLA is in breach of contract, or may be in breach in the near future.
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How Dashboard Works

The physical and logical entities in your system, such as hardware, software,
services, business processes, and so forth, are represented in Dashboard by
configuration items (CIs). The CIs are stored in the Mercury Universal
CMDB, and organized into hierarchical format based on the
interdependencies in your organization’s IT environment.

You view the CIs in Dashboard in service views. Each service view provides a
different aspect of your organization’s IT universe, enabling you to focus on
the IT area that is of interest at that point in time.

Each CI has one or more KPIs showing current operational status or business
impact over time. Status propagates up the CI hierarchy, from the monitor
(leaf) CIs at the bottom of a tree, up to the root CI shown at the top of the
tree. The monitor CIs receive real performance metrics from the monitoring
data flowing into Mercury Business Availability Center, and KPI status for
these Cls is calculated from that data. For all higher level CIs, KPI status is
based on an aggregation of statuses for all child CIs (the calculation method
used for this aggregation varies, according to the business logic the KPI is
using).

The child CIs for a CI may not be visible in a view, but the KPI status shown
is still based on the status propagated up from the hidden child ClIs.

The incoming report data is updated every 30 seconds (configurable default
value), so that the status information displayed in Dashboard represents the
real-time availability of your organization’s infrastructure components.

This section contains the following topics:

» Monitoring Performance Problems

» Monitoring Service Level Agreements
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Monitoring Performance Problems

When a problem is identified, you can drill down to locate the source of the
problem, view event reports, and track problem handling. You can also
move directly to the appropriate pages in Mercury Business Availability
Center to view reports for problematic components, measurement data over
time, and general monitoring data.

In addition, Dashboard enables you to view operational status from the
viewpoint of geographical locations, so you can see which locations are
impacted by problems.

Monitoring Service Level Agreements

You use Service Level Management to operate your applications and
infrastructure according to the service contracts you have with your
customers. In Dashboard you can view an SLA information bar that gives
you advanced warning of any potential breaches of contract, and you can
act proactively to fix a problem before it causes financial damage.
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View Explorer

Mercury Business Availability Center View Explorer enables you to locate
configuration items (ClIs) in the application with which you are working, for
example, Dashboard, Service Level Management, or IT Universe Manager.
View Explorer also enables end users to view IT elements and the
relationships between them, to select Cls, and to perform operations on the
Cls.

P 1— Browze|Search|
@|E =
Wiew: IMonitors View J

2 17 Monitors View
EE bpr_profile_1
= '_?3 bprn_profile_2

= ﬁ tx_10

[7 tx_15
E=: tx_1_failed
E=: tx_2_failed
E=: tx_ 5
EEE crn_profila_1
EE? crn_profile_2
@ fist_bprn_profile_1
GS fist_bprm_profile_2

FH EHFHMH

s

L. sis_profile_1

The View Explorer pane is displayed for most tabs in the Dashboard. For
details, see “Using View Explorer” in Working with the CMDB.
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Dashboard Menu Options

From most tabs in Dashboard and from the View Explorer, you can access
right-click menu options that enable you to move to different tabs or
applications filtered for the selected CI.

This chapter describes: On page:
About Menu Options for Cls 9

List of Menu Options 10

Show Path to Root Option 43

Show Problematic Subtree Option 43
Acknowledging Performance Problems 45

Find Visible and Hidden Child CIs Option 49

About Menu Options for Cls

w

Click the down arrow on the right of a CI name to access the menu options
for that CI. The options that are available depend on the type of CI and on

the context menu defined for the CI. If no context menu is defined for the

CI, then the menu arrow is not displayed. If one of the menu options is not
supported for the selected CI, that option is shown disabled.

The menu options are available for Cls in the Console and Filters tabs, and
in View Explorer.

For information on the various menu options, see “Context Menus
Repository” in Application Administration.
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The menu options available for a CI may include the following
functionality:

Enable you to move to other Mercury Business Availability Center
applications or SiteScope to view information and reports related to the CI,
or to open standalone reports or views. For example, you can view a trend
report on the End User Management page, containing measurement data for
the CI over a specified time period.

Enable you to move to the Filters tab to view Cls for a CI’s subtree. You can
select an option to filter the subtree CIs and monitor Cls, in which case the
CIs are filtered according to the current active filter selected in the Filters
tab.

List of Menu Options

10

Y Y Y Y Y Y Y Y VY VY Y

The menu options that are displayed in Dashboard View Explorer and in the
main page of the Console and Filters tabs, depend on the selected view and
on the selected CI. They can be a subset of the options described in this
section. The options are listed in alphabetical order.

This section includes the following topics:

“Acknowledgment” on page 11
“Application Mapping” on page 11
“Drill to Diagnostics” on page 13
“Filters” on page 15

“Find Visible and Hidden Child CIs” on page 16
“Go to Report” on page 17

“Go to Siebel Diagnostics” on page 35
“Properties” on page 40

“Show Content” on page 41

“Show Related Cls” on page 41

“Top View” on page 42
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Acknowledgment

Displays a list of options similar to options in the Top View tab to view
different trees centered on the selected CI.

This section includes the following topics:
» “Acknowledgment Details” on page 11

> “Set/Unset Acknowledgment” on page 11

Acknowledgment Details

This option is available for all Cls.

It opens the Acknowledgment details page that displayed information about
the CI's acknowledgment. For more details, see “Acknowledgment” on
page 11.

Set/Unset Acknowledgment
This option is available for all Cls.

It opens the Set/Unset Acknowledgments page where you can set or clear
the CI's acknowledgment.

For details, see “Setting or Unsetting Acknowledgments” on page 48.

Application Mapping

Displays a list of options that enable you to open specific capabilities
provided by the shared CMDB feature filtered by the selected CI.

This section includes the following reports:

» “Show Impact” on page 12

» “Problem Isolation” on page 13

11
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Show Impact

This option is available for SAP-specific Cls. This option is displayed only if
you have installed shared CMDB.

It opens a dialog box that shows the impact of a root cause object by
displaying all the objects that are affected by it. For details about the report,
see “Showing Impact for SAP CIs” on page 249.

| =3 |IH|erarch|caI Layout vI 7 |\'1-' =

TEEEIECY ERERELIE

MIGKE00370

SAP_Transport_Transaction[2]

ZMTRANSH
| SAP_Transport_Transaction[2]

EaF
inspection systen Label; inspection system for testint monitorin
Configuration Iter Type: SAP Application Component

Category Status Correlation Is new

E Mew

change B Mew

For details about the SAP Systems view, see Chapter 19, “Using the SAP
Solution”.
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Problem Isolation
This option is available for SAP-specific Cls. This option is displayed only if
you have installed shared CMDB.

It isolates a CI's problem in a separate browser dialog box. For details about
the report, see “Isolating a Problem for SAP CIs” on page 250.

| = ||Hierarchical Lawout vl 7 |\"—' = | @ @’5_@?};

QR BEDD K|
MISKI00370

SAP_Transport_Transaction[2]

ZNTRANGT

For details about the SAP Systems view, see Chapter 19, “Using the SAP
Solution”.

Drill to Diagnostics

Displays a list of options that enable you to open specific pages in the
Diagnostics application filtered by the selected CI. This option is displayed
only if you have installed Diagnostics.

This section includes the following reports:

“Layers View” on page 14
“Server Requests” on page 14
“Summary View” on page 14

“Transactions View” on page 15

13
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Layers View

In the Diagnostics View, this option is available for all Probe Group, and
Probe CIs. In the End User Monitors View, this option is available for the
Business Process Step Cls. This option is displayed only if you have installed
Diagnostics.

The option opens the Layers (Load) view, with the following characteristics:

For a Business Process Step CI, the view displays the layer(s) of the
transaction that corresponds to the Business Process Step CI.

For a Probe Group CI, the view displays the performance metrics for the
Probe Group.

For a Probe CI, the view displays the performance metrics for the Probe.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Server Requests

In the End User Monitors View, this option is available for the Real User
Monitor Business Process Step Cls. This option is displayed only if you have
installed Diagnostics.

The option opens the Server Requests View in the Mercury Diagnostics
application with the URL(s) that correspond to the Real User Monitor
Business Process Step Cls selected.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Summary View

In the Diagnostics View, this option is available for all Diagnostics Probe
Group and Diagnostics Probe Cls. This option is displayed only if you have
installed Diagnostics.

The option opens the Diagnostics Probe Group Summary View for the probe
or the probe group in the Mercury Diagnostics application.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.
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Transactions View

In the End User Monitors View, this option is available for all Business
Process Step Cls. This option is displayed only if you have installed
Diagnostics.

The option opens the Transactions view that displays performance metrics
for the transactions that are being executed by your applications. The
transaction that corresponds to the selected Business Process Step CI is
highlighted.

For more information about Diagnostics, refer to Mercury Diagnostics User’s

Guide.

Filters

Displays a list of filters you can use to display subsets of the selected CI’s
children on the Filters page.

This section includes the following topics:

“Filter Subtree” on page 15
“Filter Subtree Monitors” on page 15
“Show Complete Subtree” on page 16

“Show Subtree Monitors” on page 16

Filter Subtree

This option is available for all Cls.

It opens the Filters page, which displays the selected CI subtree filtered by
the active filter.

For details, see Chapter 6, “Dashboard Filters”.

Filter Subtree Monitors

This option is available for all CIs.

It opens the Filters page, which displays the monitor CIs in the subtree of
the selected CI filtered by the active filter.

For details, see Chapter 6, “Dashboard Filters”.

15
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Show Complete Subtree

This option is available for all Cls.

It opens the Filters page, which displays the complete subtree of the CI as if
it was filtered by the Show All active filter. That filter appears in the Active
Filters box.

For details, see Chapter 6, “Dashboard Filters”.
Show Subtree Monitors
This option is available for monitor Cls.

It opens the Filters page, which displays the monitor Cls in the subtree of
the CI as if it was filtered by the Show Monitors Only active filter. That filter
appears in the Active Filters box.

For details, see Chapter 6, “Dashboard Filters”.

Find Visible and Hidden Child Cis

This option is available for all Cls.

It returns all the visible and hidden child CIs of the selected CI that appear
in the CMDB.

fist_bpr_profile_Sanity_1_1

Performance (4#%  Availability %%

Manme Performance Availability Visible -
ad sl

[=:t><_l,le||ow1 [ @+ W Search

'f:tx red3 A Q=? W Search

'f:tx_greenS @=? @+2 W Search

[=: ta_faill &+t W Search

r==. 0o £ 3 - R v Saarrh |

For details, see “Find Visible and Hidden Child CIs Option” on page 49.
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Go to Report

Displays a list of options that enable you to access all types of reports that
display information about the selected CI.

This option is available for all Cls.
This section includes the following topics:

“Change Rule” on page 18

“Component Topology” on page 19
“Configuration Item Status Alerts” on page 20
“End User Summary” on page 20

“Event Count Over Time” on page 21

“Event Summary” on page 22

“Event Summary (Errors Monitor)” on page 22
“Event Summary (Event Monitor)” on page 22
“Event Summary (Http Error Monitor)” on page 23
“Event Summary (Information Event Monitor)” on page 23
“KPIs Over Time” on page 23

“Raw Data Over Time” on page 24

“SAP Transaction Changes” on page 25

“SAP Transport Changes” on page 26

“Server Summary” on page 27

“Service Level” on page 28

“Session Analyzer” on page 29

“Show Related RFCs” on page 29

“Siebel Cross-Performance” on page 30
“SiteScope” on page 31

“Tracking” on page 32

“Transaction Analysis” on page 33

17
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“Trend” on page 34

“Triage” on page 35

Change Rule

This option is available for all CIs whose properties have changed.

It opens the Change report for the CI. The Change report displays
information about the changes made to the properties of ClIs for all CIs that
were assigned to keep this information.

Change page size: adl il @@

CI changes
1 1 22 5] )
CIT . old .
CI label= cI athribute MNew Value Change Datef&Time Changer History
Name Value
N Sun May 28 17:25:52 Discovery! ELh
dancer.mercury.co.ill192.168,89.31 1P IP DNS Mame dancer, mercury,co.il None IoT 2006 SNMP_NET_Dis_Connaction l&]
N N Sun May 28 17:32:19 N . N ELh
dancer.mercury.couil Unix Host Hame dancer None IoT 2006 Discovery: Host_ID_Discover l&]
N N Host Cperating Sun May 28 17:32:19 N . N ELh
dancer.mercury.couil Unix Gusbarn Sunos None IoT 2006 Discovery: Host_ID_Discover l&]
) 4 aus 5]
Relationship changes
3l 4] e ote 5] 0
_ Event Container's Related's
Container label = type Related label change Date&Time changer History History
dancar.rnercury. co.il 0002pA101200 Sun May 22 17:25:52 IDT  Discovery: ELE ELF
[Unix) gdcedier (interface) 2006 SMMP_MET_Dis_tConnection (] (&3]
dancar.rmercury, co.il X Sun May 22 17:25:52 IDT  Discovery: ELE ELF
(Unix) Added €I 192.168,89,31(ip) 2006 SMMP_NET_Dis_Connection &3]
dancar.rmercury. co.il . Sun May 22 17:25:52 IDT  Discovery: EEF
(Unix) felze) € Afiieriees) 2008 SMMP_NET_Dis_Connection (&3]
dancar.rmercury, co.il Sun May 22 17:25:52 IDT  Discovery: ELE ELF
(Unix) Rldzel € enmElsnmE) 2008 SMMP_NET_Dis_Connection (5] (&3]
(dua:i;e)r.mercury.co.ll Added €I telnet(telnet) g;gsma"' 28 17:32:19 10T Discovery: Host_ID_Discover = \ﬁ
dancar.rmercury, co.il Mon May 29 10:37:44 IDT . ELE ELF
{Unix) Added CI HHE(HE) 2006 User: admin = (s

Go To Wiew Statistics
Go To Wiew Snapshaots

6] 1] v ore 18]

For details about the report, see “Change Report” on page 199.
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Component Topology

This option is available for Deep Transaction Tracing Cls.

It opens the RTM report. The RTM report displays a top view map for the
flow of information across components in the target machine, over a
specified time period. The report shows activity for all components on the
machine during the time period, not for any individual transaction. The
report also displays statistics on the interaction between components (for
example, failed, late, and total counts for events).

» Component Topology Analysis {Static Mode - Switch to Dynamic Mode ) Project: 1
Flantsdy uuen>phens
Session Bean| servert ;l
' ronenmz-il
07072265
Shopping Cart
Plants Byiiab Sphere
sarver]
ranenm-il 010 F2265
07072265

Servlet

—
0703060
07072265

Shopping Serviet

Plarits Bywiizb Sphere i

sanrer] UL
ronenmz-i

07072263

05074530

Fehopping jsp il
el | :
=

7 T —==vpeey E
Faym Completed. Displayed 10 nodes.

f ki 021062006 0000 (MMdd ey HH:mm)
Set Time to:ILast 48 hours .., | w | By Siclisites et me: [ Show &ll statistics
toiloz/os/z006 0000 (MMdd sy HH:mm)

A Grouping | a Edge | a Layout | Run Query | Save Sek.., | =] ||  Zoom | [3 | | @ll o ﬁ vl

For details about the report, see “Component Topology Report” on
page 334.

For details about the Deep Transaction Tracing Sites view, see Chapter 25,
“Working With Deep Transaction Tracing”.
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Configuration Item Status Alerts
This option is available for all Cls.
It opens the Configuration Item Status Alerts report for the CI. The

Configuration Item Status Alerts report lists all the alerts that occurred in
the specified period of time:

Wiew I Past week 'I From: 2/10/05 2:52 P To: B/17/05 2:52 PM Israel Standard Time 4|0 % Q] I'_% @u
Confiquration Tterns: Filterad

KPLs: Al Generate
Status = Time Alert Name Configuration Ttem KPI Alert Action Details |~
Ly Critical /17705 2125 PM alert_worsen 28 bpmz Perfarmance Access asd

Uy Critical 8717705 1:11 PM aler_worsen g}bme Performance Access asd

O Critical 2/17/05 11:11 AM alert_worsen 2% bpm2 Performance Access asd &

For details about the report, see Chapter 12, “Configuration Item Status
Alerts Report”.

End User Summary
This option is available for Real User Monitor-specific Cls.
It opens the End User Summary report. The End User Summary report

displays data for specific end users that were configured for Real User
Monitor in Monitor Administration.

1500.00 9500
L Latency
1350.00 8550 —3— Page Hits
1200.00 7600
1050.00 T GE50
—  900.00 5700 @
E Latency Threshold (g00.0 o
‘7 750.00 4750 ¢
£ 3
F  soo.oo0 3800
450.00 2850
300.00 1900
150.00 250
0.00 0
= =
o o
o o
= =]
(v} w
= =
2 2
u u
L] L]

94504 4:00 Fr

9504 12:00 Ak
90504 Z:00 Ak
945/04 4:00 Ak
S45/04 :00 Ak
S45/04 S:00 Ak

9504 10:00 ARk

S¢5/04 12:00 P
94504 S:00 PR

9504 10:00 P

For details, see “End User Summary Report” in Using End User Management.
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For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard”.

Event Count Over Time

This option is available for Real User Monitor-specific ClIs.

It opens the Event Count Over Time report. The Event Count Over Time
report displays data for all events, or sessions with events, in monitored

applications that you configured in Monitor Administration, broken down
by time intervals.

Ul Request not found
U Request refused

8M4 22 29 95 anz

Time

For details, see “Event Count Over Time Report” in Using End User

Management.

For details about the Real User Monitor views, see Chapter 18, “Real User

Monitor Views in Dashboard”.
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Event Summary
This option is available for Real User Monitor-specific CIs.
It opens the Event Summary report. The Event Summary report displays a

summary of events in monitored applications that you configured in
Monitor Administration.

HTTP Errors Application Errors

_| Request not found | LessThandk
o Bad uzerrequest ol TwoFailedPages

Informational Events

(=

Mo data was found,

For details, see “Event Summary Report” in Using End User Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard”.

Event Summary (Errors Monitor)

This option is available for RUM Error Events ClIs.

It opens the Event Summary report. For details, see “Event Summary
Report” in Using End User Management.

Event Summary (Event Monitor)

This option is available for RUM Informational Events ClIs.

It opens the Event Summary report. For details, see “Event Summary
Report” in Using End User Management.
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Event Summary (Http Error Monitor)
This option is available for RUM Http Error Events Cls.

It opens the Event Summary report. For details, see “Event Summary
Report” in Using End User Management.

Event Summary (Information Event Monitor)
This option is available for RUM Informational Event Monitor Cls.

It opens the Event Summary report. For details, see “Event Summary
Report” in Using End User Management.

KPIs Over Time
This option is available for all CIs.
It opens the KPIs Over Time report for the CI. The KPIs Over Time report

shows the status or value, over time, of selected CIs and KPIs that are
accessible from the Dashboard application.

View as Graph View as Tabla
Wiew: | Past year 'I From: 4/25/05 7:23 Ak To: 4/25/06 7:23 AM Eastern European Time 4| r &' 'D -5
Configuration Tterns: Business Processes  KPIs=: All
Reporttype: {8 Statuses 7 Walues Generz
Configuration Ttem KPI Status
i iBusiness Processes Performance ).?'K ";"
i ‘Business Processes Awail ability A '\;_‘g‘
{ iBusiness Processes Walurme A s
T T T T T
2:22 PM Fi23 PM 1:23 AM T2 AM

M ok O warning

D Minor D Major . Critical . Downtime D Mo Data

Mote: The report will show data only on Configuration Iterns that have historical data for the selected KPIs,

For details about the report, see Chapter 13, “KPIs Over Time Reports”.
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Raw Data Over Time

This option is available for all Cls.

It opens the KPIs Over Time report for the CI. The Raw Data Over Time
report displays raw data over time for selected configuration items, received
in the data samples from Business Process Monitor sources for the
transaction from location CIs (for Business Process Monitor) or from
SiteScope Monitor, SiteScope Measurement Group, and SiteScope
Measurement Cls (for SiteScope).

M Tranzaction Responze Time [ms)
B Transaction Awvailability

SIM2/05 9:54 AM
205 12:18 PR
SM2M05 2:42 PM
SM2405 5:08 P
QHM2/05 720 PM
Q2405 9:54 PM
1305 12:18 AR
9H3/05 2:42 AM
912005 5:08 AM
D305 T30 AR
BiM3/05 9:54 AN

=
2
"

For details about the report, see Chapter 14, “Raw Data Over Time Reports”.
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SAP Transaction Changes
This option is available for SAP-specific Cls.
It opens the SAP Transaction Changes report. The SAP Transaction Changes

report displays the SAP transactions and SAP transports and the impact of
transports on each transaction.

HEE
] MIG{SAP System)
Marne MIE
= ZMTRAMNS1{SAP Transaction)
Marme ZMTRANS1 Devclass ZIMSPECTIOM_FOR _MAM Prograrm ZMPROGL
Prograrm Wersion Screen o100
= CIT Wame = SAP Transport
Tide Namea DescHpton Creation Date User Target System
MIGK200518 [(SAP Transport) MIGK200518 2006,02.21 14:15:05:00 Sigalit Sade TR
MISK 900370 [SAP Transport) MIEKS00370 2006,01.17 11:20:49:00 Sigalit Sade
MIEKI00516 (SAP Transport) MIEKS00516 2006&,02.20 15:54:11:00 Ofer Mekrmal TR.M
MIEK200508 [SAP Transport] MIEKS00508 2006,02.20 14:52:25:00 Sigalit Sade TRM
MIGK200416 [SAP Transport) MIGKI00416 2006,01.26 10:06:15:00 Sigalit Sade
MISK 900432 [SAP Transport) MIEKS00432 2006,01.26 11:22:40:00 Sigalit Sade
MIEKI00422 [(SAP Transport] MIsKS00422 2006,01.26 11:09:22:00 Sigalit Sade
MIEKI00442 [SAP Transport] MIEKSO0442 2006.01.26 12:20:52:00 Sigalit Sade
El ZMTRANS2{SAP Transaction)
Mare ZMTRANSZ Devclass ZIMNSPECTION_FOR_MAM Program ZMPROGZ_2
Prograrm Wersion Screen o100
= CIT Name = SAP Transport
Titde Name Description Creation Date User Target System
MISK 900415 [(SAP Transport) MIsK=S00412 2006&,01.26 10:09:11:00 Sigalit Sade
MIEKI00434 [SAP Transport] MIEKSO0424 2006.01.26 11:29:58:00 Sigalit Sade
MIEK90051E [SAP Transport) MIEKI00516 2006,02.20 15:54:11:00 Ofer Mekmal TRM
MIGKI003F3 [SAP Transport) MIGKI00373 2006,01.17 11:38:02;:00 Sigalit Sade
MISK 900424 [SAP Transport) MIsKS00424 2006&,01.26 11:11:19:00 Sigalit Sade
MIEKI00520 (SAP Transport] MIEK300520 2006.02.21 14:37:58:00 Sigalit Sade TRH
= ZMTRANS3{SAP Transaction}
Marne ZMTRANESS Devclass ZINSPECTION_FOR_MAM Prograrm ZMPROG2_3
Program VYersion Screen o100 b

For details about the report, see “SAP Transaction Changes Report” on
page 252.

For details about the SAP System view, see Chapter 19, “Using the SAP
Solution”.
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SAP Transport Changes
This option is available for SAP-specific Cls.

It opens the SAP Transport Changes report. The SAP Transport Changes
report displays the changes inside the Transport and the impact on the SAP

transaction.
HEE
] MIG{SAP System)
Marne MIE
E MI6GK200424(SAP Transport)
Marne MIEKS00424 Descriptiaon Table called by Include User Sigalit Sade
& Program-
ZMTRANSZ_3
Creation Date 2006&,01.26 11:11:19:00 Target Sypstem
=l Table:ZMTAB_BY_INCLZ_3({SAP Transport Change)
Chject Hame ZMTAB_BY_IMCLZ_3 Ohjec Type Table
El CIT Name = SAP Transaction
Tide Name Devclass Program Program Wersion Screen
ZMTRANSZ (SAP Transaction) ZMTRANSZ ZINSPECTION_FOR_MAM ZMPROGZ_3 Q100
ZMTRAMNSZ (SAP Transaction) ZMTRAMSZ ZIMSPECTIOMN_FOR_MAM ZMPROG2_2 o100
=l Table:ZMTAB_BY_PROGZ_3{SAP Transport Change)
Cbject Marne ZMTAB_BY_PROGZ_2 Ohjec Type Table
El CIT Name = SAP Transaction
Tite Mame Devclass Progranm Program Wersion Screen
ZMTRANS2 (SAP Transaction) ZMTRANSZ ZINSPECTION_FOR_MAM ZMPROG2_2 o100
ZMTRANS3 (SAP Transaction) ZMTRANS3 ZINSPECTION_FOR_MAM ZMPROGZ_3 o100
[ MI6GK900516(SAP Transport)
Marme MIGK200516 Description transporting inspection User Ofer Mekmal
of Mam
Craation Date 2006,02,20 15:54:11:00 Target Syztem TRN
=l Transaction:ZMTRANSZ{SAP Transport Change}
Object Name ZMTRANSZ Chjed Type Transaction
El CIT Mame = SAP Transaction
Tie Name Devclass Program Program Wersion Screen
ZMTRANS2 (SAP Transaction) ZMTRANSZ ZINSPECTION_FOR._MAM ZMPROGZ_= o100
-

For details about the report, see “SAP Transport Changes Report” on
page 254.

For details about the SAP System view, see Chapter 19, “Using the SAP
Solution”.
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This option is available for Real User Monitor-specific Cls.

It opens the Server Summary report. The Server Summary report displays

data for the servers that are monitored by the Real User Monitor probe.

100%

ilability Threshold (02.000%)
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For details about the report, see “Server Summary Report” in Using End User

Management.

For details about the Real User Monitor views, see Chapter 18, “Real User

Monitor Views in Dashboard”.
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Service Level

This option is available for Deep Transaction Tracing Cls.

It opens the Service Level Analysis report. The Service Level Analysis report
provides a graphical view of response time for the transaction over time. The

displayed information includes average response time, maximum response
time, and transaction volume over each reporting time period.

Service Level Analysis

g th A

Response Time (sec)
Transaction Volume

ec Dec Dec Dec Dec Jan Jan Jan Jan Jan Jan Jan Jan Jan Jan Jan Feb Feb Feb

Nov' Nov Now Mow Nov Nov Nov Dec’ Dec Dec D
2 15 18 21 23 2% 29 01 04 O7 10 13 15 18 21 24 27 W 02 05 OF

D
13 16 19 2 25 28 30 03 06 00

For details about the report, see “Service Level Report” on page 333.

For details about the Deep Transaction Tracing Sites view, see Chapter 25,
“Working With Deep Transaction Tracing”.
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Session Analyzer

This option is available for Real User Monitor-specific Cls.

It opens the Session Analyzer report. The Session Analyzer report displays
session data for specific applications that were configured for Real User
Monitor in Monitor Administration.

For details, see “Session Analyzer Report” in Using End User Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard”.

Show Related RFCs

This option is available for all CIs.

It enables you to view the impact of planned IT changes which have been
submitted to the service desk.

For details, see Chapter 17, “Related Change Requests Report”.
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Siebel Cross-Performance

This option is available for the Siebel Application Server, Siebel Web Server
Extension, Siebel Component Group, Siebel Component, and Siebel Web
Application ClIs.

It opens the Cross-Performance report for the CI. The Cross-Performance
report displays the behavior of a measurement running on several
monitored servers, or the behavior of several measurements from various
types of monitors running on one monitored server.

kali cortinued

2000.00
e — B tiemory ME free
100000 B Wemory pagesisec
B Memory percent usecd
0.00
10.00
N »
5.00 i -
4 iy
0.00
45.00 .
.,
2250 R
0.00

115204 1:27 Ak
11/3/04 4:00 FM
141104 4:00 P
141304 4:00 FM
1/16/04 4:00 FM
141704 4:00 P
1/18/04 4:00 FM
1/21/04 4:00 P
142304 4:00 PM
1/25/04 4:00 FM
142704 4:00 P
1/23/04 4:00 FM
12/1/04 4:00 FM
120304 4:00 P
1245/04 4:00 FM
12/7/04 4:00 FM

For details about the report, see “Cross-Performance Report” on page 13.
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SiteScope

This option is available for all Cls.

It opens the appropriate monitor page in SiteScope.

; Mercury Business Availability Center

F=SieScope | Alerls THReports | T Health Preferences

Multiview Manage Monitors/Groups Browse Tools Progress Summa

SiteScope Main View

License:Permanent, points: 10000, ugsed: 7 b

will update monitor Chopup:2 Report Everything in 0 seconds

Page refresh rate: B0 seconds, last refresh: 8:13 A 4425106

Find out what's in this rel . Go to the Release Motes. -
4 | v

For details about SiteScope, refer to SiteScope documentation.
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Tracking

This option is available for Deep Transaction Tracing Cls.

It opens the Transaction Tracking Report. The Transaction Tracking report
lists information for every instance (run) of the Business Process Monitor

transaction over a specified time period. The displayed information includes
start time, response time, and the result of the run.

» Transaction Tracking Report- {Show Form) Project: TEST

Transaction Tracking Report
(17513 transactions, showing 1-20)

T= start Time Response Completion Result

Class Time State Gtate Label BpmTransaction BpmScript ¥alue|

Login 01/26/2006 09:45:23.038 0.05 Completed Success Login WwebSphere -
Login 01/26/2006 09:46:23.866 0.02 Completed Success Lagin WebSphere -
Login 01/26/2006 09:47:23.957 0.03 Completed Success Login Wwebsphere -
Login 01/26/2006 09:48:21,957 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 09:49:19.832 0.02 Completed Success Lagin WebSphere -
Login 0142642006 09:50:20.191 0.0Z Completed Success Login Wwebsphere -
Login 01/26/2006 09:51:20.582 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 09:52:21.159 0.02 Completed Success Lagin WebSphere -
Login 01/26/2006 09:53:21.487 0.0Z Completed Success Login Wwebsphere -
Login 01/26/2006 09:54:21.346 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 09:55:21.549 0.03 Completed Success Lagin WebSphere -
Login 01/26/2006 09:56:22.628 0.00 Completed Success Login Wwebsphere -
Login 01/26/2006 09:57:22.719 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 09:58:23.423 0.02 Completed Success Lagin WebSphere -
Login 01/26/2006 09:59:23.844 0.0Z Completed Success Login Wwebsphere -
Login 01/26/2006 10:00:21.173 0.00 Completed Success Login WwebSphere -
Login 01/26/2006 10:01:21.173 0.02 Completed Success Lagin WebSphere -
Login 01/26/2006 10:02:22.894 0.0Z Completed Success Login Wwebsphere -
Login 01/26/2006 10:03:25.972 0.02 Completed Success Login WwebSphere -
Login 01/26/2006 10:04:20.379 0.02 Completed Success Lagin WebSphere -

Go to |:|age:|‘I 'l Mext Mext10 Last Page

For details about the report, see “Tracking Report” on page 331.

For details about the Deep Transaction Tracing Sites view, see Chapter 25,
“Working With Deep Transaction Tracing”.
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Transaction Analysis

This option is available for all Cls.

It opens the Transaction Analysis report for the CI. The Transaction Analysis
report provides an in-depth picture of the performance of transactions.

Profile(s]):
fist_bprn_pr..._Sanity_1_2

Active Filters: Transactions: All , Locations: All , Groups: All [Clear All

Z006

=
thon  Tue  Wed Thu  Fri Sat  fun  Mon o
] Critical
17 12 19 20 21 22 23 29 o Not defined

s I O O O O O O e
tx greend
e e O O *L e
e [N O O O Xz 2000t 50% ks
tx vellowl Xz 30% to 7020 failed
tx yellow? X £ 70% to 90% failed
tr vellows X £ More than 90% failed

| | | [ ]
.

= = = = = = =
tx faill X= X= X=X XK= X= X= X=

MNote: Report uses hourly aggregated data.

To generate a sub-report, click a drill-down link in the table above.

For details about the report, see “Transaction Analysis Report” in Using End
User Management.

33



Part | ¢ Dashboard Overview

Trend
This option is available for all Cls.

It opens the trend report for the CI. Trend reports enable you to compare
multiple measurements from several profiles.

100

20

60—'\-\\

Scaled Average Measurement Yalue

0¥ T [ni T ni T nd T ni T ni ]
= = = = = = = = = = = = =
= o e e T Y e Y [ = o o =
[ o o [l o oW [l o oW [l o oW [l
T T T T T T T T T T T T T
[l bal kel [l uw r- o - - [l uwr r- o
o o
Time Range

For details about the report, see “Trend Report Manager” in Application
Administration.
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Triage

This option is available for Real User Monitor-specific Cls and for Siebel-
specific CIs.

It opens the Triage report. The Triage report displays transaction data for
Business Process Monitor, Client Monitor, and Real User Monitor profiles for
the past day.

Transaction by Location
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Collector Health
tx 5

tx 10

tx 15

tx 1 failed

Statistics

00060

tx 2 failed

525 completed transactions.
Average response time 15,21 secs,
StatusiCritical

Availability: 75.0%

For details, see “Triage Report” in Using End User Management.

For details about the Real User Monitor views, see Chapter 18, “Real User
Monitor Views in Dashboard”.

For details about the Siebel Sites view, see Chapter 20, “Using the Siebel
Solution”.

Go to Siebel Diagnostics

This option lists options that enable you to open specific pages in the
Business Availability Center for Siebel filtered by the selected CI.

This section includes the following reports:

» “Siebel Database Breakdown” on page 36

> “Siebel SARM” on page 36
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> “Show Tasks in Error” on page 37
» “Show Running Tasks” on page 38

> “Show Processes” on page 39

Siebel Database Breakdown

This option is available for the Siebel Site, Siebel Application, and Siebel
Enterprise ClIs.

It opens the Database Breakdown tab in Business Availability Center for
Siebel to enable you to create and analyze database logs that record the SQL
activity between Siebel components and the Siebel database.

For details, see “Using the Siebel Database Breakdown Diagnostic Tool” on
page 275.

Siebel SARM

This option is available for the Siebel Site, Siebel Application, and Siebel
Enterprise ClIs.

It opens the SARM - User Trace Breakdown tab in Business Availability
Center for Siebel to enable you to create and record the SQL activity in each
monitored Siebel site.

For details, see “Using the SARM - User Trace Breakdown Diagnostic Tool”
on page 289.



Show Tasks in Error
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This option is available for Siebel Application Server, Siebel Component

Group, and Siebel Component Cls.

Enterprize: Isiebel vl Status: IEHited with Errar vl

SiteScope: desonance

Server: undefined, Component group: Assignment
Advanced Options: Management, Siebel Component: LABM1SBELOZ, Using

Uzer: I
Apply

SW_MAME CG_ALIAS CC_ALIAS TEK_LABEL

TK_TASKID

TK_PID TK_DISP_RUNSTA

Mo information to display

It opens a separate page with the Task Diagnostics Tool filtered by:

> the selected site, server, and Exited with Error status for Siebel Application

Cls

> the selected site, server, selected Component Group CI, and Exited with

Error status for Component Group Cls

» the selected site, server, selected Component Group CI, selected Component
ClI, and Exited with Error status for Component Cls

For details about the Siebel Cls, see Chapter 20, “Using the Siebel
Solution”.For details about the Siebel Task Diagnostics Tool, see Chapter 22,

“Using the Siebel Tasks Diagnostic Tool”.
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Show Running Tasks

This option is available for Siebel Application Server, Siebel Component
Group, and Siebel Component Cls.

Enterprise: Isiehel vl Status: IRunning ;I User: I

Server: undefined, Component group: Assignment
Advanced Options: Management, Siebel Component: LABM1SBLOZ, Using Apply
SiteScope: desonance

5¥_NAME CG_ALIAS CC_ALIAS TK_LABEL TK_TASKID TK_PID TK_DISP_RUNS

LABMISBELOZ AzgnMgmt AsgnSrur 6195 3500 Running

It opens a separate page with the Task Diagnostics Tool filtered by:

> the selected site, server, Running status, and Session type for Siebel
Application ClIs

» the selected site, server, selected Component Group CI, Running status, and
Session type for Component Group Cls

» the selected site, server, selected Component Group CI, selected Component
CI, Running status, and Session type for Component ClIs

For details about the Siebel CIs, see Chapter 20, “Using the Siebel Solution”.
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For details about the Siebel Task Diagnostics Tool, see Chapter 22, “Using
the Siebel Tasks Diagnostic Tool”.

Show Processes

This option is available for Siebel Application Server, Siebel Component
Group, and Siebel Component Cls.

-
Enterprise:lsiebel ;I Seruer:lwhistle ;I Componentl -All component groups- ;I
graup:
N Siebel Component: -All components-, Process Type: -All process
P H N N
Advanced Dptions types-, Process Id: 0, Using SiteScope: desonance Apply
858
I )+ | il
Server Component Component Process Process cPu Memory
group P Type j{v] %) (KE)
whistle ziehsuc 1403 L] 5704
whistle siebswe 280 ] 3408
whistle SCBroker siebproc 2384 1} 1144
whistle TxnRoute siebproc 2808 1] 9848
whistle TxnMerge siebprac 2204 1} 1920
whistle SynchMgr siebrntsh 2912 1] 3952
whistle Systern SRBroker siebrntsh 2152 1} 2772
whistle AdminMaotify  siebrntsh 2328 1] 1556
whistle PLbXtract siebrntsh 2082 L] 1132
whistle Systermn SR.Proc siebrntsh 2188 1] 2656
whistle siebrntsh 2436 L] 1044
whistle ziebmtshmw 2796 L] 1128
whistle siebrmtshmw 2872 1} 1096
-

It opens the Task Diagnostics Tool filtered by:

» the selected site, and server for Siebel Application CIs

> the selected site, server, and selected Component Group CI for Component
Group CIs

> the selected site, server, selected Component Group CI, and Component CI
for Component Group Cls
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For details about the Siebel Task Diagnostics Tool, see Chapter 22, “Using
the Siebel Tasks Diagnostic Tool”.

For details about the Siebel CIs, see Chapter 20, “Using the Siebel Solution”.

For details about the Process Diagnostics Tool, see Chapter 24, “Using the
Process Diagnostic Tool”.

Properties

This option is available for all CIs.

Opens the Properties dialog box relevant to the CI.

o)
(=)
CI Tupe Business Process Group
Create 6/5/06 7:258 AM
Tirme
Update 6/5/06 71258 AM
Tirme
Created By
MNare# Alerts BRM

Description  This profile was autoratically created by MTF
Drigin SOURCE_ID_-1535599187
Updated
By
Allow CI Update

Display Alerts BPM
Label

Country
State
City

Context Business Process Monitor Group Menu
Menu

(%)

ID#* az

Application -1
ID#*

Iz diagnostic enabled

Close | Help |

For details, see “Working with CIs in IT Universe Manager” in IT Universe
Manager Administration.
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Show Content
This option is available for specific SAP-related and Siebel-related ClIs.
For SAP-related Cls, the option displays a details file that includes details

about the configuration file, software component, or support package of the
SAP system discovered by the automatic discovery process.

For Siebel-related ClIs, the option displays a details file that includes
installation information (siebel.cfg) or the output of the list parameters for
component command using srvrmgr (parameters.cfg).

For details about the SAP-related configuration files, see “Configuration File
Details” on page 257.

For details about the Siebel-related configuration files, see “Viewing
Configuration File Details” on page 273.

Show Related Cls

This option is available for all CIs.

Performs a search for related Cls and displays the result in the Search tab of
View Explorer.

Browse|Search| ?

Search for: I

Search in:

0 Currant view

& all views

Search

Name = View =

[ plerts pp...o 1 End Use...iew
[ alerts pp...5 1 Lirans
[ Alarts Bp...5 2 End Use..iew
[ alertz pp..5 2 Lirans
[ plertz pp...o 3 End Use...iew
[ alerts pp...3 3 Lirans
[ alerts BP...5 4 End Use..iew

s

O Alerts pp...o 4 Lirans
[ plertz pp...o 5 End Use...iew
s
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For details about the Search tab, see “Searching for Configuration Items” in
Working with the CMDB.

Top View

Displays a list of options similar to options in the Top View tab to view
different trees centered on the selected CI.

This section includes the following topics:

» “Show in Top View” on page 42
> “Show Path to Root” on page 42

> “Show Problematic Subtree” on page 42

Show in Top View

This option is available for all Cls.
It opens the Top View tab with the view’s tree centered on the selected CI.

For details about the Top View tab, see “Dashboard Top View” on page 73.

Show Path to Root

This option is available for all CIs.

It opens a Top View page that displays the path from the selected CI to the
root CL

For details, see “Show Path to Root Option” on page 43.

Show Problematic Subtree

This option is available for all Cls.

It opens a dialog box with capabilities similar to the Top View tab
capabilities. The dialog box displays all the child CIs with Critical, Major, or
Minor status.

For details, see “Show Problematic Subtree Option” on page 43.
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Show Path to Root Option

The purpose of the Show Path to Root option in the Filters or Console tab is
to open a Top View window and display the path to the root CI from the
selected CI.

For example, right-click the arrow to the right of the CI for which you want
to display the path to root, and select Top View > Show Path to Root.

A Top View window opens and displays the path to the root.

Monitors Yiew g

bpm_profile_1 g

My

L

%%
s

Show Problematic Subtree Option

The purpose of the Show Problematic Subtree option is to enable you to
find the problematic child CI that causes the parent CI that you selected to
have a status other than OK.

The Show Problematic Subtree option is enabled only for Cls that have at
least one KPI with a status other than OK.

When you select the Show Problematic Subtree option, a Top View window
opens to display the subtree of the selected CI with the child ClIs that have
at least one KPI with a status other than OK.
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For example, the Profilel CI has the following children:

Monitors ¥iew m

4'4‘
bloomberqg ssla|
T w#n

| Profilel |

w1

assaf | 35531 Epgyyry
P S o i ” |
AR AR A

If you select the Top View >Show Problematic Subtree option for Profile 1,
the following children are displayed:

Profllel =

/ i\
hloomhergs
' i'
bloomber \
s i 0, ,,f

i s
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Acknowledging Performance Problems

The Acknowledging utility enables you to track performance problems
identified in your system and network infrastructure by keeping a record of
when the problem was acknowledged and by which user.

You acknowledge a problem by selecting the Ack check box for a CI in the
Top View, Console, and Filters tabs (you can clear the acknowledgment by
selecting the check box again). In the Console and Filters tabs you can
set/unset the acknowledgement by clicking the icon. You can also set/unset
acknowledgment and view the CI acknowledgment history by using the
context menu in the Top View, Console, and Filters tabs.

After a problem CI is acknowledged, or the acknowledged status is cleared,
you can view the history in the Acknowledged Details dialog box.

Note: The Ack check box is enabled only if there is at least one KPI defined
for the CI, and at least one of the KPIs has a status other than OK (green).

A tooltip for the Ack icon displays the current status of the CI'’s

acknowledgment.

Name Performance Availability Ack Name Performance Availa
E Do~ L+ @+ B [ tailed~ : @
E;\.(tx is = Gt @=+* ] ’f:tx 2 failed * . X

H [, =~ @+° o

Acknowledgement

The acknowledgrment far this CIis set,
Click to unset this acknowledgment,

Mote: You can see the ©I acknowledgment
detailsfhistory using contest menu.

» By default, the Ack column is displayed. It can be hidden by users with
administrative permissions. The Acknowledgment-related right-click
options remain available. For details, see “Hiding or Showing the Ack
Column” in Application Administration.
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This section includes the following topics:

> “Viewing Acknowledgment Details” on page 46

> “Setting or Unsetting Acknowledgments” on page 48

Viewing Acknowledgment Details

After a problem CI is acknowledged, you can view the details of the current
acknowledgment or the acknowledgment history of the CI in the
Acknowledged Details dialog box.

To view acknowledgement details:

Click the down arrow to the right of a CI and select one of the following
options:

> Acknowledgment details. Displays the details of the currently opened
acknowledgment in the Acknowledgment details box.

» Cl history. Displays the details of all the acknowledgments over time in
the Acknowledgment details box.

The acknowledgment for this CI is set

Acknowledgrnent details:

Date User Action Message
1/18/06 5:47 AM adrmin Spen set
1/12/06 5:47 AM adrrin Edit 2 child problern

@ The acknowledgernent details Cer histary

Add details:

Add Clear Close
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The information displayed in the Acknowledgment details box is:

Field

Description

Date

The date and time when the acknowledgment
status was modified.

User

The name of the user who modified the status.

Action

The type of action that was performed:

» Clear. When the acknowledgment history was
cleared.

» Unset. When the acknowledgment was unset.

» Info. Details were added to the acknowledgment
without changing the acknowledgment status.

» Open. When the acknowledgment was set.

» Edit. When details were added to the
acknowledgment.

Message

Displays the status of the acknowledgment or the
information that was entered in the Add details
box.

2 In the Add details box, add information about the actions you are going to
perform to solve the problem. You can add information whether the
acknowledgment is Open or Closed.

3 Click one of the following buttons:

» Add to add the information you entered in the Add details box to the
acknowledgment history.

» Clear to clear the acknowledgment history. All acknowledgment details
are deleted and a new note is added to indicate that the history was

cleared.

» Close to close the dialog box. If you changed something in the dialog box
and you click Close, a message is issued indicating that data will not be

saved.
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Setting or Unsetting Acknowledgments

You acknowledge a problem by selecting the Set/Unset Acknowledgment
right-click option for a CI (you can unset the acknowledgement by selecting
the same option and clicking OK).

Note: The Ack check box is enabled only if there is at least one KPI defined
for the CI, and at least one of the KPIs has a status other than OK (green).

A tooltip for the Ack icon displays the current status of the CI’s
acknowledgment.

To set or unset acknowledgement:

Click the down arrow to the right of a CI and select Acknowledgment >
Set/Unset Acknowledgment to open the Set/Unset Acknowledgment dialog
box or click the Ack icon to the right of the CI.

Note: The dialog box is a toggle dialog box. If you have acknowledged the
CI, the top line in the dialog box is: The acknowledgment will be unset. If
you have not acknowledged the CI, the top line in the dialog box displays:
The acknowledgment will be set.

2 In the Add details box, enter information about the acknowledgment.

The acknowledgement will be set

Add details:

(114 Cancel
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3 Click OK to set or unset the acknowledgment depending on the previous
status of the dialog box.

Find Visible and Hidden Child Cls Option

A CI’s child CIs can be specified as included (visible) or excluded (hidden) in
a specific view. The status of any child ClI, visible or hidden, has an impact
on the status of its parent CI in any view where the parent CI appears. For
details about including or excluding child CIs, see “Include Related CIs” in
IT Universe Manager Administration.

For example, you might have the situation where, in a specific view, the
Availability KPI's status of the parent CI’s is Critical while the Availability
KPI’s status of the CI's child CIs are OK. When this happens, you would like
to know what caused the status of the Availability KPI to be Critical.

view: [Danidin = parent -

Performance @ +®  Availability C5+%

B %2 Dpanidinl -
=R
appl
app2

Use the Find Visible and Hidden Child Cls option to list all the child CIs of
the selected CI in the CMDB. After the list of child Cls is displayed, you can
search for the views the child CI belongs to and then display the child CIs
details in the specific view.
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To find the Visible and Hidden Child Cls for a specific Cl:

Right-click the CI and select the Find Visible and Hidden Child Cls option to
open the Find Visible and Hidden Child CIs dialog box and list all the
selected CI’s child Cls that appear in the CMDB (visible and hidden).

fist_bprm_profile_Sanity_1_1

Performance (4#%  Availability %%

Manme Performance Availability Visible -
'f:tx_l,lellowl VEY @+ W Search
[=: tw_red3 Qs - R W Search
[=: tx_greend @+ - R W Search
[=: ta_faill - &+t W Search
'f:tx_l,lellow2 5 - R W Search

The Find Visible and Hidden Child CIs page displays the following
information:

» The name of the selected CI, whose child CIs you want to list, the CI’s
KPIs, and their status in the current view.

» Alist of the child CIs (visible and hidden) that appear in the CMDB, their
KPIs and their status. In the Visible column, a checkmark indicates that
the child CI is visible in the view and an X indicates that the child is
hidden in the view.
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To search for the views that include a specific child Cl:

1 Click Search to perform a search for the CIs whose names include the
selected child CI's name string in all views, and display the results in the
View Explorer search page.

Browse|Search]| ?

Search for: Iblc-c-rnberg =zl

Search in:

0 Current view
& Al views

[T Rrelated ta: l:IJ

Search

Mame = Yiew -

':=: bloormberg ==l Danidin

[=.. End

v bloarmberg ==l Use...iew

[=.. Monitors
¢ bloormberg =5l yjew

':=: bloarmberg szl 1 Canidin
[=" End

¢ bloormberg £2l 1 se,..jew
[=" Monitors
¢ bloormberg g5l 1 yjauw

F vy

2 Click the appropriate CI in the list to display more information about the
selected CI in the selected view.

If the CI is not visible in any view, in Dashboard, the following message is
displayed: Search is complete. There are no results to display for the current
search parameters.

The CI is not visible in any view in the following situations:

» Itis included in the CMDB but does not belong to any view.

» It belongs to a view but the Exclude all child Cls option has been selected
for its parent CI in that view. For details, see “Creating a New CI” in
IT Universe Manager Administration.
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Working with Dashboard
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Working with Dashboard

This chapter describes how to work with Dashboard tabs, views, and

configuration item (ClIs).

This chapter describes: On page:
Overview of Dashboard 56
Working with Views 58
Understanding KPI Status 59
Viewing Additional Information for CIs 67
Viewing Sample Details 69
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Overview of Dashboard

You access the Dashboard application by selecting Applications >
Dashboard.

Top View | Console Filters Geographical Map Custom Map Topology Map Reports |

Monitars Wiew Jﬂﬂﬂ

Name System Performance Awailability Ack
[ - @2 [+ X
@ bprn profile 2 + - -_§<¢g '-§<¢f

@ cn_profile_1 =

@ cn_profile_2 «

D0|K
£
DI9|S
E1)

@fist bprn profile 1«
@fist bprn profile 2 *

|

6

W+ |

%

@
' >! *]

] s_profile_1 *

Last Update - 05:47:19 AM

Dashboard contains the following tabs:

» Top View tab. Displays the components of the active view in a hierarchical,
top-down graphic. For details, see “Dashboard Top View” on page 73.

» Console tab. Displays the components of the active view arranged in a
hierarchical tree. For details, see “Dashboard Console” on page 85.

> Filters tab. Displays a filtered list of ClIs, according to the selected filter
option. For details, see “Dashboard Filters” on page 97.
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Geographical Map tab. Displays an association between geographical
locations and status indicators using a maps applet. For details, see
“Dashboard Geographical Map” on page 117.

Custom Map tab. Displays icons representing Cls in the view on a custom
image. For details, see “Dashboard Custom Map” on page 129.

Topology Map tab. Displays the results of pattern views or instance views.
For details, see “Dashboard Topology Map” on page 135.

Reports tab. Displays the Dashboard reports: Configuration Item Status
Alerts report, KPIs Over Time report, Raw Data Over Time report, Change
report, and Report Repository. For details, see “Working with Dashboard
Reports” on page 153.

Each tab contains a Last Update time, showing the time that the
information in the tab was last updated.

Notes and Limitations

Note the following when working with Dashboard:

It is recommended that you use Microsoft Internet Explorer as your browser
when using the Dashboard application.

User access to Dashboard views is limited according to the viewing
permissions specified for the user. If you cannot see a view, contact your
administrator. For details, see “Configuring User Permissions” in Platform
Administration.

The first time that you access Dashboard, you may experience a short delay
while Dashboard compiles the page.
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Working with Views

58

The CIs and relationships produced by the various CI-generating tools that
operate within Mercury Business Availability Center are stored in the
Configuration Management Database (CMDB).

The service views displayed in Dashboard are built from CIs contained in
the CMDB. These CIs are mapped together to build views that meet your
business requirements and objectives, and monitor what is important to
you. (For a more detailed explanation of how views are built, see IT Universe
Manager Administration.) Each CI has only one instance in the CMDB.
Different views can look at the same CI.

The ClIs at the lowest level of the hierarchy represent the monitor CIs, such
as SiteScope monitors, Business Process Monitor transactions, or metrics
from other external monitoring sources. The upper levels of the hierarchy
represent logical groups (that is, all CIs that may act as a parent CI to other
ClIs). CI names are either taken from the external source, or as defined by the
administrator in “Creating a New CI” in IT Universe Manager Administration.

When changes are made to your organization’s infrastructure, they are
detected by the discovery process or by the monitoring source adapters.
Dashboard checks the engine every 60 seconds (default setting) for
configuration changes received from the external sources. The structure and
content of the CI hierarchies are then automatically updated and deployed
to the Dashboard application.

In addition, changes made within Mercury Business Availability Center, by
changing the profiles in Monitor Administration, or by manually updating
CIs in CMDB Administration, are also automatically deployed to Dashboard.

Key Performance Indicators (KPIs) are assigned by default to monitor Cls
and propagate up the hierarchy. You can manually assign additional KPIs to
ClIs in Dashboard Administration. For each CI, one or more Key
Performance Indicator (KPI) columns are displayed, for example, for
Availability, System, Performance, and so forth. For a list of the KPIs used in
Dashboard, see “Dashboard KPIs Detailed Description” in Application
Administration.
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For each CI, each KPI column contains status icons or values, representing
how the KPI objective is met. For details on KPI status, see “Understanding
KPI Status” on page 59.

The views may also contain dynamic hierarchies generated by the Dynamic
Node Factory definition file. These hierarchies are created in Dashboard in
runtime, based on the incoming samples. The parent for a dynamic
hierarchy is a Dynamic Node Factory CI. Note that the CIs under the
Dynamic Node Factory parent do not generally have option menus. For
more information on dynamic hierarchies, see “Working with Dynamic
Node Factory” in IT Universe Manager Administration.

Understanding KPI Status

For each CI, Dashboard displays real-time status in one or more KPI columns
used in the view. A color-coded icon (LED) is displayed for each KPI in a
view, representing the status assigned to that component for its current
performance level. In addition to the main status icon for a KPI, the KPI
column may contain additional icons showing trend and history for the CI
under that KPI.

Performance Availability

9 +° Qo+
LE s
S
9 +? D+ 3

History
Trend
Status

i

For explanations about trend and history icons, see “Trend and History
Statuses” on page 64.

The status of a KPI in Dashboard provides an indication of how well a
business process or system is meeting your business objectives. Based on
traffic light colors (with additions), the Dashboard shows you whether the
KPI measurement is meeting the objective requirements (green), is critically
failing (red), or is at some business risk level between the two (olive, yellow,
orange). For more details about objectives, see “KPI Objectives” in
Application Administration.
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The status of each KPI is calculated using a business rule. A different
business rule may be used for a parent CI and a child CI with the same KPI
attached. The business rules are defined for the KPI in Dashboard
Administration. For details on the rules, see “Dashboard Business Rules
Detailed Description” in Application Administration.

There are two types of CIs whose status is calculated differently:

Monitor CI. Monitor CIs receive real data from data samples. These data
samples are used to calculate the status of the KPIs attached to the monitor
Cls.

The foundation of status definition for all monitor ClIs is a comparison of
performance metrics with objective values.

Group CI Status. For group ClIs (all Cls except monitor Cls), Dashboard
displays a status icon that represents a “summary” of the status for the child
components (that is, the CIs that belong to the lower level in the
hierarchical structure).

The Details tooltip for each status icon provides some information regarding
the calculation method in use for the KPI. For details, see “Viewing
Additional Information for CIs” on page 67.

Note: The color displayed for a CI icon in Dashboard represents a summary
of interim status values for a predefined duration (the default duration value
is generally 300 seconds). The calculation of status values is an ongoing
process, using samples collected every 60 seconds (default granularity
value), thus the interim status may actually change several times over the
duration without causing any change in the color of the icon. For example,
if the icon for a transaction is red at the beginning of a duration, and during
the duration the interim status changes from red to green and back to red, at
the end of the duration the icon will still be red.

This section includes the following topics:

» “Statuses Used in Dashboard” on page 61

> “Trend and History Statuses” on page 64



Statuses Used in Dashboard

The following shows the main status levels that are used to show status for
KPIs in Dashboard (note that some of the Dashboard KPIs use text in place
of icons, but use the same color coding to indicate status as shown here):
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Icon | Description Status Status Definition
1 Red with Critical The measurement calculated for the

o attached “X” KPI fell within the value range for
the Critical objective.

Orange with | Major The measurement calculated for the
* attached KPI fell within the value range for

exclamation the Major objective.

marks
. Yellow with Minor The measurement calculated for the
' attached KPI fell within the value range for

exclamation the Minor objective.

mark

Olive with Warning The measurement calculated for the
™~ | tilda KPI fell within the value range for

the Warning objective.

. Green OK The measurement calculated for the
KPI fell within the value range for
the OK objective.

Gray with Uninitialized No performance measurement data

attached has yet been received for this KPI.

dash This may be the case if no
measurements have been taken for
the CI in the period since starting
Dashboard.

Gray with Not up to date The KPI has passed a timeout period

attached (Decay) during which no new information

dash has been received.

The default timeout period is 15
minutes, and the default decay status
color is gray.
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Icon | Description Status Status Definition
(o Gray with Stopped or The corresponding
- attached Downtime profile/group/monitor for the CI is
dash and currently disabled. For details, see
green outline “Stopped/Downtime Status” on
page 63.

Gray with Not applicable This KPI is not applicable for the CI.
white center | for this CI

Note: To change the color of the icons used at each status level, you can
customize some of the icons, or complete sets of icons. For details, see
“Specifying Different Status Icons” in Repositories Administration.

Note the following specialized status icon information:

Change icons indicate when a change was made to a specific static attribute
of a specific CI in the Mercury Universal CMDB. For details, see “Viewing
Real-Time Changes to CI Properties” on page 91.

If all members of a group have Uninitialized status, the group status is
Uninitialized, regardless of which calculation method is in use. A group will
also have Uninitialized status if it has no children.

As long as there are one or more children in a group that have a colored
status, then one of the group business rules will be used to define status for
the group, regardless of the number of children that have Uninitialized,
Stopped, or Downtime status.

For Trend and History status, see “Trend and History Statuses” on page 64.

This section includes the following topics:

> “Stopped/Downtime Status” on page 63

> “Influence of Must and Weight on Status” on page 64
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Stopped/Downtime Status

If a monitor in SiteScope or Business Process Monitor is stopped (disabled
indefinitely) or in downtime (disabled for a scheduled time period),
Dashboard displays a Stopped/Downtime status icon for the corresponding
CIs (gray with a green outline).

Monitor_kiosk -

Performance | :_' Availability | :_'

CI Mame Performance Availability
@ﬁccess fin ... data page *

When the downtime or stopped period finishes, the status icon changes to
No Data until data is received for the CI.

You can determine whether the Cl is stopped or in downtime by holding the
cursor over the Stopped/Downtime icon for the CI. The displayed Details

tooltip gives the CI status, the rule that was used to calculate the result, and,
if the CI is in downtime, to give the date and time when downtime finishes.

Details - Performance

CIname: siebel 7.7 whistle cc
Status: Minor

Calculation Rule: warst Child Rule
Held status since ! &f4/06 10:53:50 PM

The following applies for the status of groups containing Stopped or
Downtime status Cls:

If at least one child has a status other than Stopped, Downtime, or
Uninitialized, then the status for the group is calculated in the usual way, as
described in “Understanding KPI Status” on page 59.

If all the children have either Stopped, Downtime, or Uninitialized status, the
group has Uninitialized status.

» If all the children have Stopped status, the group also has Stopped status.

» If all the children have Downtime status, or there is a combination of Stopped

and Downtime, the group has Downtime status, and its Details tooltip displays
the earliest time given for the end of downtime for all children in the group.
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In the Top View tab, the icon for a Stopped or Downtime status CI is shown in
gray with a green border.

&)

Influence of Must and Weight on Status

When Must and Weight properties have been defined for the relationship
between a parent CI and a child CI, these properties have an impact on the
status calculations for the KPIs of the parent CI.

Must and Weight can be used to qualify a relationship. Weight is used for
weighted percentage status calculations. Must is used for dominant child
status calculations.

The dominant and/or weight information affects only the status of the
group to which this CI belongs, and does not affect the status of the CI
itself. The status of a group ClI is based on its child CIs, and the status of a
monitor CI is based on the information received from the monitoring
source.

For more details about Weight and Must, see “Understanding the Percentage
Rule” in Application Administration.

Trend and History Statuses

The following status levels are used to show historical and trend status for
monitor Cls in Dashboard:

Icon | Description Status Status Definition

' Small gray Downward Real-time status shows a downward
downward trend trend.
arrow

& Small gray Stable trend Real-time status shows a stable trend.
double-sided
arrow
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Icon | Description Status Status Definition
* Small gray Upward trend Real-time status shows an upward
upward trend.
arrow
@ Small green Historical OK All performance measurements fell
” with within the OK objective level over a
attached time period up to the present.
checkmark
Small yellow | Historical At least one performance
i with Warning measurement fell within the
attached Warning objective level, but no
exclamation measurements fell within the Critical
mark objective level, over a time period up
to the present.
3 Small red Historical At least one performance
" with Critical measurement fell within the Critical
attached “X” objective level, over a time period up

to the present.

The trend status has three positions: up, down, and no change. It shows the
trend of the real-time status.

The history status can display the worst status or the average status over a

time period.

Note: No history or trend status is displayed for a CI if there is no relevant
data, for example, if it is uninitialized or stopped, or if it is not relevant for

the KPI.
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Trend status tooltips display the following information:

% Trend - Performance #

CI name: bprn_profila_2
Trend Stable

» Trend followed by the name of the KPI
» Cl name. The name of the CI.

» Trend. The trend of the KPI in the selected time period.

History status tooltips display the following information:

CI nanne ! cpu netapp
History type: W orst
Historical worst: Critical

> History followed by the name of the KPI.
» Cl name. The name of the CI.

» History type. The history calculation type to be used when calculating history

status. Values can be: Worst, Average, or None (no history status displayed). The
value of the parameter is assigned to the HistoryType rule global parameter.
For details, see “Configuring the Rules Global Parameters” in Application
Administration. If the value is none, the historical information is not
displayed.

Historical <worst|average|none>. The worst or average status of the KPI in
the selected time period. The information that is displayed depends on the
value assigned to the HistoryType rule global parameter.

For more information on how to customize your trend and history statuses
and explanations about how those statuses are calculated, see “Status
Calculations” in Application Administration.

You can customize the set of Trend and History icons. For details, see
“Specifying Different Status Icons” in Repositories Administration.
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Viewing Additional Information for Cls

You can view additional information for a CI in a Details tooltip by holding
the cursor over the status icon for the CI. Details tooltips provide additional
textual information for the CI, such as the current status, how long the icon
has held the current status, the thresholds used to calculate the status, and
the historical worst value. For example, the tooltip for the Availability KPI of a
monitor CI is as follows:

Details - Availability

goto_accounts_whistle_sadmin

Llname frarm rcal
Status: oK
Calculation Rule: Transaction Availability Rule

Held status since:  &/1/06 09:57:37 AM
Awg. availability: 100%

Average for: 990 seconds period
Major: == 30.0%
Minor: == 50.0%
Warning : == 70.0%
okK: == 90.0%

The Critical threshold is defined by values lower than the Major threshold;
for example, in the above tooltip the Major threshold is 30%, so any value
lower than 30% means that the KPI is at Critical status.

For more information on all status calculations methods, see “Status
Calculations” in Application Administration.
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Note:

» Dashboard uses the timestamp of the database machine hosting the
Mercury Business Availability Center database. The times displayed in the
tooltips reflect the time zone setting on that machine. If you customize
the time zone setting in Mercury Business Availability Center using the
Admin > Personal Settings > General Settings option, then the
customized time zone is also used in Dashboard.

» When Dashboard is not receiving data for a Business Process profile
because a Business Process Monitor is stopped (while the profile itself is
not stopped), this is not specifically indicated in the tooltip. In this case,
after a while the tooltip Status parameter displays Not up to date, and
the Warning parameter displays the number of seconds during which no
data has arrived.

The parameters displayed in the Details tooltips vary, depending on factors
such as the CI type (group or monitor), KPI, and business rule. For details,
see “Tooltips Repository” in Application Administration.

Note: To change the color of the tooltip border and header. For details, see
“Modifying the Tooltip Border and Header Colors” in Repositories
Administration.
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Viewing Sample Details

If required, you can set Dashboard to provide data from the last sample that
arrived for a monitor CI. This data is viewed in the Event Details dialog box
for the CI. The Event Details dialog box displays all the parameters for the
CI, and gives the parameter values at the last update.

To view the Event Details dialog box for CIs, you must configure Dashboard
to save the last sample for the CI. You can configure this per KPI rule (so that
you will only see sample details for a monitor CI under that KPI), or for all
rules. For details on how to do this, see “Displaying the Last Sample Details”
in Application Administration.

Note: Storing last sample details may require use of a large amount of
memory, slowing down Dashboard performance.

After setting Dashboard to save the CI samples, the Event Details dialog box
can be opened from the Console or Filters tabs in Dashboard by clicking the
status icon for a monitor CI. (If there is an associated Event Details dialog
box for a CI, then the cursor changes to a hand when you hold the cursor
over the status icon for the CI.)

Top View Console Filters Geographical Map C

Springfield_travel_book_flight from Unionville =
Performance Y Availability @ H
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The Event Details dialog box is as follows:

Event Details - Springfield_t-avel_book_flight from Unionville

Event source

Dirnension narme: Auvailability
Status: Critical
Event Message

u_iLocationId 4

szScriptMame
instance_id
zzSessionMame
dEndTime
szldnigueldentifer
u_iSessionld
szTransactionMarme
iCormponentErrorCount
iBreakdownExists
customer_name
trans_instance_id
u_irganizationId
u_iHao=tId
u_iScriptld
szlocationMarme
sz2rganizationMame
iApplicationType
profila_narne
sampleType
u_iStatus
dResponzeTime
szHostMame
u_iTransactionld

time_starmp

Springfield_Travel_Services
eTadywebgkK2rk2qd_CRGQA==
ZI

1,127290169E9
00045245f4420003

a2
Springfield_travel_boak_flight
u}

u}

Default Cliant
-21474253337

4

4

=1

Unianville

Groupl

1

ZI

trams_t

1

1.0

Unianville

1z

1,127290169E9

Close |

The Event Source area in the dialog box contains parameters providing
information on the KPI (in the Dimension name field) for which the event
details are relevant, the date and time of the last update to the CI, and the
CI status at that update.
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The Event Message area displays the details for the CI (according to the KPI)
at the last update. Note that the Event Details dialog box is not
automatically refreshed when there is a new update for the CI. You can
refresh by right-clicking in the dialog box (outside of the Event Message
panel) and selecting Refresh, or by closing and reopening the dialog box.

You can open as many Event Details dialog boxes as required; if you move to
another application or administration page in Mercury Business Availability
Center, any open Event Details dialog boxes are closed.
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Dashboard Top View

The Top View tab provides you with a top-down view of the health of your
applications and business processes. The configuration items (Cls) in the
view are displayed in hierarchical format within a single, interactive
graphical interface, enabling you to gain a big-picture perspective of
business availability for both the end-user and system Key Performance
Indicators (KPIs) of your organization.

This chapter describes: On page:
Navigating the Top View Tab 74
Working with the Top View Tab 75
Network Operations Center View 83
Monitoring the Connection to Tomcat 83

See Also...

“Accessing an External Application from Top View” in Application
Administration

“Customizing the Layout of the Hierarchy in Top View” in Application
Administration

“Enabling Chinese or Japanese Characters in Top View” in Application
Administration

“Specifying Different Status Icons” in Repositories Administration
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Navigating the Top View Tab

When you click the Top View tab, Dashboard displays the Top View page
(for details, see “Working with the Top View Tab” on page 75):

MERCURY" APPLICATIONS ~ | ADMIN~ | MY BAC | HELP = | SITE MAP LoGouT
Business Availability Center - Dashboard Custamen: Zanity 1 User: administrator

@ ’,—_ _— Browse|Searct Top View | Console | Filters | Geographical Map | Custom Map | Topology Map Reports

Wiew: |Monitors View J

m
Al

fan
bprr_profile_Sanity_1_

B B

bprr_profile_Sanity_1_

E2]

0 catapultl

P catapultll

[Z fist_bprm_profile_Sanity
[Z fist_bprm_profile_Sanity

HEH H

.7 jeop
£ jpatstora
5 knot

Honitors Yiew m

H&#

% mepetshop "
(3 plat_bprm_t -
[ siebel cannan
[ siebel whistle
I sis_profile_1_Sanity_1

—
H H &

g
N
el K
TR
M fist_bpm x| P .
o T
\ .
d/ n \\mm e
4 13 Last Update - 05:04:27 FM NOC Wiew
- |
I
I
View Explorer Last Update Root . View KPIs and NOC View
Child Cls )
message Cl their statuses/
values

When the Top View tab is selected, Dashboard includes the following
features:

» View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select Cls,
and to perform operations on the ClIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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» Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 83.

» View. When you select a view in View Explorer, Top View displays the
selected view bar centered in the tree with all its root Cls expanded. For
details, see “Working with the Top View Tab” on page 75.

» Cls, Child Cls, and Root Cls. The tree is built from branch parent and
children configuration items (ClIs) and monitor ClIs. For details, see
“Working with CIs in IT Universe Manager” in IT Universe Manager
Administration.

» KPIs and their statuses/values. For each CI, Dashboard displays the CI's KPIs
and their real-time status as a color-coded icon (LED). For details, see
“Understanding KPI Status” on page 59.

» NOC View. Displays the top view tree in a separate window to be used by a
Network Operations Center (NOC). For details, see “Network Operations
Center View” on page 83.

Working with the Top View Tab

The Top View tab page enables you to see the business availability of your
system components at a glance. The CI bars in the tab provide a visual
representation of real-time IT performance metrics mapped onto business
applications, based on the hierarchy tree structure defined for each view.
The connecting lines between the bars define the relationships between the
CIs.

By presenting an integrated, single view of essential applications and
business processes, the Top View tab is able to provide you with an overall
perspective on the health of your business services, and enables you to
instantly assess how a performance issue impacts the availability of any part
of your business. Each CI in the active view is color coded to indicate the
worst status held by the CI's KPIs.

The Top View tab presents an interactive map of the CIs that can be
intuitively manipulated using the mouse, enabling you to drill down to
specific branches of the tree and to focus on particular business areas or
problem areas. For details, see below.
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Select the Top View tab to display the CIs of the selected view in a top-down,
graphical diagram. Select the required view from the View Explorer. The
name of the selected view is displayed in the central bar of the diagram.

This section includes the following topics:

“Accessing the Top View Tab” on page 76
“Cls and KPIs” on page 76

“KPI Icons” on page 77

“Menu Options” on page 78

“Top View and View Explorer” on page 80
“Top View Tab Functionality” on page 80

Y Y Y Y Y Y Y

“Notes and Limitations” on page 82

Accessing the Top View Tab

To access the Top View tab, select Applications > Dashboard and click the
Top View tab.

Cls and KPIs

By default, the Top View tab displays four levels of Cls. The rest of the Cls
are collapsed. You can then expand a CI at the fourth level and see its
children.

You can change the default setting for the number of levels of CIs that are
displayed in Top View, on the Infrastructure Settings page. For details, see
“Modifying the Number of Levels in the Console Tab” in Application
Administration.

You can also change the default setting for the number of levels of Cls that
can be expanded in Top View, on the Infrastructure Settings page. For
details, see “Modifying the Number of Levels in the Console Tab” in
Application Administration.
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Each CI contained in the view is displayed as a bar, color-coded according to
the current worst operational status for that CI. For details about color
coding, see “Understanding KPI Status” on page 59.

AN

Springfield_infra_ems_logi

i

The icons displayed under a CI bar identify the relevant KPIs for the CI.
These icons are also color coded to indicate the status of that KPI.

Note: The root CI does not display KPI icons because it is a container and
not a real CI.

KPI Icons
A CI may have one of the following icons:

Icon Description

18 Availability KPI (with OK status)
-

1 Customer KPI (with OK status)

j System/HP System KPI (with OK status)
= OT Impact KPI (with OK status)
,r-'.-f Performance KPI (with OK status)
-—ln

f_l PNR KPI (with OK status)

— RT Impact KPI (with OK status)

- User KPI (with OK status)
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Icon Description

ml All other KPIs (with OK status)

":, The CI has been acknowledged
Note:

In the Top View tab, the icon for a CI with a Stopped or Downtime status CI
is shown in gray with a green border.

You can customize the set of icons used in Dashboard. For details, see
“Specifying Different Status Icons” in Repositories Administration.

For a list of the KPIs used in Dashboard, see “Dashboard KPIs Detailed
Description” in Application Administration.

The lines connecting the bars represent the branches of the tree. The bars
and lines can be manipulated to change the amount of information
displayed and the overall layout of the diagram, as described in “Top View
Tab Functionality” on page 80.

Menu Options
Right-click a CI bar to display the following menu options:

» View in Console. To view the CI’s branch in the Console tab.

» Expand to problem. To collapse the branches where CIs do not have critical

or major statuses.
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For example, if in the Mercury Tours Business view, you see that Infra support
is red, you might want to display the lower levels of the view to get a better
idea of the problem.

Monitors View m

| app_1_ o
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Right-click Infra support and select the Expand to problem option, to
collapse the non-problematic branches.

| Monitors View |

T
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oo // \ R
I/l+
"* SE v i Sorin
#F g A0

> Expand more levels. To open a number of levels (7 by default) below the

selected level.
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> Set/Unset Acknowledgment. To set or clear the CI acknowledgment. For

details, see “Acknowledging Performance Problems” on page 45.

Acknowledgment Details. To display acknowledgment information for the
CI. For details, see “Acknowledging Performance Problems” on page 45.

Open in new window. To open a popup window that contains the page
accessed by the specified URL. This is useful to open external applications.
By default, this option does not appear in the menu.

Note: Some Top View tab functionality can be customized by users with
administrative permissions. For details, see “General Administration for
Dashboard” in Application Administration.

Top View and View Explorer
When you select a CI in View Explorer, Top View displays the selected CI
centered in the tree with all its sub-branches expanded.

If you select a CI in the Top View tree, it is highlighted in the View Explorer.

Top View Tab Functionality

You can manipulate the Top View graphic to display any area of the tree, to
display expanded branches or collapsed branches, and to change the overall
panorama of the graphic, by using the following actions:

» Click a bar to move the bar to the center of the graphic.

» Click anywhere in the tab to change the emphasis of the graphic. The

graphic rotates to display the components of the subtree for the nearest bar.

Click and drag anywhere in the tab to move and rotate the graphic around
that point.

Expand and collapse the branches of a subtree by clicking the expand (+) or
collapse (-) symbols, displayed in the bottom right corner of the bar.

Increase or reduce the gap between each branch by holding down the ALT
button on the keyboard and dragging in the tab.
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» If there are branches that do not fit on the screen, the Top View graphic
displays lines emerging from the bar, to indicate the number of branches
and leaves that are hidden. Click the end of one of these lines to display the
entire hidden branch.

Monitors ¥iew m

Profllel =

Holding the cursor over a bar enables the following functionality:

» The bar is outlined in grey.
» If the CI has a long name, the bar expands to display the full name.

» A tooltip is displayed, providing status and performance data in each KPI for
the item. For an explanation of the tooltips, see “Viewing Additional
Information for CIs” on page 67.

Note: When you open the Top View tab, it displays by default the active
view at the root level, centered around the view name bar. Any
manipulation you do to the graphic is not saved; if you move to another
tab, then when you open the Top View tab again it reverts to the default
display format.
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Notes and Limitations

When you open the Top View tab for a view tree with a large infrastructure,
you may experience a short delay while Dashboard builds the view.

The top view is refreshed every 30 seconds. If no change was made to the
view, the top view remains the same. If many changes have been made to a
view, or if CIs have been deleted from the view, that view’s top view is
automatically reloaded after 30 seconds and displays the changes. While
reloading, the following message is displayed in the top right corner of the
screen: The model has changed. Reloading... After reloading is complete,
the following message is displayed in the top right corner of the screen: Top
view has been updated with model changes. Last Update in the bottom left
corner of the screen indicates the last time an update of the top view was
reloaded. The refresh rate of the view can be modified. For details, see
“General Administration for Dashboard” in Application Administration.

If the Top View tab does not display Chinese or Japanese characters
properly, make sure that the Top View Font Name setting has been set to:
Arial Unicode MS in the Infrastructure Settings. For details, see “Enabling
Chinese or Japanese Characters in Top View” in Application Administration.

Do not select a new view in the Role-Based Views list until the currently
selected view has finished loading. Doing so may cause the browser to
freeze. If this happens, close the Top View browser page, then close any
other open Mercury Business Availability Center browser pages, and reopen
Mercury Business Availability Center.
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Network Operations Center View

You can display the top view tree in a separate window to be used by a
Network Operations Center (NOC).

Monitors ¥Yiew g
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Only one instance of Top View can be displayed at a time; this means that if
you are displaying the top view in the NOC View standalone window, you
do not see it in the Top View tab and vice versa.

To display the top view in the NOC View standalone window, click
NOC View at the bottom right corner of the Top View tab. To return to the
Top View tab, close the Top View standalone window.

Monitoring the Connection to Tomcat

The Last Update message in the bottom-left corner of the tab shows
connectivity with the Dashboard servlet, running on the Tomcat servlet
engine. The Last Update message text displays the time the information in
the tab was last updated.
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Dashboard Console

The Console tab presents your views in tree format, indicating status for
each CI under each KPI.

This chapter describes: On page:
Navigating the Console Tab 86
Understanding the Console Tab Page 87
Viewing Real-Time Changes to CI Properties 91
Menu Options for Cls 93
Service Level Management Results in Dashboard 93

See Also...

> “Sound Alert for Critical Status in the Console and Filter Tabs” in Application
Administration

» “Hiding or Showing the Ack Column” in Application Administration

» “Modifying the Number of Levels in the Console Tab” in Application
Administration

> “Specifying the Number of CIs that Can Be Monitored for Change in Real-
Time” in Application Administration

» “Specifying Different Status Icons” in Repositories Administration

» “Modifying the Tooltip Border and Header Colors” in Repositories
Administration
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Navigating the Console Tab

When you click the Console tab, Dashboard displays the Console page (for
details, see “Understanding the Console Tab Page” on page 87):

MERCURY" APPLICATIONS ~ | ADMIN~ | MY BAC | HELP ~ | SITEMAP |  LOGOUT
Business Availability Center - Dashboard Customer: Sanity 1 User administrator
ﬂ E E J Browse|Search Top View | Console Filters Geographical Map Custom Map Topology Map Reports ‘
View: W =] Manitors View — Jﬂﬂﬂ
Nama Systenn Siebel e Availability Sessions Tasks in ervor Volume Ack
25 monitors view (%% born orafile Sanity 3 1 i : e
(32 bpr_profile_sanity_1_1 [7 bpm profile sanity 1 2w ]
AF bpr_profile_Ssnity_1_2 catapultl v L
" catapult S i @4 @ 104 36 ]
@ :ta:': :mmE sanitet [%3 fiot bom profile Sanitv 2 1 v : = Qe Qpe -]
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|
|
View Explorer Last Update Cls KPls and Context tools Acknowledgment
message their statuses/
values

When the Console tab is selected, Dashboard includes the following
features:

» View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select Cls,
and to perform operations on the ClIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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» Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 83.

» Cls. The tree is built from group parent and children configuration items
(CIs) and monitor ClIs. For details, see “Working with ClIs in IT Universe
Manager” in IT Universe Manager Administration.

> KPIs and their statuses/values. For each CI, Dashboard displays real-time
status in one or more KPI columns used in the view. A color-coded icon
(LED) is displayed for each KPI in a view, representing the status assigned to
that component for its current performance level. In addition to the main
status icon for a KPI, the KPI column may contain additional icons showing
trend and history for the CI under that KPI. For details, see “Understanding
KPI Status” on page 59.

» Context tools. Click the buttons to expand, collapse, to go up or down one
level in the tree of CIs, or to switch on/off the sound alert for Critical status.
For details, see “Understanding the Console Tab Page” on page 87.

» Acknowledgment. Shows the components of the active Dashboard view
organized into the same hierarchy tree format that you defined for the CIs
in Dashboard Administration. For details, see “Acknowledging Performance
Problems” on page 4S5.

Understanding the Console Tab Page

The Console tab page shows the components of the active Dashboard view
organized into the same hierarchy tree format that you defined for the CIs
in Dashboard Administration. For details, see “Working with ClIs in

IT Universe Manager” in IT Universe Manager Administration.

The tree is built from group ClIs (parents and children) and monitor CIs.

The KPI columns for the view (for example, System, Performance, and
Availability) contain colored indicators representing performance status for
each CI under that KP1I (if the KPI is applicable for the CI). Note that if a KPI
is relevant for at least one CI in the tree branches currently displayed, then
that KPI is displayed for all CIs. The KPIs that are not relevant for a
particular CI display a hyphen (-) meaning that the KPI is not applicable for
this CI.
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For an explanation of the status icons, see “Understanding KPI Status” in
Using Dashboard.

Tip: Hold the cursor over the entry in the Cl Name column to display the
full name of a CI in a tooltip.

This section includes the following topics:

> “Navigating in the Tree” on page 88
> “Tooltips” on page 90
> “Sound Alert for Critical Status” on page 90

Navigating in the Tree

The Console tab top level displays the view and the status of the top level
CIs’ KPIs. The tree pane provides a “snapshot” of tree branches at two
consecutive levels (configurable default). When you first access the view, if
there is only one parent, you see the two highest levels: Mercury Tours
Business (parent) and Springfield and Unionville (children).

Top View I Console Filters | Geographical Map | Custom Map | Topology Map | Reports |

Mercury Tours Business B
CI Name Systemn Performance Awailability PNR

@ Sprinafield Q@ ° 9 2 o g -93M 475

@ Unionville

If there is more than one child, all Cls are shown collapsed when you first
access the view.

You can expand each CI individually to show the child CIs for that CI, or
you can use the Expand All/Collapse All buttons to expand all Cls in the
view (so that you see child ClIs for all CIs). Note that these buttons are
shown only when one or more of the currently displayed ClIs can be
expanded or collapsed.
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After a Cl is expanded using either of these methods, it remains expanded
for as long as the browser window is open, even if you move to another
Mercury Business Availability Center application.

If you move from another tab to a CI in the Console tree pane (for example,
by clicking a CI name in the Filters tab, or by selecting an option from a CI
options menu), then the relevant CI name is shown highlighted in the tree
(and in the View Explorer), and the CI is shown expanded. However, Cls
expanded in this way do not retain the setting and are collapsed again when
you move away from that level of the view.

To view the ClIs two levels down from the current ClIs, click a drill-down link
(linked CI name). CIs are displayed as drill-down links if there is at least one
level below the CI, or if there is at least a CI with child CIs within the same
branch. In the above example, the Cls Springfield and Unionville are shown as
drill-down links because Mercury Tours Business is a CI with child CIs. Click
Springfield to display the CI’s child CIs. The view of the tree changes;
Springfield is shown as the parent CI and the level under the selected CI is
displayed.

Springfield ﬂﬂjﬂ

System @ * performance , % Availability ©) ¥ PWR CTHD -93M 475

CI Name Systemn Performance Awailability  PHR
@ @ Fl ]
=4 Infra supp ... pringfield * o o= [
@ @ \ ]
@Trauel zer ... pringfield * o .- k=

The CIs at the new level are by default shown collapsed; however, if the
displayed level contains only one parent CI, or if you have previously
expanded ClIs, then the child CIs are shown for the relevant Cls.
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Tooltips

Hold the cursor above the icon to display a tooltip that provides more
information about the change:

Details - Performance

CI nanne ! tx_5

Status: K

Calculation Rule: warst Child Rule
Held status since ! 2/19/06 05:43:44 AM

The tooltip includes the following information:

» Cl Name. The name of the CI.

» Status. The status of the CI (calculated according to one of the status

calculation methods). It may also display:

> Not up to date. For decayed ClIs, indicating that the CI has passed its
timeout period. (For a SiteScope CI, this status is displayed after a
SiteScope monitor is disabled.)

> Stopped. When a Business Process profile is stopped.

Calculation Rule. The name of the rule that calculates the KPI status or
value.

Held Status Since. The date and time since which this CI has held its current
operational status.

Invisible Children. Might not appear. The number of child CIs belonging to
other views, which are connected to this CI but do not belong to this view —
“Editing CI Properties” in IT Universe Manager Administration.

Sound Alert for Critical Status

Dashboard provides the option to have a sound play when a CI changes
status to Critical (red), to provide an aural notification of the change in
status.

The Sound On/Off button is displayed in the top right corner of the Console
tab. Click the button to toggle the sound on or off.

The icon tooltip indicates the action you will perform if you click the
button.
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When the sound is switched on, a sound alert is played when the Console is
currently displayed and a CI’s KPI changes status to Critical (red). The
Critical status icon is also shown flashing until the next screen refresh.

Note the following additional conditions:

» The sound is played only if the status of a CI’s KPI in the currently displayed
tree branches has changed to Critical. If a Cl in a hidden part of the view has
changed to Critical but does not change the status of any of the Cls in the
currently displayed branches, no sound is heard.

» If the view is being loaded for the first time, no sound is played for the CI’s
KPIs that are loaded at Critical status.

Note: The alert sound is a .wav file downloaded by the browser. If you are
using Mozilla, you must download a plug-in for playing .wav files,
otherwise no sound will be heard.

The default alert sound can be changed by users with administrative
permissions.

Viewing Real-Time Changes to Cl Properties

Change icons are displayed in the Console tab report and in the Filters tab
- report, between the name of the CI and the down arrow to indicate that
changes were made to the CI’s or KPI's change-monitored properties, in real
time. The change-monitored properties are the properties for which the
Change Monitored parameter has been selected. For more information on
CIT definitions, see “Managing CITs” in CI Type Manager Administration.

To display real-time changes for a CI and its child Cls, the Monitor changes
check box must be selected for the CI. For details, see “Real-Time
Monitoring of CI Property Changes” in Application Administration.

A limited number (twenty by default) of Cls (and their child CIs) can be
monitored for real-time changes at any one time. This number can be
customized.
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By default the Change icon is displayed for 24 hours (default value) after a
change has occurred. This time period can be customized.

Note: To view the real-time change icons you must have the Shared CMDB
feature installed. For details, see “Real-Time Monitoring of CI Property
Changes” in Application Administration.

Changes made to other CIs are displayed in the Change report. For details
about the Change report, see “Change Report” on page 199.

The Change icons are:

left-pointing arrow and star indicate that at least one change-monitored
property of CI itself has changed.

down-pointing arrow and star indicate that at least one change-monitored
property of the CI's child CIs has changed.

both left-pointing and down-pointing arrows and star indicate that at least
one change-monitored property of the CI and at least one
change-monitored property of the CI’s child CIs has changed.

Hold the cursor above the icon to display a tooltip that provides more
information about the change:

Change - This CI and those related to it have changed

=) bloormberg s=l 1 from part-tng
=
2 v bloomberg ssl 1

=) bloomberg ==l 1 from wall

The tooltip header indicates whether the change was made to the CI, the
CI’s child CIs, or both.

» The tooltip body lists the CIs that were changed.
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Menu Options for Cis

¥ You click the down arrow to the right of a CI name to access the menu
options for that CI. The available options vary, depending on the CI type
and on the context menu defined for the CI. If no context menu is defined
for the CI, then it will not have a menu arrow. If one of the menu options is
not supported for the selected CI, that option is shown disabled.

The menu options are available for Cls in the Console and Filters tabs. For
information on the various menu options, see “Context Menus Repository”
in Application Administration.

The menu options available for a CI may include the following
functionality:

» Enable you to move to other Mercury Business Availability Center
applications or SiteScope to view information and reports related to the CI;
for example, you can view a trend report on the End User Management
page, containing measurement data for the CI over a specified time period.

» Enable you to move to the Filters tab to view ClIs for a CI’s subtree. You can
select an option to filter the subtree CIs and monitor ClIs, in which case the
ClIs are filtered according to the current active filter selected in the Filters
tab.

For details about the menu options, see Chapter 2, “Dashboard Menu
Options”.

Service Level Management Results in Dashboard

You use the Dashboard Console to proactively monitor your service level
agreements (SLAs). The console displays a PNR KPI bar that enables you to
see which SLAs are problematic. You can drill down to see which specific CI
may cause you to breach a service contract.

Dashboard calculates whether the measurements of an SLA are within the
limits set out in a service level agreement (as defined in Service Level
Management). Furthermore, Dashboard calculates whether an SLA is in
breach of contract, or may be in breach in the near future.
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Dashboard displays the results color-coded according to the status of the CI
(that is, whether the CI is functioning within the SLA’s time constraints).

For details on attaching a PNR (point of no return) KPI to a CI to view data
in Dashboard, see “Attaching a PNR KPI to a CI” in Application
Administration.

This section includes the following topics:

» “PNR Details” on page 94
» “How Dashboard Calculates Unavailability” on page 95

PNR Details
The following example shows the PNR of an SLA:

PNR CHIT -12M 478 Ack B

Details - PNR

CI name: profilel
Status: Breached
Calculation Rule: Cashboard PHR
SLA: alga

Tracking Period: Hour

Time Interval: 24x7
Calculation Time ! 1/19/06 12:00:00 PM
PHR Time Left: -18min. 47sec
Max unavailability : 1min. 1Zsec
PHNR availability: 6E.679%

Target availability: 98.0%

» Cl name. The name of the CI that is attached to the SLA.
» Status. The status of the SLA as defined in the Edit KPI dialog box. For

details, see “Defining Objectives” in Application Administration.

Calculation Rule. The name of the rule that was used to calculate the value
of the PNR.

» SLA. The name of the SLA.

» Tracking Period. The time period by which Service Level Management filters

the calculation (in this example, Hour).

Time Interval. The actual period of time for which Service Level
Management calculates data.
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Calculation Time. The date and time from when Service Level Management
begins calculating the SLA. In this example, the time period being measured
is 1/19/06 12:00:00 PM to 1/19/06 01:00:00 PM.

PNR Time Left. The time remaining before the service level agreement (SLA)
contract is breached (in this example, 18 minutes and 47 seconds).

Max Unavailability. The maximum time that a KPI may be unavailable (in
this example, 1 minute and 12 seconds) without breaching the SLA contract.

PNR Availability. The availability percentage of the KPI at the last time data
was polled. PNR availability is calculated from the start of the time range (by
default, at 00:00) till the current time.

Target Availability. The percentage of time that the KPI must be available,
according to the SLA. For an example of unavailability, see the next section.

Note: The PNR KPI takes the score of the worst result from the lower levels
of the SLA (the worst child result).

How Dashboard Calculates Unavailability

Service level agreements regularly include a clause covering unavailability,
that is, the period of time that a system may be down. For example, if
availability must be 98.5%, then a system may be unavailable 1.5% of the
time.

The Dashboard PNR Rule (the rule always assigned to the PNR KPI)
calculates unavailability according to the target availability for the CI (the
time that the component must be available, according to the SLA). This
calculation is also based on the measurements for the Service Level
Management Availability KPI that is attached to the CI when creating the
SLA.
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The following example shows how Dashboard calculates the time a system
may be unavailable:

The start of the week is Monday, 8 Aug 05 00:00 AM.

Today is Friday 12 Aug 05 10:15 AM.

The time range is Week to Date.

The time interval is Business Hours, that is, 8:00 AM to 5:00 PM, Monday
to Friday.

The time that has passed for this time range is:

4 whole days (Monday to Thursday) = 4 x 9 = 36 hours.

Part of a day (Friday) = 8:00 AM - 10.15 AM = 2.25 hours.
Total time = 38.25 hours.

Availability (as defined in SLA) = 98.5%

Availability, therefore, must be 98.5% x 38.25 = 37.68 hours.
Maximum unavailability = 38.25-37.68 = 0.57 hours.

If unavailability reaches above this limit, Dashboard changes the status icon
colors in the SLM tab.
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Dashboard Filters

The Filters tab enables you to view operational status for specific segments
or components of your business. The Filters tab displays (in a flat
non-hierarchical way) the configuration items (Cls) that match the
following criteria: they belong to the selected view, and at least one of their
Key Performance Indicators (KPIs) has the status specified in the active filter.

This chapter describes: On page:
Navigating the Filters Tab 98
Understanding the Filters Tab 100
Setting Active Filters 102
Searching for Specific CIs and Filtering the Results 108
Quick Filter 112
Menu Options in the Filters Tab 115

See Also...

“Sound Alert for Critical Status in the Console and Filter Tabs” in Application
Administration

> “Hiding or Showing the Ack Column” in Application Administration

» “Specifying the Number of CIs that Can Be Monitored for Change in Real-

Time” in Application Administration

» “Specitying Different Status Icons” in Repositories Administration

> “Modifying the Tooltip Border and Header Colors” in Repositories

Administration
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Navigating the Filters Tab

When you click the Filters tab, Dashboard displays the Filters page (for
details, see “Understanding the Filters Tab” on page 100):

MERCURY" APPLICATIONS ~ | ADMIN ~ | HELP = | SITEMAP |  LoBOUT
Business Availability Center - Dashboard User: administrator
o ,: . X Browse|Search|? Top View | Console Filters Geographical Map | i v ke | Reports
= - Search|
i il 1 lobal: Show All -  —
view: [Monitors View ol ke Active Filters:  [global: Show =
- Quick Filterby Statuses: @ [T A G G @ o @ @r e El ey
sanea Name System  Performance | _ Availability _|Held status since Ack |~
! Bla Bla Knot T % packets good * & - 03:01:58 PM -]
 elad ol . - 01:40:38 PM a
? espresso
o T 9 packets qood » - : 01:40:38 PM e
S oquy
' knot I 96 packats good ™ = - 2:01:53 PM -]
7 netknat W oasaaa v = 03:01:58 PM -]
5 schulman rv—
[ siebel cannon I o ccess permitted v > 0%:01:58 PM -]
b [7 siehel whistle T 2 1:40:38 PM -]
4 F yarivknot
. M access parrnitted ot : 01:40:38 PM -]
 yossi
T sccess permitted v - = 01:40:38 PM -]
T sccess permitted = - . 03:01:53 PM -]
U sccess permitted ¥ - 0%:01:58 PM -]
“.¢ app server v o 03:01:58 PM ?
“.7 app server v "] 01:40:38 PM ]
“.7 Applicatio ... = subgroup = = : 0Z:46:52 PM -]
 Applicatio ... s subgroup ¥ - : 02:10:10 PM -]
T spplicstio ... uency mesn : - 01:40:38 PM -]
T spplicstio .., uency mesn ¥ : 03:01:58 PM -]
[ R T R il n1:an:3a pm | a
Last Update - 03:43:21 AM
View Explorer Quick Last Update Cls KPlIs and Active filters ~ Alarm Acknowledgment
filter message their statuses/
values

When the Filters tab is selected, Dashboard includes the following features:

> View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select ClIs,
and to perform operations on the ClIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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Quick filter. Enables you to create a temporary filter to display CIs whose
KPIs have one of the selected statuses. For details, see “Quick Filter” on
page 112.

Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 83.

Cls. The tree is built from branch parent and children configuration items
(CIs) and monitor ClIs. For details, see “Working with CIs in IT Universe
Manager” in IT Universe Manager Administration.

KPIs and their statuses/values. For each CI, Dashboard displays real-time
status in one or more KPI columns used in the view. A color-coded icon
(LED) is displayed for each KPI in a view, representing the status assigned to
that component for its current performance level. In addition to the main
status icon for a KPI, the KPI column may contain additional icons showing
trend and history for the CI under that KPI. For details, see “Understanding
KPI Status” on page 59.

Active filter. Enables you to create filters that enable you to filter the Cls
displayed in the Filters tab, enabling you to focus on the specific view, on
specific CI types or statuses, or on problematic areas. For details, see “Setting
Active Filters” on page 102.

Alarm. Switches on/off the sound alert for Critical status. For details, see
“Sound Alert for Critical Status” on page 90.

Acknowledgment. Shows the components of the active Dashboard view
organized into the same hierarchy tree format that you defined for the CIs
in Dashboard Administration. For details, see “Acknowledging Performance
Problems” on page 4S5.
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Understanding the Filters Tab

100

The Filters tab displays a filtered list of CIs and the current operational status
in each Key Performance Indicator (KPI) for each CI. The displayed Cls
belong to the selected subtree. All CIs in the Filters tab are shown at the
same level (non-hierarchically).

Active Filters: | alobali Show All = ﬂ
Quick Filter by Statuses: [+ ] [ O @0 -§< [mS O [l O Il Iﬁ Apply
Hame Performance  Awvailability OT Impact Held status since Ack |
(D blocmberg ssl + petails Qe - 12:31:55 PM x|

(D bloomberg szl v Detsils et 12:23:40 PM &

(P bloombera ssl 1 v petails 9+ 9+ 07:32:40 PM x|

@ bloomberg ss1 1 * Details 9+° @+ $0 12:23:10 PM X

= bloornberg ... m rovaloak * Details @+ 9+* $o0 12:23:10 PM e

6 bloarnberg ... m rovaloak * Details 9s® @+ 12:31:55 PM

B bloomberg ... m rovalosk v Details @+ L Ao 12:31:95 PM

e bloarnberg ... m rovaloak ¥ Details 9s® Qs $0 12:23:10 PM ed

B2 bloomberg szl 1 fram Wall ¥ Details o @+ 12:23:40 PM td

= bloormberg ==l 1 from Wall * Details 92 [ R 12:25:40 PM x|

&2 bloarnberg ssl 1 from Wall * Details #® @+ 12:23:40 PM td

= bloomberg szl 1 from Wall * Details Qs Qs 12:23:40 PM e

(D bloomberg szl 2  Detsils Get 9+ 07:32:40 PM ]

(7 bloamberg ssl 2 + petails Qe L Lo $0 12:23:10 BM x|

2 bloombera .. m rovaloak v Details @2 @ $0 12123110 BM |

ez bloomberg ... m rovaloak ¥ Details -.&%‘,E 9+ 12:31:55 PM e

X bloombera .. m rovaloak v Details Qo2 @ $0 12123110 BM x|

r [ P T R (RO W - W O Q2 [ L3 12:31:55 PM < B

If none of a CI’s KPI statuses match the filter, the CI is not listed.
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The Filters tab contains the following components:

» Active Filters link. Define or modify active filters in the Defining/Editing
Filters dialog box. For more information, see “Setting Active Filters” on
page 102.

> List of existing filters. Select a filter from the Active Filters list. The filter can
be one of the predefined filters or a custom filter.

> Quick Filter by Statuses. Select a combination of KPI statuses in the Quick
Filter bar. For details, see “Quick Filter” on page 112. You can also use one of
the options in the list to further filter the results:

» All. To display all types of CIs whose KPIs match the selected
combination of KPI statuses selected in Quick Filter.

» Monitors only. To display only the monitor CIs whose KPIs match the
selected combination of KPI statuses selected in Quick Filter.

» All excluding monitors. To display all types of Cls, except the monitor
Cls, whose KPIs match the selected combination of KPI statuses selected
in Quick Filter.

» Click Apply to apply the Quick Filter selection to the display.

» Sound On/Off. Enables a sound to be played when a CI changes status to
error/worst (red), to provide an aural notification of the change in status.
For more information, see “Sound Alert for Critical Status” on page 90.

» The table of filtered Cls includes the following information:

» Name. Displays the filtered list of CIs. You can click a specific CI name to
move to that CI in the Console tab. The relevant CI is shown highlighted
in the View Explorer.

The arrow to the right of a CI name opens the options menu for the CI.
For details, see “Menu Options in the Filters Tab” on page 115.

For details about the Console tab, see “Dashboard Console” on page 85.

» KPIs. Displays text or an icon indicating the current operational status of
each CI. For an explanation of the color coding for status icons, see
“Understanding KPI Status” in Using Dashboard.

> Held Status Since. The time and date when the KPI status changed to the
current status.
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» Ack. Displays an icon that represents the CI Acknowledgment status. For
details, see “Acknowledging Performance Problems” on page 45.

A Details tooltip for each status icon provides some information regarding
the calculation method in use for the KPI.

Details - Performance

CIname: siebel 7.7 whistle cc
Status: Minor

Calculation Rule: warst Child Rule
Held status since ! &f4/06 10:53:50 PM

For details, see “Viewing Additional Information for CIs” on page 67.

Tips
You can sort the information displayed in the Filters tab according to the

entries in any column by clicking the column header. You can toggle
between ascending and descending order by clicking the header again.

If you select (in the View Explorer) a specific CI, the filter works only on the
CI’s subtree.

If you select the view's root, the filter is applied to the whole view.

Hold the cursor over a CI to display its full name in a tooltip.

Setting Active Filters

102

You use the Active Filters capability to create filters that enable you to filter
the CIs displayed in the Filters tab, enabling you to focus on the specific
view, on specific CI types or statuses, or on problematic areas.

The currently active filter is displayed in the Active Filters box in the Filters
tab. You select an alternative filter from the Active Filters list.

The Active Filters list contains the Dashboard predefined filters (shown as
gray text strings) and any additional filters you have defined (shown as
black text strings).

You can also create your own filters or modify existing filters.
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This section includes the following topics:
“Visibility” on page 103

“Predefined Filters” on page 104

“Defining or Customizing Filters” on page 105

“Deleting a Filter” on page 108

Visibility
The following levels of visibility are available:

Global. The global active filters are pre-defined and built-in. They are
available for all users of all customers. The global active filters cannot be
modified. You can use the global active filters as templates to build public or
private active filters. Their names have the following syntax:
global:<name>. They appear in the list of active filters as gray text strings.
For a list of global active filters, see “Predefined Filters” on page 104.

Public. Administrators or users with the appropriate permissions can build
public active filters. The public active filters are available for all users at the
specific customer. You can use the global active filters as templates to build
public active filters. Their names have the following syntax: public:<name>.
They appear in the list of active filters as black text strings.

Private. Users can build their own private active filters. The private active
filters are available only to the user who created them. You can use the
global and public active filters as templates to build private active filters.
Their names have the following syntax: private:<name>. They appear in the
list of active filters as black text strings.

For each user name used when logging on to Mercury Business Availability
Center, Dashboard creates an associated filters file. When you log on to
Mercury Business Availability Center using a specific user name, you can
only view and modify the filters contained in the associated filters file. The
file is updated with the filter modifications made by each user who logs in
under this user name, so any changes you make to the filters may overwrite
modifications made by previous users.
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» Temporary. Another type of private active filter. These filters are created

when you select statuses in the Quick Filter and click Apply or when you use
the Filter subtree - Monitors only option in a CI context menu. The name of
the temporary filter is temp: Quick Filter. For details, see “Quick Filter” on
page 112. You cannot save temporary filters.

Note:

» If more than one user is logged in at the same time using the same user
name (for example, admin), then every time one of the users saves a
change to the filters, the associated filters file is updated with a copy of
that user’s filters.

» The information displayed in the Filters tab is not refreshed while the
Defining/Editing Filters dialog box is open. (This also applies when the
Defining/Editing Filters dialog box is not in focus.)

Predefined Filters

Dashboard includes several predefined filters. Each predefined filter is used
to include or exclude Cls according to their type, and KPIs according to their
status. These filters cannot be modified or deleted. The predefined filters are
as follows:

» global: Show All. Displays all the Cls, all their KPIs, and the status of the
KPIs.

» global: Show Errors. Displays, for all CI types, only the CIs whose
Availability, Customer, HP System, OT Impact, PNR, Performance, RT
Impact, System, User, Volume, and custom KPIs have a critical status.

> global: Show Errors — Monitors Only. Displays only the monitor Cls
whose Availability, Customer, HP System, OT Impact, PNR, Performance,
RT Impact, System, User, Volume, and custom KPIs have a critical status.

> global: Show Errors and Warnings. Displays, for all CI types, only the CIs
whose Availability, Customer, HP System, OT Impact, PNR, Performance,
RT Impact, System, User, Volume, and custom KPIs have a minor, major,
or critical status.
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> global: Show Monitors Only. Displays only the monitor CIs, their KPIs,
and the status of the KPIs.

» global: Show PNR. Displays, for all CI types, only the CIs whose PNR KPI
has an OK, Warning, Minor, Major, Critical, or No Data status.

By default, a filter is called Custom Filter when you create a filter without
assigning it a name.

Defining or Customizing Filters
You can define new filters or customize existing filters.
To define or customize filters:
1 Select Application > Dashboard, and click the Filters tab.
2 Select the view in the View Explorer.

3 Click the Active Filters link. The Defining/Editing Filters dialog box opens.

Seled a filter : Ipriuate: Custom Filter ;I Rename Save As | New | Delete | Clear All
visibility: T Public ™ Private
Define filter:

[Fh [Fh [Fh Fh [Fh 4 Fh [Fh -

4[] an w1 ] 4[] 4[] 4[] w1
Application Ooe Impd O« o< ImL Imp [l ':;:' [l ':;:
Aweail ability 0oe Ooa Ooe | m Im Ooa m & mE
Bandwidth [ [ [ | [ critical [ [ [
Component a 3 1 (@) (o
Somponert [ @ oe o@ o&a 0Oe oe 0@ p@
Customer l- [ l- ~ l- ' I- i l- & l- ‘- l- et l- =
?n:::;'fd O O O O O critical O O O
DT Late Impact [ [ [ Il O critical [ [ [
o r r r r O critical [ r r
HP Systermn Oe Ooe O« Ooe Imp Ooe [l ':;' [l ':;2
Latency | | | O [0 critical | | | hd
Filter by CI type : All -
Filter by Change ! IIgnore Configuration Changes ;I
Acknowledged: IAII ‘I

OK | Cancel Help
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4 Select one of the following options:

» To define a completely new filter, click New. All the KPIs’ statuses are
cleared.

> To use an existing filter as the basis for the new filter, select the filter
name in the Select a filter list and then click Save As. The KPIs’ statuses
that were selected for the filter you are using as a model are still selected.

» To modify an existing filter, select it in the Select a filter list.

The Filter Name dialog box opens. Enter a name for the new filter (this must
be a unique name). This creates the new filter and adds it to the active filters
list. Click OK to save the filter to the active filters list.

Pleaze enter 3 name for the filker

||Custom Filter

0K | Cancel |

Select the required Visibility option:
visibility: ) Public ™ privats

» Private. If you want to create a private filter.

» Public. If you want to create a public filter.

Note: Visibility is displayed only to the administrator or to a user with the
appropriate permissions.
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7 Enter the appropriate information in the Define filter area. You can specify

any combination of the filter criteria listed in that area. The filter displays
the CIs that meet all the selected criteria, as follows:

» Select the check box for each KPI status type that you want to include in
the filter.

Note: If no status is selected for a KPI then all statuses are included in the
filter.

To invert the selection use the Invert Selection button.
> In the Filter by CI type list, select one of the following options:
o All. All the types of CIs are included (monitor and non-monitor CIs).

o All excluding monitors. All the types of Cls are included except for
monitor Cls that are excluded.

e Monitors only. All the types of CIs are excluded except for monitor Cls
that are included.

> In the Filter by Change list, select one of the following options to filter
by the CIs that are set to be monitored in real-time for changes (only 20
Cls and their children can be monitored at a time). For details, see
“Change Report” on page 199:

¢ Ignore Configuration Change. To display all CIs, whether their
configuration changed or not.

¢ Only Changed Configuration Items. To display only the CIs whose
configuration changed.

¢ Exclude Changed Configuration Items. To display only the CIs whose
configuration did not change.

> In the Acknowledged list, select one of the following options:
o All. To display all the CIs whether they are acknowledged or not.
¢ Yes. To display the CIs that are acknowledged.
¢ No. To display the CIs that are not acknowledged.
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8 Click OK to save your changes to the currently displayed filter and to close

the Defining/Editing Filters dialog box.

Click Cancel to exit the Defining/Editing Filters dialog box without saving
your changes to the filter criteria for the currently displayed filter. The filter
you created is saved and will appear in the Active Filters list.

Deleting a Filter

You can delete filters.

To delete a filter:

1 Click the Active Filters link. The Defining/Editing Filters dialog box opens.

Select the name of the filter you want to delete from the Select a filter list.
Filters that can be deleted are shown as black text strings.

3 Click Delete. Dashboard displays a confirmation message.
4 Click OK to delete the filter from the Active Filters list.
5 Click OK or Cancel at the bottom of the Defining/Editing Filters dialog box

to close the dialog box.

Searching for Specific Cls and Filtering the Results

108

You can search for a specific CI using the View Explorer search function to
filter the list of Cls that Mercury Business Availability Center displays. For
more details about the Search feature, see “Searching for Configuration
Items” in Working with the CMDB. You can locate CIs by their name, by
related ClIs, by their CITs, in the current view, or in all views.

If, in addition to using the Search feature in View Explorer, you display the
Filters tab in the right pane of the Dashboard, the resulting filtered report
displays only the ClIs that have been located by the search filtered by the
selected filter in the Filters tab.

This section includes the following topics:

» “Searching for ClIs in the Current View” on page 109

» “Searching for ClIs in More Than One View” on page 111
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Searching for Cis in the Current View

You can search for CIs by their name, by related Cls, and by their CITs in the
current view.

The result is a list of all the CIs corresponding to the search criteria listed in
View Explorer. The Filters tab displays a filtered list of the Cls and the CI’s
children CIs corresponding to the search criteria filtered by the active filter
and the current operational status in each KPI for each one of those ClIs.
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If the search result is a single CI, or if you click one of the CIs in the results
of the search list, the Filters tab displays the selected CI and the CI’s children
Cls filtered by the active filter, and the current operational status in each KPI
for each of those ClIs.

N] Browse|Search| ? Top View | Console I Filters Geographical Map | Custom Map Topology Map Reports |
-
Search far: Iproﬁle Active Filbers: Iglobal: Show Ervars ;I ]
gearch in: (¢ current .
view Cuuick Filter by L o ' v G 2 @ @ Im Apply
Al views Statuses: O O O O O O O O
[ Related to: I:lJ Mame Performance Availability Held status since Ack
[ocreyper [ el &% bom profile 1 v @2 @2 02:10:02 PM =]
m— Edtx 15 v R 9+° 02:10:02 PM (]
earc e
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Searching for CIs in More Than One View

You can search for CIs by their name, by related Cls, and by their CITs in all
the views.

The result is a list of all the CIs and the views in which they are included,
corresponding to the search criteria listed in View Explorer. The Filters tab
displays a filtered list of the CIs corresponding to the search criteria filtered
by the active filter and the current operational status in each KPI for each of
those ClIs.

Browse|Search| ? Top View | Console I Filters Geographical Map | Custom Map Topology Map Reports |
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You can click a specific CI in the results of the search list to display in the
Filters tab a filtered list of the CIs corresponding to the search criteria and to
the selected view, filtered by the active filter and the current operational

status in each KPI for each one of those Cls.
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Quick Filter

Quick Filter enables you to display Cls whose KPIs have one of the selected
statuses. The filter is a temporary filter that persists until you log off, until

you change its selection of statuses, or until you select another filter.

After you have selected a combination of filters to display a view’s data, you
can further refine the report by selecting specific KPI’s statuses. The CIs that
are displayed have at least one of their KPIs with one of the selected statuses.
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Note: You cannot save the settings you selected in Quick Filter, but you can
create a similar filter using Active Filter. For details, see “Setting Active

Filters” on page 102.

For example, the report is as follows:
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Last Update - 10:25:49 AM

To display only the CIs whose KPIs have the OK and/or Critical statuses,
select those statuses in the Quick Filter bar and click Apply.

Quick Filter by Statuses: [*]

!!D‘-}c

D@D @D
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The following filtered report is displayed:

Top View Console Filters Geographical Map | Custom Map | Topology Map Reports
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To display a combination of statuses:
Select Application > Dashboard, and click the Filters tab.
2 Select the view in the View Explorer.

3 Select the filter in the Active Filter list and select one of the Filters options
from the options list.

4 Click Apply to display the report.

5 Select one or more statuses in the Quick Filter by Statuses bar and click
Apply.
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Menu Options in the Filters Tab

A list of all the menu options available in the Filters tab is provided in
Chapter 2, “Dashboard Menu Options”.
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Dashboard Geographical Map

The Geographical Map tab enables you to view an association between
geographical locations and status indicators using a map applet, or
Microsoft MSN Virtual Earth.

This chapter describes: On page:
Navigating the Geographical Map Tab 118
Overview of Geographical Maps 120
Working with the Virtual Earth Geographical Map 123
Working with the Geographical Map Applet 127

See Also...
> “Configuring the Geographical Map” in Application Administration

» “Customizing View Options” in Application Administration
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Navigating the Geographical Map Tab

118

When you click the Geographical Map tab, Dashboard displays the
Geographical Map page (for details, see “Overview of Geographical Maps”

on page 120).

MERCURY"
Business Availability Center - Dashboard
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View Explorer

Last Update status of a location with
message group Cls

search

status of a location with  adjustment
monitor Cls buttons

zoom type of display

When the Top View tab is selected, Dashboard includes the following

features:

View Explorer. Enables you to locate configuration items (Cls) in the

application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select ClIs,
and to perform operations on the CIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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search. Use this feature to perform a search in Microsoft MSN Virtual Earth
(outside of Mercury Business Availability Center).

Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 83.

zoom. Enable you to zoom in and out to enlarge or shrink the map For
details, see “Adjusting a Virtual Earth Map” on page 125.

view. When you select a view in View Explorer, the Geographical Map tab
displays the selected view bar centered in the tree with all its root Cls
expanded. For details, see “Overview of Geographical Maps” on page 120

status of a location with group Cls or with monitor Cls. The geographical
map of the view displays the worst status at each geographical location. For
details, see “Working with the Virtual Earth Geographical Map” on

page 123.

type of display. Enable you to select different types of maps. For details, see
“Adjusting a Virtual Earth Map” on page 125.

adjustment buttons. Enable you to zoom in and out to enlarge or shrink the
map. For details, see “Adjusting a Virtual Earth Map” on page 125.

Note: If you do not have an Internet connection, the Geographical Map
page displays a maps applet graphic instead of a Virtual Earth map. For
details, see “Working with the Geographical Map Applet” on page 127.
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Overview of Geographical Maps

120

Dashboard displays, for a specific view, the corresponding geographical map
with real-time status indicators showing the worst status at different
geographical locations.

The CI location is determined either by the location defined in Dashboard
for the data collector host from which the CI originated, or by locations
defined individually for the group or leaf (monitor) Cls in a view.

Each location in the map may represent one or more Cls from the view.

For details on how to define locations and configure map settings, see
“Configuring the Geographical Map” in Application Administration.

Note: The maps applet requires that Sun JRE plug-in 1.4.2_08 be installed on
the client machine. If an earlier version is installed, then Mercury Business
Availability Center automatically tries to download JRE 1.4.2_08 when you
access the maps applet.

If you select a CI in View Explorer, the geographical map is redisplayed
automatically and shows only the selected CI and the CI’s children status
indicators if a location was specified for them.

If you search for a specific CI in the View Explorer and you click the result of
the search, the geographical map is not automatically redisplayed. The map
is redisplayed only when you go back to the browser mode. It shows only
the selected CI and the CI’s children status indicators if a location was
specified for them.

You specify the CI location when you define a new CI or when you edit a
CI'’s properties. For details, see “Configuration Item Properties” in

IT Universe Manager Administration. If you do not specify a geographical
location for at least one CI in the view, the Geographical Map tab displays
only the map.

If you select another view, the geographical map reloads automatically to
show the view’s CI status indicators.
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If you have an Internet connection, geographical maps can be displayed
using Virtual Earth (for details, see “Working with the Virtual Earth
Geographical Map” on page 123). If you do not have an Internet
connection, geographical maps can be displayed using a maps applet (for
details, see “Working with the Geographical Map Applet” on page 127).

Location Status Information

The map presents color-coded status indicators that represent the worst
status at each geographical location. The color coding is the same as for
other icons in Dashboard. For more information about color coding, see
“Understanding KPI Status” in Using Dashboard.

The round icon represents the status of a location with group ClIs.
The square icon represents the status of a location with monitor ClIs.

To determine a location status, Dashboard takes the worst status for all KPIs
attached to all the CIs assigned to that location and determines an overall
worst status.

In addition to the overall worst status for each location, you can view the
worst status for all KPIs associated with the location in the location tooltip
(for details, see below). A KPI is associated with a location if that KPI is
assigned to at least one of the Cls attached to the location.

Geographical Map Tooltips

Tooltips provide the overall status for each KPI associated with the location,
and how long the KPI has been at that status.

Performance
Location: USA, Hew vod, New Yok
Status: Critizal
Held status since: 8/23405 01:16:24 P
Caused by: bpm_profile_1
Availability
Locstion: USa, New Yok, New York
Status: Critical
Held status since: /23005 01:16:34 PM
Caused by: bpm_profile_1
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122

The tooltip includes the following information:

Item Description

KPI Name The name of the KPI. The color of the header
indicates the overall status of the KPI.

Location The name of the location (country, city, and state, if
applicable).

Status The status of the KPI.

Held status since The time and date when the KPI status changed to

the current status.

Caused by The names of the CIs/monitors where the problem
occurred.

The city names use UTFS8 format. If Mercury Business Availability Center is
working with MS-SQL Server, or an Oracle Server that is not configured for
UTEF8 support, then when the name of a city includes non-English
characters (for example, €), these characters are displayed as empty square
brackets [ ].
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Working with the Virtual Earth Geographical Map

If you have an Internet connection you can display the geographical map
using Microsoft MSN Virtual Earth. Mercury Business Availability Center
integrates Virtual Earth online mapping functionality, available over MSN,
to enable you to use the geographical map of a view that displays the worst
status at each geographical location and detailed information about the CI’s
KPIs.

Top View Console Filters Geographical Map Customn Map Topology Map Reports

ANt et Indian Ocean

O cean

Terms ¢

To view the map applet, a user with the appropriate permissions must have
set the Use Virtual Earth parameter to true. For details, see “Selecting the
Type of Display Used for Geographical Maps” in Application Administration.
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124

This section includes the following topics:

» “Displaying the Virtual Earth Geographical Map for a View” on page 124

> “Displaying Additional Information about the Cls at the Location” on

page 125
“Adjusting a Virtual Earth Map” on page 125

Displaying the Virtual Earth Geographical Map for a View

You can display the Virtual Earth geographical map for a view.

To display the Virtual Earth geographical map for a view:

1 Select Applications > Dashboard.

Select a view in the View Explorer.

3 Click the Geographical Map tab to open the geographical map page for the

selected view.
You can then:

» view the status indicators to see the worst status at each geographical
location. For details, see “Location Status Information” on page 121.

» display tooltip details for each location. For details, see “Geographical
Map Tooltips” on page 121.

» display additional information about the CIs for each location. For
details, see below.

» navigate the map to display other locations or to zoom into some
locations. For details, see “Adjusting a Virtual Earth Map” on page 125.

» open the map in a standalone page by clicking open.
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Displaying Additional Information about the Cis at the
Location

Click the status indicator in a specific location to open the KPIs Over Time
report for all the CIs at the location. For details, see “KPIs Over Time
Reports” on page 165.

Adjusting a Virtual Earth Map

By default, a map displayed in the Geographical Map tab has a focus area
(center of map) and a magnification that have been set by a user with the
appropriate permissions. For details, see “Adjusting a Virtual Earth Map” in
Application Administration. The adjusted map is displayed when you click the
Geographical Map tab for the view in Dashboard.

You can zoom in and out to enlarge or shrink the map using the IN and OUT
buttons in the top-left corner of the map pane.

You can also zoom in and out to enlarge or shrink the map using one or
more of the following options:

Click the flag button to shift center of map to the nearest CI.
Click the map and drag to move the map in the window.
Double-click on the map to zoom in.

Click the globe button to zoom out completely.

Click the Open in full screen button to open the map on a standalone page.
Close the page to return to Dashboard.
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You can also select how you want to display the map.

Road | Aerial | Hybrid

§

» click Road to display the map with the country borders
» click Aerial to display the map with the topographical features

» click Hybrid to display the map with both the country borders and the
topographical features
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Working with the Geographical Map Applet

If you do not have an Internet connection you can use the maps applet to
display the geographical map of a view. The map displays the worst status at
each geographical location and detailed information about the CI’s KPIs.

@ Gl Click anywhere to shift map center

To view the map applet, a user with the appropriate permissions must have
set the Use Virtual Earth parameter to false. For details, see “Selecting the
Type of Display Used for Geographical Maps” in Application Administration.

This section includes the following topics:

» “Displaying the Geographical Map Applet for a View” on page 128
» “Navigating the Geographical Map Applet” on page 128
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QA&

Displaying the Geographical Map Applet for a View

You can display the geographical map for a view using the maps applet.

To display the geographical map applet for a view:

1 Select Applications > Dashboard.

Select a view in the View Explorer.

3 Click the Geographical Map tab to open the geographical map page for the

selected view.
You can then:

» view the status indicators to see the worst status at each geographical
location. For details, see “Location Status Information” on page 121

» display tooltip details for each location. For details, see “Geographical
Map Tooltips” on page 121

» navigate the map to display other locations or to zoom into some
locations. For details, see “Navigating the Geographical Map Applet” on
page 128

Navigating the Geographical Map Applet

By default, a map displayed in the Geographical Map tab has a focus area
(center of map) and a magnification that have been set by a user with the
appropriate permissions. For details, see “Adjusting a Map Applet” in
Application Administration. The adjusted map is displayed when you click the
Geographical Map tab for the view in Dashboard.

You can:

click the area that interests you. The map shifts to make the location you
clicked the new center of the map.

zoom in and out to enlarge or shrink the map using the Zoom In and Zoom
Out buttons in the top-left corner of the map pane.
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Dashboard Custom Map

The Custom Map tab enables you to view the association between a custom
image that represents a view and real-time data.

This chapter describes: On page:
Navigating the Custom Map Tab 130
Using the Custom Map Tab 131

See Also...
> “Configuring the Custom Map” in Application Administration

> “Customizing View Options” in Application Administration
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Navigating the Custom Map Tab

When you click the Custom Map tab, Dashboard displays the Custom Map
page (for details, see “Using the Custom Map Tab” on page 131).
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View Explorer Last Update status
message indicator

When the Top View tab is selected, Dashboard includes the following
features:

> View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select Cls,
and to perform operations on the ClIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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» Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 83.

» status indicator. Indicates the worst status (worst of all KPIs) of the CI. For
details, see “Using the Custom Map Tab” on page 131.

Using the Custom Map Tab

The Custom Map tab contains a diagram or a picture that represents a view
combined with Dashboard real-time status indicators.

The diagram can represent, for example, a logical network diagram, business
logic, or any other graphical representation of a view used by your
organization.
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The image shown in the Custom Map tab is the one defined for the active
view. When you select a different view, the corresponding image is
automatically displayed in the tab.

An element of the image may be associated with a status indicator
representing the status of a CI. The color of the status indicator indicates the
worst status (worst of all KPIs) of the CI. When you place the cursor over the
status indicator, a tooltip shows the name of the associated CI, and KPI
details. For details about tooltips, see “CI Status Indicator Tooltip” on

page 134.

E% Main Server g’
Flat screen

Laser printer

10,022

l/
-

! = Pen computar
Scanner Workstation

When you click a status indicator, the corresponding CI in the View
Explorer is highlighted. If necessary, the View Explorer will automatically
expand to show the selected CI.

Note: The tab displays the image centered in the image pane. If the image is
larger than the image pane, use the scroll bars.
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Note: When a CI is removed from the IT universe model, the corresponding
Clicon (in Dashboard Administration) and the corresponding status
indicators (in Dashboard) are automatically removed from the relevant
custom maps.

This section includes the following topics:

» “Displaying a View’s Custom Map” on page 133

» “CI Status Indicator Tooltip” on page 134

Displaying a View's Custom Map

You can display the custom map for a view.

To display a view’s custom map:

1 Select Applications > Dashboard.

2 Select a view in View Explorer.

3 Click the Custom Map tab to open the custom map page for the selected

view.
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ClI Status Indicator Tooltip

The tooltip associated with a CI status indicator displays information about
each KPI attached to the CI in a separate section. The color of each section
represents the color of the corresponding KPI's status. For details about the
colors, see “Understanding KPI Status” on page 59.

Details - Yolume

| CIname:

Status:

Held status since:
Details -

CI name:

Status:

Held status since:
Historical worst:

new group
Uninitialized

8/22/05 12:20:53 PM
Performance

new group

Minor

8/22/05 12:20:38 PM
Minor

Details - System

CI name:
Status:
Held status since:

new group
Uninitialized
S/22/05 12:37:13 PM

Details - Awvailability

CI name:

Status:

Held status since:
Historical worst:

new group

(o]

S/22/05 12:12:35 PM
(o]

The tooltip can display any of the following information, depending on the
KPI:

the header of each section displays Details followed by the name of the KPI
Cl name. The name of the CI.

Status. The status of the KPI.

Y VY VY Y

Held status since. The date and time when the status changed to the current
status.

Historical worst. The tooltip of the historical status of the CI. For details, see
“Trend and History Statuses” on page 64.
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Dashboard Topology Map

This chapter describes how the Dashboard topology map enables you to
view the results of either an instance view or a pattern view defined in the
View Manager.

This chapter describes: On page:
Navigating the Topology Map Tab 136
Understanding the Dashboard Topology Map 137
Displaying a Topology Map in Dashboard 137
Understanding Topology Map Functionality 138
Using the Toolbar Options 141
Printing the Contents of the Topology Map 141
Defining a View’s Layout 142
Understanding Layout Options 142

135



Part 1l « Working with Dashboard

Navigating the Topology Map Tab

When you click the Topology Map tab, Dashboard displays the Topology
Map page (for details, see “Understanding the Dashboard Topology Map” on

page 137).
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View Explorer Last Update Cl toolbar
message

When the Top View tab is selected, Dashboard includes the following
features:

> View Explorer. Enables you to locate configuration items (Cls) in the
application with which you are working, for example, Dashboard, Service
Level Management, or IT Universe Manager. View Explorer also enables end
users to view IT elements and the relationships between them, to select ClIs,
and to perform operations on the CIs. For details on how to use View
Explorer, see “Using View Explorer” in Working with the CMDB.
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» Last Update message. Displays the time the information in the tab was last
updated. For details, see “Monitoring the Connection to Tomcat” on
page 83.

» Cl. The CIs that are displayed as the result of a pattern or an instance view.
For details, see “Understanding the Dashboard Topology Map” on page 137.

» Toolbar. The tools that are available to work with the CIs in the topology
map. For details, see “Using the Toolbar Options” on page 141.

Understanding the Dashboard Topology Map

The topology map in Dashboard displays the results of a pattern or an
instance view. You set up the topology map by creating an instance view or
pattern view in View Manager. For information on pattern views, see
“Working with Pattern Views” in View Manager Administration. For
information on instance views, see “Working with Instance Views” in View
Manager Administration.

The topology map shows the results of the currently selected view in the
View Explorer, and consists of Cls and relationships that are defined in the
view you created in the View Manager. You can change the way the maps are
displayed by selecting one of the view layouts (Hierarchical, Symmetric, or
Orthogonal). For details, see “Modifying Layer Layout Options” in Working
with the CMDB. You can also modify the values of the default layer layouts,
as described in “Defining a Layer’s Layout” in Working with the CMDB.

Displaying a Topology Map in Dashboard
This section describes how to display a topology map in Dashboard.
To display a topology map in Dashboard:
1 Select Applications > Dashboard and select the Topology Map tab.

2 In the View Explorer, select the required view from the View list.

For more information about the displayed view, see “Presentation Options
for Views” in View Manager Administration.
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Understanding Topology Map Functionality

138

& [InE]
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This section describes topology map functionality:

“Understanding CI Icon Composition” on page 138
“Selecting Multiple ClIs” on page 139

“Simultaneous Selection” on page 139

“Tooltips” on page 140

“CI Icon Colors” on page 140

“Navigating Between Different Map Levels” on page 140
“Viewing the Selected CI in the Console Tab” on page 141

Understanding ClI Icon Composition

The icon that represents each CI in the topology map is defined by the
administrator in the CI Type Manager. For information on how to assign an
icon to a CIT, see “Assigning an Icon to a CIT” in CI Type Manager
Administration.

Cl icons are made up of the following components:

» An icon.

» The group to which it belongs. For example, Network or SAP System,

appears in the upper left-hand corner.

If an icon appears with a shadow, it means that there is an additional CI
layer beneath it, created by a parent or child organization rule defined in the
View Manager. For information on how to set up organization rules, see
“Adding Organization (Folding) Rules to Relationships” in View Manager
Administration. For information on how to navigate between layers, see
“Navigating Between Different Map Levels” on page 140.
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Selecting Multiple Cis
In the topology map, you can select multiple ClIs.

To select multiple Cls:

Hold down the CTRL button and click the Cls or drag the mouse diagonally
along the CIs as shown in the following figure:
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» : 2y A
. " L L

Qren Sis salsa cm_profile_1 ticker profile

If you select multiple ClIs, only one CI has a black selection rectangle around
it, while all the other selected ClIs have red selection rectangles around
them. In this situation, when you right-click anywhere on the map to open
the context menu, the option is performed only on the CI surrounded by
the black rectangle.

Simultaneous Selection

When you select a CI, it simultaneously selects the CI in both the View
Explorer and the topology map.
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140

Tooltips

» When you point to a relationship in the topology map, a tooltip is
displayed that contains the relationship CI type of the selected
relationship as defined in the CI Type Manager. For details, see CI Type
Manager Administration.

» When you point to a CI in the topology map, a tooltip is displayed
containing information about the CI, as seen below.

Cl name: zap- zmtrangd on mis
Skatus: Ok

Calculation Rule: Warst Child Rule
Held status since: 2/9/06 08:20:55 PM

Availability

Cl narne: zap- 2mtranzd onh mig
Status: (]4

Calculation Rule: Warst Child Rule
Held status since: 2/9/06 08 20:55 PM

For details, see “Viewing Additional Information for CIs” on page 67.

Cl Icon Colors

The colors displayed for a CI icon represent the worst status of all KPIs for
the CI, apart from Change. For information on status levels, see
“Understanding KPI Status” on page 59.

Navigating Between Different Map Levels

If an icon appears with a shadow, it means that there is an additional CI
layer beneath it, created by a parent or child organization rule defined in the
View Manager (in a pattern view). For information on how to set up
organization rules, see “Adding Organization (Folding) Rules to
Relationships” in View Manager Administration.

For example, if the IP CI is defined as a child of the host CI in the View
Manager, you can double-click any host icon in the topology map to display
a map of IPs connected with that host.

To drill down to the lower level(s):

Double-click an icon with a shadow.
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To move up one level in the topology map:
1 Select a CI that has an additional CI layer above it.
i 2 Click the Up layer button.

The Up layer button is enabled only if there is an additional CI layer above
it, created by a parent or child organization rule defined in the View
Manager.

Viewing the Selected Cl in the Console Tab

You can view the selected CI and its direct child CI(s) in the Console tab.

To view the selected Cl and its direct child CI(s) in the Console tab:

Right-click the required CI and select Open in Console. The Console tab
opens and displays the selected CI and its direct child CI(s). For details about
the Console tab, see Chapter 5, “Dashboard Console”.

Using the Toolbar Options

For a description of each toolbar option in the View Manager, see “Toolbar
Options” in Working with the CMDB.

Printing the Contents of the Topology Map

For a description of how to print the contents of the topology map, see
“Printing the Topology Map” on page 38 in Working with the CMDB.
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Defining a View’s Layout

For a description of how to customize the layout of a specific layer in a view,
see, “Defining a View’s Layout” in Working with the CMDB.

Understanding Layout Options

For a description of how you can display the contents of the topology map
using different layout options, see “Understanding Layout Options” in
Working with the CMDB.
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Dashboard Ticker

Mercury Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message

Window without opening Mercury Business Availability Center.

This chapter describes: On page:
About Mercury Dashboard Ticker 143
Understanding Mercury Dashboard Ticker 144
Controlling Mercury Dashboard Ticker Behavior 145
Modifying Preferences 146
Message Window 148
Ticker Window 149

About Mercury Dashboard Ticker

Using Mercury Dashboard Ticker, you can, without opening Mercury
Business Availability Center, select a view, select the server where Mercury
Business Availability Center is installed, adjust the rate and the scrolling

speed of the Ticker Window, and open the Message Window.

To use Mercury Dashboard Ticker, you must install it on your desktop. For

details, see “Installing Mercury Dashboard Ticker” in Application

Administration.
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Understanding Mercury Dashboard Ticker

After you have installed Mercury Dashboard Ticker (for details, see

“Installing Mercury Dashboard Ticker” in Application Administration), one of
Mercury Dashboard Ticker’s icons appears in the desktop tray bar. The type
of icon displayed indicates different situations. A tooltip is available for each

144

icon to describe Mercury Dashboard Ticker’s status.

Status Icon

Description

Tooltip

=

Online. The ticker has connected with
the server and is monitoring status.

Connected with
<server-url>

where server-url is
the URL of the
server.

Message. An incoming message was
received. A KPI has turned to Critical
state.

Incoming message

Offline. The server could not be found
or the response returned from the
server is not recognizable.

Offline - <reason>

where reason
explains why the
ticker is offline.

Connecting. Dashboard Ticker is
attempting to connect to the server.

The indication is an animated icon.

Connecting...

Mercury Dashboard Ticker attempts to connect with the server using the
supplied server address after the period of time specified in the Update
interval parameter in the Preferences. If the server cannot be found or a
connection cannot be established, the tray icon changes to Offline. For

details about the Update interval parameter, see “Modifying Preferences” on

page 146.

The tray icon changes to Connecting if Dashboard Ticker is trying to
connect to the server.

The tray icon changes to Online when the server has connected properly.
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Every KPI in the selected view is checked. Any KPI with an error status is
checked against the information already in Mercury Dashboard Ticker. If it
is the first time this KPI appears in the view, or if the KPI's status has
changed to an error status, it is displayed in the Message Window and/or the
Ticker Window. As soon as a message is put in the queue, the tray icon
changes to Message, indicating that there is a message to be viewed.
Mercury Dashboard Ticker’s internal message queue can contain an
unlimited number of messages.

Controlling Mercury Dashboard Ticker Behavior

You can view an event in the Message Window or in the Ticker Window.
You can open the Web browser, connect to the Mercury Business Availability
Center server, and display the view in Dashboard. You can select what
information is displayed in Mercury Dashboard Ticker, and how it is
displayed.

To control some of the Dashboard Ticker behavior:

You can control the behavior of Mercury Dashboard Ticker using the
options that are displayed by right-clicking the icon in the tray bar.
Depending on the icon, a subset of the following options is displayed:

> Show Current Event. To display the event if an event is waiting in the
queue. For details, see “Message Window” on page 148.

> Show Ticker. To display the Ticker Window. For details, see “Ticker Window”
on page 149.

» Log On. Opens the default Web browser, connects to the Mercury Business
Availability Center server, and displays the view in Dashboard. For details
about the Dashboard view, see “Dashboard Console” on page 85.

> Preferences. To modify the information that is displayed in Mercury
Dashboard Ticker, and how it is displayed. For details, see “Modifying
Preferences” on page 146.

» About. To display the About window.
» Exit. To exit Mercury Dashboard Ticker.
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Modifying Preferences

146

You can view messages automatically (if you indicated so in the Preferences)
or you can click the Message icon to display the Message Window. The
Message Window fades out after 5 seconds.

If you click the icon in the Message Window, the message that it currently
displayed is removed from the queue as soon as you close the window.

If you have selected to display the Message Window automatically and you
do not click that window, the Message Window fades out after 5 seconds,
the message is considered unread. It is not removed from the queue.

Use preferences to:

» select the view whose Cls and KPIs statuses you want to display

\

Y Y Y Y Y Y

reload the views from the Mercury Business Availability Center server you
are accessing

change the server you are accessing

modify the refresh rate

change the scrolling speed of the Ticker Window

display a popup Message Window when a new message arrives
sound an alert when a new message arrives

automatically load Mercury Dashboard Ticker when you start your
computer

To modify Mercury Dashboard Ticker preferences:

Right-click the Mercury Dashboard Ticker icon in the desktop tray bar and
select Preferences.

In the View name list, select the name of the view you want to display in the
ticker.

Click Reload if you want to reload the views from the Mercury Business
Availability Center server you are accessing.
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4 In the Connection Settings area:

a In the BAC server URL box, enter the URL or the IP address of the server
you want to access. The URL format must be:
http://<Mercury_Business_Availability_Center_server>/<virtual_Web_URL>
where virtual_Web_URL may be, for example: MercuryAM.

b In the Update interval box, enter the update interval timeout (in
seconds). The default is 15 seconds. The minimum interval is 5 seconds.

5 In the Login Information area:
a In the User name box, enter your user name
b In the Password box, enter your password

6 In the Ticker Window area, select a scrolling speed: Low, Mid, or High. The
default is Mid.

7 Select Show incoming message desktop alert to automatically display the
Message Window when a new message arrives. If you do not select this
option, you have to click the message icon to display the Message Window.

8 Select Play incoming message sound alert to automatically sound an alert
when a new message arrives.

The alert sound depends on the alert.wav file that is located in
<product_installation_folder>\Dashboard Ticker\ticker\

A user with the appropriate permissions can replace the sound of the alert
and save it in the same location under the same name. For details, see
“Sound Alert for Critical Status in the Console and Filter Tabs” in Application
Administration.

9 Select Load BAC Ticker when my computer starts to automatically load
Mercury Dashboard Ticker when you start your computer.

10 Click OK to save your settings.
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Message Window

The Message Window is used to convey to the user that a KPI's status has
changed to error/poor/worst.

The window is displayed either automatically or manually. For details on
how to set this option, see “Modifying Preferences” on page 146.

When you close the message window, the entry that was displayed is
removed from the queue. You cannot re-display that information. When
you reopen the window, the next message in the queue is displayed.

If you specified in the Preferences that an alarm should be sounded when a
KPI’s status changes to error/poor/worst, an alarm sounds when the message
is displayed.

The Message Window displays the following information:

Business Availability Center

s Cl: weall_saniy
F.P: dovailability
her: 8/23/20050 31542 AM
Log-on

the status icon of the KPI.
Cl. The name of the CI.
KPI. The name of the KPI.

When. The date and time when the status change was received by Mercury
Dashboard Ticker.

» Log-on. Click Log-on to automatically open Dashboard.
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Ticker Window

The Ticker Window displays a scrolling list (from right to left) of the top
level CIs monitored by Dashboard along with icons that display the status
of each one of the CI’s KPIs.

MERCURY" B
erezh-amil 5 bpm_profile_1 . & wirtual_hast_7 |
R
Cl KPI KPI

The icons correspond to the icons displayed in the Top View tab in
Dashboard. For details, see “Accessing the Top View Tab” on page 76.

You set the scrolling speed of Mercury Dashboard Ticker in the Preferences
page. For details, see “Modifying Preferences” on page 146.

When you have moved the Ticker Window to a specific location on your
desktop, the window will be displayed in the same location the next time
you select Show Ticker in the Preferences page or when you restart your
computer.

If you move the mouse to the Ticker Window, scrolling stops; it resumes
when you move the mouse out of the Ticker Window.

You can click an icon in the Ticker Window to show a tooltip that includes
the name of the KPI.

cm_profile_1 gl

If you change any parameter in the Preferences page, scrolling restarts from
the beginning.
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Working with Dashboard Reports

The Dashboard Reports tab enables you to view the Configuration Item
Status Alerts report, KPIs Over Time report, Raw Data Over Time report,
Change report, and Report Repository.

This chapter describes: On page:
Working with Dashboard Reports 153
Filtering by CI(s) 155
Filtering by KPI(s) 156

Working with Dashboard Reports

The Dashboard reports are:

» Configuration Item Status Alert report. Lists all the alerts that occurred in
the specified period of time. Those alerts represent predefined performance
limits that were breached. For details, see Chapter 12, “Configuration Item
Status Alerts Report”.

> KPIs Over Time report. Displays the status or value, over time, of selected
ClIs and KPIs that are accessible from the Dashboard application. For details,
see Chapter 13, “KPIs Over Time Reports”.

> Raw Data Over Time report. Displays raw data, over time, for selected
configuration items, received in the data samples from Business Process
Monitor and SiteScope sources for the transaction from location Cls. For
details, see Chapter 14, “Raw Data Over Time Reports”.
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154

» Change report. Displays information about the changes to CI properties for

all CIs that were assigned to keep this information. For details, see
Chapter 15, “Change Report”. This report is listed only if you have installed
shared CMDB.

Report Repository. Displays a list of reports saved to the report repository.
For details, see Chapter 16, “Report Repository”.

You can filter the Dashboard reports by configuration item (CI), by Key
Performance Indicator (KPI), by raw data measurement, and by period of
time. For details about raw data measurements, see Chapter 14, “Raw Data
Over Time Reports”) and by period of time. For details about the period of
time, see “Choosing the Tracking Range and Granularity” in Working with
Applications.

You can print the generated report, send the report by e-mail, open the
report in different formats, publish the report in different formats, or save
the report to the report repository. For details, see “About Working in
Reports” in Working with Applications.

This section includes the following topics:

> “Filtering by CI(s)” on page 155
» “Filtering by KPI(s)” on page 156

Note:

» Mercury Business Availability Center records in a reports log errors that
occur when generating reports. The reports log can also include the
following activities: creating a new report, generating a report, modifying
the report filter(s), drilling down in reports, and so forth. For details
about the reports log, see “Reports Log” in Platform Administration.

» Mercury Business Availability Center enables you to generate Dashboard
reports automatically, and to specify a header and a footer for those
reports. For details, see “Customizing Reports” in Platform Administration.




Chapter 11 « Working with Dashboard Reports

Filtering by CI(s)

Active filters enable you to filter specific components from reports for the
duration of a Web session. You can select specific Cls to filter Dashboard
reports.

To filter by CI(s):

1 Click Configuration Items to open the Configuration Items Filter dialog box.

Browse|Search
Wiew: I.ﬂ.lona J

B0 T Alana
O D boston
|:| one
O @ zdzad
O |:| three
O |:| two
O D wewqge

(1134 | Cancel | Help |

2 In the View list, select the appropriate view. For additional information, see
“Filtering Data Using Active Filters” in Working with Applications.

3 Select the relevant CI(s).
4 Click OK to save the selection.
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Filtering by KPI(s)

Active filters enable you to filter specific components from reports for the
duration of a Web session. You can select specific KPIs to filter Dashboard
reports.

To filter by KPI(s):
1 Click KPIs to open the KPIs Filter dialog box.

¥ oT impact
¥ Performance
¥l availability

el | 58

OK | Cancel | Help |

2 Select the appropriate KPI(s). For additional information, see “Filtering Data
Using Active Filters” in Working with Applications.

3 Click OK to save the selection.
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Configuration Item Status Alerts Report

The Configuration Item Status Alerts option in the Dashboard Reports tab
enables you to list all the alerts that occurred in the specified period of time

and to display detailed alert information.

This chapter describes: On page:
About Configuration Item Status Alerts Report 157
Viewing the Configuration Item Status Report 158
Viewing the Configuration Item Status Alert Notifications Report 160

About Configuration Item Status Alerts Report

Note: It is recommended to use the new CMDB-based alerting mechanism
under Admin > Dashboard > Cl Status Alerts which provides greater
granularity and flexibility for configuring alerts. The existing alerting
mechanism under Admin > Platforms > Alerts and Recipients will be
gradually phased out in future releases of Mercury Business Availability

Center.
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Mercury Business Availability Center alerts proactively inform you when
predefined performance limits are breached, by sending alerts to pre-defined
users. The Configuration Item Status Alerts report is a log of alerts that were
sent during a specified time period.

Users with the appropriate permissions must attach alerts to a configuration
item (CI) in a view. For details, see “Configuring CI Status Alerts” in
Application Administration. The alert is then attached to the CI in any view
where the CI is included.

You can schedule this report. For details, see “Scheduling User Reports or the
Performance Update Report” in Platform Administration.

This chapter includes the following topics:

> “Viewing the Configuration Item Status Report” on page 158

> “Viewing the Configuration Item Status Alert Notifications Report” on
page 160
Viewing the Configuration Item Status Report

The Configuration Item Status Alerts report lists all the alerts that occurred
in the specified period of time:

Uiew:IDast week -I From: 2/10/05 2:52 PM Te: 2/17/05 2:52 BM Israel Standard Time 4| b = 1E ()
Caonfiguration Iterns: Filtered

KRIs: All Generate
Status = Time Alert Name Configuration Item KPI Alert Action Details |+
Uy Critical 8/17/05 2125 PM aler_worsen g}bme Performance Access asd

O critical 2/17/05 1:11 PM alart_worsen Zhbpmz Parformance Access asd

Q. Critical 8/17/05 11:11 AM alert_worsen Shbpmz Performance Access asd &=
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The Configuration Item Status Alerts report displays the following
information:

Field Description

Status The current status of the KPI(s). The change from
previous status to current status triggers the alerts.

Time The time and date when the alert was triggered. The
format is: dd/mm/yy hh:mm GMT[<offset>].

Alert Name The name of the alert.

Configuration Item The name of the CI the alert is attached to.

KPI The name of the KPIL

Alert Action The action that is triggered by the alert.

To view the Configuration Item Status Alerts report:

1 Select Applications > Dashboard.

Select the appropriate view, CI, or KPIL.

3 You can then do one of the following to display the Configuration Item

Status Alerts report:

» click the Console tab, click the appropriate context menu, and select
Configuration Item Status Alerts

» right-click the Reports tab and select the Configuration Item Status Alerts
option

You can then:

» select the period of time for which you want to display the alerts. For
details, see “Choosing the Tracking Range and Granularity” in Working
with Applications

» filter by configuration item. For details, see “Filtering by CI(s)” on
page 155

» filter by KPI. For details, see “Filtering by KPI(s)” on page 156
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Viewing the Configuration Item Status Alert Notifications

» click the Details button for the relevant alert to see the alert notification
details. For details, see “Viewing the Configuration Item Status Alert

Notifications Report” on page 160

» print the report, send it by E-mail, open it in Excel or PDF format. For
details, see “Sharing and Storing Reports” in Working with Applications

Report

To display detailed alert information, access the Configuration Item Status
Alerts page, and click the Details button for the relevant alert to open the
Configuration Item Status Alert Notifications report.
For example:

Alert Details

Time: 12/20/035 £:05 AM

Status: W arning

Alert Name: Alert 2

KPI:

Alert Action

Configuration Item: fist_bpr_profile_1

A ailability

Send E-mail to: fist_email_recipient_1; Send SM$S to: fist_sms=_recipient_1,
fizt_sms_recipient_1; Send Pager to: fist_pager_recipient_1; Send SHNMPul
trap to dardanelles on port 162; Send SMMPyL trap to <GLOBAL SMMP ADDRESS>

on port 162
Action Notifications
Type = Command Status
SHMPul Send trap to dardanelles Pass
SHMPwl Send trap to Pass
Message Motifications
Type = Recipients Status
E-rrail fist_ernail_recipient_1 Pass
Pager fist_pager_recipient_1 Pass
SMS fist_srns_recipient_1 Pass
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In the Configuration Item Status Alert Notifications report:

> the Alert Details area displays the following information:

Field Description

Time The time when the alert was triggered.
Status The previous status of the KPI.

Alert Name The name of the alert.

Configuration Item

The name of the CI to which the alert is attached.

KPI The name of the KPI whose change of status
triggered the alert.
Alert Action The action that has been assigned to the alert.

> the Action Notifications area displays the following information:

Field

Description

Type

The type of action notification: Executable, URL, or
SNMP trap.

Command

The action that was executed:
» for executables — the command line

» for URLs — the URLSs
» for SNMP traps — Send SNMP trap to <address>

Status

The status of the action:
» Pass. When the action has been performed.

» Fail. When the action failed.

161



Part 11l « Dashboard Reports

162

> the Message Notifications area displays the following information:

Field

Description

Type

The type of message notification: E-mail, SMS
message, or Pager message.

Recipients

The names of the recipients who receive the
notification that the alert has been triggered and
that the alert scheme has been executed.

Status

The status of the message:
» Pass. When the message has been sent.

» Fail. When the message was not sent.

> the Notification Messages area displays the type of message followed by the
text of the message.

E-Mail Message:

Pager Message:

SME Message:

Motification Messages

=b=fist_bpm_profile_1</b> status has changed to <b>Warning</b>. <br><table
border=1=<tr=<td=<b>Trigger Time: </b>=</td><td>GMT[-08:00] 12/20/05 &:05
AN td =< ftr-<tr=<td><b=KPI Name:</b></td= <td > Availability</td></tr=<tr><td
><h>KPI Value:£/be</ftd> ctd= N/ A</ td > < tre <tr> <bd > <h>Previous Status:</b>=<
Std=<td=Minor<ftd=</tr=<tr=<td=<bxAlar Marme: </b></td> <td=Alert 2</td=</. .,

fist_bprn_profile_1 status has changed to Warning,
Trigger Time: GMT[+02:00]

12/20/05 4:05 PM

KPI Marme: Auvailability

EPI Yalue: MiA

Previous Status:

Minor

Alert Mame: Alert 2

Alert Description: Alert 2

fist_bprn_profila_1 status has changed to Warning.
Trigger Tirme: GMT[+02:00]

12/204/05 4:05 PM

KPI Marme: Auvailability

KPI valua: MiA

Previous Status:

Minar

Alert Marme: Alert 2

Alart Description: Alert 2
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The E-mail message text format depends on the e-mail format selected by
the sender. The following format corresponds to a Long HTML format:

<b><ci-name> status</b> has changed to <b><current-status></b>.<br>
<table border=1>

<tr><td><b>Trigger Time:</b></td><td><trigger-time></td></tr>
<tr><td><b>KP| Name:</b></td><td><KPIl-name></td></tr>
<tr><td><b>KPI value: </b></td><td><KPI-value></td></tr>
<tr><td><b>Previous status:</b></td><td><previous-status></td></tr>
<tr><td><b>Alert name:</b></td><td><alert-name></td></tr>
<tr><td><b>Alert Description: </b></td><td><alert-description></td></tr>
<tr><td><b>URL: </b></td><td><URL></td></tr>

</table>

HTML is encoded in the report. The text of the e-mail received by the
recipient is decoded and is similar to the Pager message text. For more
information on the different formats available to send e-mails, or pager
messages, see “E-Mail, SMS, and Pager Message Templates” in Application
Administration.

The text of the Pager and SNMP messages has the following format:

<ci-name> status has changed to <current-status>.
Trigger Time: <trigger-time>

KPI Name: <KPIl-name>

KPI value: <KPI-value>

Previous status: <previous-status>

Alert name: <alert-name>

Alert Description: <alert-description>

URL: <URL>

where:

» ci-name. The name of the CI whose change of status triggered the alert.

» current-status. The new status of the CI.

» trigger-time. The time and date when the alert was triggered. The format is:

dd/mm/yy hh:mm GMT[<offset>]

» KPl-name. The name of the KPI.
» KPIl-value. The value of the KPI.
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previous-status. The previous status of the CI.
alert-name. The name of the alert.
alert-description. The description of the alert.

URL. The URL of the Mercury Business Availability Center Centers Server.

To view the Configuration Item Status Alert Notifications Report:

Access the appropriate Configuration Item Status Alerts report. For details,
see “Viewing the Configuration Item Status Report” on page 158.

Click the Details button for the relevant alert to open the Configuration
Item Status Alert Notifications report.

You can then print the report, send it by E-mail, and open it in Excel or PDF
format. For details, see “Sharing and Storing Reports” in Working with
Applications.
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KPIs Over Time Reports

The KPIs Over Time Report option in the Dashboard Reports tab enables you
to view the status or value, over time, of selected CIs and KPIs that are
accessible from the Dashboard application.

This chapter describes: On page:
About the KPIs Over Time Report 166
Customizing the Report 166
Accessing KPIs Over Time Reports 167
Understanding KPIs Over Time Reports 168
KPIs Over Time Reports with Status Data 170
KPIs Over Time Reports with Value Data 177
Drilling Down to Mercury Diagnostics 180
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About the KPIs Over Time Report

Y VY VY Y

KPIs Over Time reports show the status or value, over time, of selected ClIs
and KPIs that are accessible from the Dashboard application. The report is
also accessible from the View Explorer.

The report includes filtering (by CI, KPI, and time). It can be displayed as a
table or a chart.

You can also add a KPIs Over Time report to a custom report. For details, see
“Custom Report Manager” in Working with Applications).

You can also schedule when to run the report. For details, see “Scheduling
User Reports or the Performance Update Report” in Platform Administration.

For example, when you encounter a problem with a specific CI while
viewing the Dashboard, and the Performance and Availability KPIs are
attached to that CI, you can view the KPIs Over Time report of that CI's
Performance and Availability. You can also receive a daily report showing all
Cls statuses in the past day.

This chapter includes the following topics:

“Accessing KPIs Over Time Reports” on page 167
“Understanding KPIs Over Time Reports” on page 168
“KPIs Over Time Reports with Status Data” on page 170
“KPIs Over Time Reports with Value Data” on page 177

Customizing the Report

166

>

>

After you have created the report, you can:

change the time frame of the existing report by using the filters. For details,
see “Choosing the Tracking Range and Granularity” in Working with
Applications.

change the Cls you want to display. For details, see “Filtering by CI(s)” on
page 155, and for more information see “Filtering Data Using Active Filters”
in Working with Applications.
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» change the KPIs you want to display. For details, see “Filtering by KPI(s)” on
page 156.

» print the report, send it by e-mail, or save it in PDF or Excel format. For
details, see “Sharing and Storing Reports” in Working with Applications.

» customize the report by adding a header and a footer, by selecting to
automatically or manually generate the report, and/or by customizing other
display elements. For details, see “Customizing Reports” in Platform
Administration.

Accessing KPIs Over Time Reports

You can access the KPIs Over Time reports from different locations in
Mercury Business Availability Center.

To access KPIs Over Time reports:
1 Select Applications > Dashboard.
2 To open the KPIs Over Time page, you can:

» right-click a specific CI in the View Explorer and select the Go to Report
> KPIs Over Time Reports option

» right-click a specific CI in the right pane of Dashboard and select Go to
Report > KPIs Over Time Report

» select the KPIs Over Time Report option in the Reports tab

Note: The context menu includes the KPIs Over Time Report option for all
ClIs except for monitors. The report displays data only for CIs whose KPIs are
persistent. For details, see “Persistent Data for KPIs” on page 170.

3 If relevant, click Configuration Items to select the relevant ClIs for the report.
For details, see “Filtering by CI(s)”.

4 If relevant, click KPIs to select the relevant KPIs for the report. For details,
see “Filtering by KPI(s)”. If you do not select specific KPIs then the data of all
the KPIs for the selected Cls is displayed in the report.
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For details about the KPIs Over Time report, see “Understanding KPIs Over
Time Reports” on page 168.

Understanding KPIs Over Time Reports

168

You can select to display data only about status-based KPIs or about value-
based KPIs. To reflect these capabilities, two types of KPIs Over Time reports
are available:

reports that display status information. For details, see “KPIs Over Time
Reports with Status Data” on page 170. To display such information, the
KPIs must be persistent. For more details, see “Persistent Data for KPIs” on
page 170.

reports that display value information. For details, see “KPIs Over Time
Reports with Value Data” on page 177.

KPIs Over Time reports display the status or value of each CI and each
instance of the attached KPIs. For example, when you select two CIs and the
Availability and Performance KPIs, the performance KPI is not attached to
the first CI, and the report has only three rows:

Cl KPI

First Availability

Second Availability
Performance

The statuses are shown over time, starting with the event and ending with
the next event.

This section includes the following topics:

> “Collecting Data” on page 169
» “Persistent Data for KPIs” on page 170
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Collecting Data

To display the status or value of each CI and KPI instance in the KPIs Over
Time report, you must set specific attributes so Mercury Business Availability
Center collects the appropriate information.

These settings store the following information in the database for each CI
with the Save historical data for this Cl option selected:

» every status change for each KPI

» the current calculated value for each KPI, read at regular time intervals (the

default time interval is 15 minutes)

When the settings described above are first selected, the current status for all
the CI KPIs is written to the database. As long as the settings remain the
same each time there is a change in status for one of the CI’s KPIs (for
example, from Critical to OK), the status change is written to the database.

Note: Saving historical data for long periods of time or for many Cls and
KPIs can require a lot of database memory, so this option should be used
with care. When you no longer require data to be saved for a CI, deselect the
Save historical data for this Cl check box for that CI.

To save status data:

1 Select Admin > Dashboard > KPlIs.

2 Select the appropriate CI in View Explorer.

3 Select the Save historical data for this Cl option.

To save value data:

Make sure the Save historical data for this Cl option has been selected for
the CI (it is selected by default). For details, see the procedure above.

Set the saveValuesToPersistency global attribute to true in all the rules. For
details, see “Configuring the Rules Global Parameters” in Repositories
Administration.
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Persistent Data for KPIs

A KPI whose data is persistent is attached to a CI whose Save KPI data over
time for this Cl option has been selected. For details, see “Saving KPI Data
over Time for a CI” on page 32. This option is selected by default for
Business Process, Line of Business, and Monitor Application ClIs. This option
is not available for Monitor type Cls.

KPIs Over Time Reports with Status Data

170

If you select the Statuses option when you generate a KPIs Over Time report,
the report displays only the status of the relevant KPIs. Those KPIs may also
have values in the Mercury Universal CMDB but the status report will not
show those values.

The reports can be displayed in graph or table format.

This section includes the following topics:

> “View as Graph” on page 170
» “View as Table” on page 176

View as Graph
The graph shows all the selected ClIs and KPIs.

Configuration Ttem = KP1 Status
1]
. app_world_2 Performance I
@trxl EUM Performance :
i
@trx_Genera\ Performance i
T T - -
/52003 /7 2003 /2005 /11720035
2:04 PM 2:04 PM 2:04 AM 2:04 AM

||:| ok [ warning [ Minor [ Major [0 critical [0 Downtime  [] Mo Data |

When you select Cls and do not select specific KPIs, all the KPIs that have
been attached to the selected CIs and have historical data in the database are
displayed.
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The graph displays the following information:

Item Description
Configuration Item The name of the selected configuration item.
KPI The name of the KPI. The information for each KPI

of each Cl is displayed in a separate line.

Status The status of each KPI of each CI during the selected
time period.

You can drill down:

to a specific segment of the time period. For details, see “Drilling Down by
Time Segments in Status KPIs Over Time Reports” on page 172.

to display status information about the children that contribute to the
status of the selected CI's KPI. For details, see “Drilling Down to Influencing
Children” on page 173.

to display status information about the parents of the CI whose status is
influenced by the status of the selected CI's KPI. For details, see “Drilling Up
to Influenced Parents” on page 174.

Tooltips are shown for each status. The background of the tooltip reflects
the color of the status according to the KPI's objectives.

Details - Performance

Configuration Item: app_world_1 edit

Status: CK

Start Time: 2f7/05 7:58 AM
End Time: 2/ 705 8:14 PM
Duration: 12:16:19

The tooltip displays the following information:

Item Description

Details The name of the KPL

Configuration Item The name of the CI whose KPI status is displayed.
Status The status of the KPI.
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Item Description

Start Time The time when an event occurred, starting the
sampling period for that event.

End Time The time when a new event occurred, ending the
sampling period of the previous event.

Duration The duration of the sampling period.

This section includes the following topics:

» “Drilling Down by Time Segments in Status KPIs Over Time Reports” on
page 172

» “Drilling Down to Influencing Children” on page 173

» “Drilling Up to Influenced Parents” on page 174

Drilling Down by Time Segments in Status KPIs Over Time Reports

Click any time segment in the graph time footer to drill down (zoom) on all
the CI and KPI information for that period of time. The time segment you
zoom on is split into four equal parts that can also be zoomed until each
time segment is one minute long.

The From date and time of the segment you select becomes the From date
and time of the whole time footer and the To date and time of the segment
you select become the To date and time of the whole time footer.

For example, if the time period you selected is from 7/13/05 6:14 AM till
7/13/05 4.:44 PM, the time footer is split into four equal segments as follows:

Configuration Item = KPI Status

(Tepm_profs Perfarmance N I . ENEE N ] [

(TDbpm_profs availatilty &

(Dbpm_profs oT tmpact e

(Teverareen Perfarmance s

(Tevercreen availatilty S

@GrayRay Performance

(Dorayray availabilty 8§ 0|
7/13/05 §:51 AMI 7/13/05 11:29 AMI 7/13/05 Z:06 PMI 7/13/05 4:44 PI\"\I

|I [s]'4 O warning O Minar O Major B Critical O Mo Data |

172



Chapter 13 ¢ KPIs Over Time Reports

If you drill down on the first segment of the time footer, the From date and
time of that segment is 7/13/05 6:14 AM, and its To date and time is what is
indicated under the second tick of the time footer: 7/13/05 8:51 AM.

The drilled down report time From and To fields display those dates and
times, and the time footer of the report displays this period of time split into
four equal parts: (8:51-6:14)/4=39 mn. The first part starts at 6:14 AM, and
ends 6:14+:39=6:53, the second part starts at 6:53 and ends at 6:53+:39=7:32,
and so forth:

Wiew: From: 7/12/05 &114 AM Tor 7/12/05 8:51 AM Israel Standard Time 4 L3 @
Configuration Itermns: Filtered {3)

KPIs: All

Report type: @ statuses O values |
Configuration Item = KPI

(T bprm_profi Performance _
[Tbprm_profi Availability

(T bprm_profi OT Impact

@EverGreen Performance

[TEversreen Availability

@GrayRay Performance

(TGrayray Availability

7/13/05 6:53 AM 7/13/05 7:32 AM 7713405 6111 AM 71305 8:51 AM
|l QK O Warning O Minor O Major W Critical O Mo Data |
Drilling Down to Influencing Children
P Click the Drill to influencing children button for a specific CI’s KPI to display

status information about the children that contribute to the status of the
CI’s KPI.

For example, the view has the following hiearchy.

= ln:c': Monitors Wiew
| ‘:::' app_waotld_1 edit
= {::' app_world_2
(7 tex1_gum
@ trz_General
ol @ trw_sarm
¥ @ trx_weekly_plan
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[
ALK,

If you drill down the app_world_2 CI and the Performance KPI, the
information that is displayed is the status of all the Performance KPIs for all
the children of the app_world_2 CI that have a Performance KPI and of the
parent itself.

If you click the Drill to influencing children button for the app_world_2 CI
and the Performance KPI in the following graph:

Configuration Ttem = KP1 Status

Y7 app_world_2
@ trxl_EUM
D trs_general

Performance
Perfarmance

| !
|
Perfarmance 1

T T T T
2/5/2003 /772005 /972005 2/11/2005
2:04 PM 2:04 PM 2:04 AM 2:04 AM

||:| ok [ warning [ Minor [ Major [0 critical [0 Downtime  [] Mo Data |

then the drilled down report displays the status of all the Performance KPIs
for all the children of the app_world_2 CI that have a Performance KPI as
follows:

Configuration Item = KPI Status
@trxl EUM Performance :
| |
@tr’x_General Performance i
@trx sarm Performance :
[ |
@trxiwaeklyfplan Performance i
T ¥ . -
252005 /32005 &/9/2005 2/11/2005
2:04 PM 2:04 PM S04 AM 2:04 AM

L&
o

||:| ok [ warning  [] Miner  [] Majer [0 critical [ Downtime  [] Mo Dats |

If the selected CI and KPI do not have influencing children, then the report
displays the message: No influencing children found.

Drilling Up to Influenced Parents

Click the Drill to influenced parents button for a specific CI’s KPI to display
status information about the parents of the CI whose status is influenced by
the status of the selected CI's KPI. A CI may have more than one parent but
the parent Cls that are displayed in the report are the parent Cls that are
part of the view.
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For example, if you drill up to influenced parents for the trx_weekly_plan CI
and the Availability KPI, the information that is displayed is the status of all
the Availability KPIs for all the parent(s) of the trx_weekly_plan CI and of the
influencing child.

=] app_world_2
[ (3 tewa_gum
¥ @ trx_General
¥ @ tre_zam
@ trw_weekly_plan
= bprn_tx_from_location

0 ®H &

= bprn_tx_from_location

= trx_weekly_plan from rmetal_kalvin_1
= trx_weekly_plan fram metal_kalvin_2
= trx_weekly_plan from virtual_host 1
= trx_weekly_plan fram virtual_host_ 10

= trx_weekly_plan from virtual_host_2

The report about the status of trx_weekly_plan CI displays information about
the Availability and Performance KPIs as follows:

Configuration Item = KPI Status
[ g e Performance 1
53 te_mvafblly,_ellim Avail ability 1
! BISIZUUSI S.I'?fZUUSI 8.!"9.!’2005' 8.!"11.!"2005'
2:12 PM 2:12 PM 2:12 AM 2112 AM

||:| oK D W arning D Minor D Major D Critical D Downtirne D Mo Data |

If you drill down to influenced parents for the Availability KPI, the report
displays the status of the Availability KPI for the app_world_2 CI (parent of
trx_weekly_plan CI) as follows:

Configuration Item = KPI Status

o el o
. app_warld_2 Awailability I

T T T T
2/5/2005 &/7/2003 2/9/2005 2/11/2005
8:12 PM 2:12 PM 2:12 AM 2:12 AM

||:| ok [ warning [ Minor [ Major [0 critical [0 Downtime  [[] Mo Data |

If the selected CI and KPI do not have influenced parents, then the report
displays the message: No influenced parents found.
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View as Table

The table shows all the selected CIs and KPIs. When you select CIs and do
not select specific KPIs, all the KPIs that have been attached to the selected
Cls are displayed.

Configuration Item = KPI Start Time End Time Duration Status

(T bpr_profi Perfarmance 713405 6:12 AM 713408 7113 AM 00:59:38 D oK

(T bprm_profi Performance 7/13/05 7:13 AM 7413405 7128 AM 00:15:15 1 Minar
(T bpr_profi Perfarmance /13405 7:28 AM 713408 7143 AM 00:14:30 + Major
(T bprm_profi Performance 7/13/05 7143 AM 7413405 8:12 AM 00:29:01 1 Minar
(T bpr_profi Perfarmance /13405 8:12 AM 7413405 8:51 AM 00:38:36 D oK
@bpmfprofl Availability T/12/05 4147 PM 7/13/05 6:51 AM 0z:37:00 oK

T bprr_profi OT Irmpact 71205 4144 PM 7/13/05 8:51 AM 0z:37:00 Dok
(TEevercreen Performance 7/12/05 4:47 PM 7413405 8:51 AM 02:37:00 oK
[TEeverGreen Availability 7/12/05 4:47 PM 7413405 8:51 AM 02:37:00 D oK
@GrayRay Ferformance T/12/05 4144 PM 7/13/05 6:51 AM 0z:37:00 - Uninitialized
(T Grayray Availability 7/12/05 4:47 PM 7413405 8:51 AM 02:37:00 “x Critical

The table displays the following information:

Item Description
Configuration Item The class icon and the name of the CI.
KPI The name of the KPI. The information for each KPI

of each Cl is displayed in a separate line.

Start Time The time when an event occurred, starting the
sampling period for that event.

End Time The time when a new event occurred, ending the
sampling period of the previous event.

Duration The duration of the sampling period.

Status The status of each KPI of each CI during the selected
time period.

The table shows the list of all the events sorted by CI by default. You can sort
the table by different elements by clicking the relevant column header.
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Note: The number of lines that can be displayed in the table is not limited.
This might slow performance when displaying the table; in such cases it is
recommended to limit the time period or the number of ClIs and KPIs you
want to display.

KPIs Over Time Reports with Value Data

If you select the View Value over Time option when you generate a KPIs over
Time report, the report displays only the values of the relevant KPIs. Those
KPIs may also have statuses in CMDB but the value report will not show
those statuses.

Reports of this type are relevant for KPIs with business rules that calculate
meaningful values, such as rules for calculating percentage, volume,
financial impact, or Real User Monitor values.

You can select the number of sampling points in the Every boxes.
The report can be displayed as a graph or as a table.
This section includes the following topics:

> “View as Graph” on page 178
> “View as Graph” on page 178
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View as Graph

Each KPI instance is represented by a separate graph. The legend lists the
color followed by the name of the CI and a specific KPI. If a CI data is shown
in more than one graph, the CI has the same color in all the graphs.

100 100
Wl EwverGreen Availability (3]
| Sreenvellow_Stripes Availability (96)
E2 B EverGreen Performance (95
a5 W Green'ellow_Stripes Performance (9%
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a0 i)
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(%) @3uenuopIag
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a0
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Maote: The repart will show data anly on Configuration Iterns that have histarical data for the selected value-based KPIs,

If only two KPIs are selected for one CI, the first KPI appears as the left y-axis
and the second KPI as the right y-axis. This is helpful for correlating an
event.
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If only one KPI is presented in each chart, the KPI objectives are shown as
horizontal colored lines (the colors correspond to the objective colors) as
follows:

EverGreen Performance (%)
ol GreenvVellow_Stripes Performance [36)

Ok

Warning

Minaor

Major

8305 11:53 PM

405 1:00 A
24505 1:00 AM
8/505 1:00 AM
BITMS5 1:00 AM
8/8M05 1:00 AM
2/9/05 1:00 AM
SM005 1:00 AM

Note: All values in the graph are averaged by time frame.

Tooltips are available for each point in the graph and display the exact data
for the point.

Value: 83,333

You can drill down each point in the graph to display the data in the period
of time that corresponds to your selection. For example, if you have selected
to display information every day for the past week, then drilling down on
one point displays the detailed information for every hour of the selected
day, and then drilling down on one hour displays the detailed information
for 5 minutes intervals in the hour, and so forth down to a minute interval.
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View as Table

The table shows the list of all filtered ClIs and KPIs. Only existing KPIs
should appear.

Configuration _ o 7/11/05 2:55 7/12/05 1:00 7/13/05 1:00 7/14/05 1:00 7/15/05 1:00 7/16/05 1:00
Ttem pM AM AM AM AM AM
bprn_profl OT Impact ($) - 0.00 0.00 0.00 0.00 0.00
bpm_profi Availability (%) 100,00 83,33 83,33 83,33 83,33 83,33

Perf
bpm_profl STTOMMANEE g ng 58,74 59,04 55,36 59,69 58,94

(%)

The table displays the selected ClIs and KPIs values in the selected time
period.

You can sort the CIs and KPIs by clicking the relevant column header.

Drilling Down to Mercury Diagnostics

If Mercury Diagnostics is enabled, you can drill down to Mercury
Diagnostics views from the KPIs Over Time report for Business Process Step
Cls in the Monitors View and End User Monitors View, and for the
Diagnostics Probe Group, and Diagnostics Probe Cls in the Diagnostics
View.

By default, if Mercury Diagnostics is enabled, the Application KPI is
automatically added to all relevant Cls in the CMDB. The relevant Cls are
the logical CIs. For details, see Mercury Diagnostics User’s Guide.

The following table displays the Diagnostics drill down options for Cls in
KPIs Over Time reports:

Cl Type Diagnostics drilldown options

Diagnostics Probe Group e Summary View (Probe Group Summary)

e Layers View (Load)

Diagnostics Probe e Summary View (Probe Summary)

Layers View (Load)

Business Process Step e Transactions View

e Layers View
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For example, in the Monitors View, click the down arrow to the right of a
Business Process Step CI and select one of the following options:

Configuration Item KPI Status
[=:Add to cart Performance
[JAdd to cart Availability
[=:Add to cart plication
Transactions Wiew ' 6."'3."'2006I 6.-"3.-"2006I

1z:56 PM G156 PM

Layers Wiew

||:| (a4 D Warning D Minor D Major . Critical . Cowntirne D Mo Data |

The Mercury Diagnostics views accessed via the right-click options that are
available from the KPIs Over Time report are as follows:

Summary View. This option is available for all Diagnostics Probe Cls. This
option is displayed only if you have installed Diagnostics.

This option opens the Probe Summary View in the Mercury Diagnostics
application, for the probe group and for the time frame specified in the View
box in the KPIs Over Time report.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Layers View. This option is available for all Business Process Monitor, and
Diagnostics Probe Cls. This option is displayed only if you have installed
Diagnostics.

The Layers (Load) view displays the performance metrics for the Diagnostics
layers where processing has taken place in your application, for the
transaction that corresponds to the Business Process Monitor CI or for the
selected Probe CI and for the time frame specified in the View box in the
KPIs Over Time report.

For more information about Diagnostics, refer to Mercury Diagnostics User’s
Guide.

Transactions View. This option is available for all Business Process Step CI.
This option is displayed only if you have installed Diagnostics.
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The Transactions view displays performance metrics for the transactions
that are being executed by your applications, with the transaction
corresponding to the Business Process Step CI highlighted, and for the time
frame specified in the View box in the KPIs Over Time report. For more
information about Diagnostics, refer to Mercury Diagnostics User’s Guide.

The right-click options that are available from the KPIs Over Time report are
a subset of the Drill to Diagnostics options available in Dashboard. For
details, see “Drill to Diagnostics” on page 13.
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Raw Data Over Time Reports

The Raw Data Over Time Report option in the Dashboard Reports tab
enables you to view raw data over time for selected configuration items,
received in the data samples from Business Process Monitor sources for the
transaction from location ClIs (for Business Process Monitor) or from
SiteScope Monitor, SiteScope Measurement Group, and SiteScope
Measurement Cls (for SiteScope).

This chapter describes: On page:
About Raw Data Over Time Report 183
Accessing the Raw Data Over Time Report 185
Understanding the Raw Data Over Time Report 187

About Raw Data Over Time Report

The Raw Data Over Time report displays raw data over time for selected
configuration items, received in the data samples from Business Process
Monitor sources for the transaction from location ClIs (for Business Process
Monitor) or from SiteScope Monitor, SiteScope Measurement Group, and
SiteScope Measurement ClIs (for SiteScope).

The report displays raw data over time in graph or table format.
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You can also:

add this report to a custom report. For details, see “Custom Report Manager”
in Working with Applications.

schedule it. For details, see “Scheduling User Reports or the Performance
Update Report” on page 302 in Platform Administration.

Once you have created the report you can:

change the time frame of the existing report by using the filters. For details,
see “Choosing the Tracking Range and Granularity” in Working with
Applications. The time frame is limited to Past week for performance reasons.
If you wish to use another time frame, you may select Custom; be aware that
selecting this time frame might reduce the report performance.

change the CIs you want to display. For details, see “Filtering by CI(s)” on
page 155.

change the raw data measurements you want to display. For details, see
“Filtering by Raw Data Measurements” on page 196.

use the Advanced Options to change the way the data is presented in the
report. For details, see “Selecting Advanced Options” on page 198.

» sort the table by its columns by clicking on the relevant column header.

» print the report, send it by e-mail, or save it in PDF or Excel format. For

details, see “Sharing and Storing Reports” in Working with Applications.

customize the report by adding a header and a footer, by selecting to
automatically or manually generate the report, and/or by customizing other
display elements. For details, see “Customizing Reports” in Application
Administration.

This chapter includes the following topics:

> “Accessing the Raw Data Over Time Report” on page 185
» “Understanding the Raw Data Over Time Report” on page 187
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Accessing the Raw Data Over Time Report
You can access the Raw Data Over Time report.

To access the Raw Data Over Time report:
1 Select Applications > Dashboard.
2 In the View list, select an appropriate view.
3 To display the Raw Data Over Time page, you can:

» right-click the appropriate BPM transaction from location in View
Explorer and select the Raw Data Over Time option

» right-click a specific CI in the right pane of Dashboard and select
Go to Report> Raw Data Over Time

» select the Raw Data Over Time option in the Reports tab

4 Select the appropriate time frame. For details, see “Choosing the Tracking
Range and Granularity” in Working with Applications.

Due to the large number of measurements that can occur in a specific time
period, which might create performance issues, the maximum length of
time you can select is Past Day, and the maximum custom value you can
specify is: 48 hours.

5 Select the appropriate filters. For details, see “Filtering by Raw Data
Measurements” on page 196.

6 If relevant, click Configuration Items to select the relevant CIs for the report.
For details, see “Filtering by CI(s)” on page 155.

7 If relevant, click Raw Data Measurements to select the relevant
measurements for the report. For details, see “Filtering by Raw Data
Measurements” on page 196.

185



Part 11l « Dashboard Reports

Note:

» Due to performance issues, the maximum raw data value is limited to the
last 1000 for one measurement, and to the last
2000/<nbr-of-measurements> per measurement if you select more than
one measurement. This limitation exists for the table format and for the
graph format of the report.

» If you do not select specific raw data measurements then the default
measurements assigned to the CI (if any) are automatically selected. If
the CI does not have default raw data measurements, then the first
measurement is automatically selected.

» The breakdown raw data measurements are listed only if Enable
breakdowns was selected for the transaction from location in Monitor
Administration. For details, see in “Enable/Disable Transaction
Breakdown for the Transaction Monitor” in End User Management Data
Collector Configuration.

8 If relevant, select Advanced options to modify the report’s appearance.

9 Click Generate to generate the report.
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Understanding the Raw Data Over Time Report

¥alue

The Raw Data Over Time report displays Business Process Monitor raw data

in:

» graph format - the graph legend lists the selected raw data measurements.
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The type of information displayed in the report depends on the type of CI
you select. For more details about Business Process Monitor ClIs, see below.
For more details about SiteScope Cls, see “Raw Data Over Time Reports for a
SiteScope Monitor Source” on page 194.

This section includes the following topics:

“Raw Data Over Time Reports for a Business Process Monitor Source” on
page 188

“Best Practices for Raw Data Over Time Reports for a Business Process
Monitor Source” on page 192

“Raw Data Over Time Reports for a SiteScope Monitor Source” on page 194
“Filtering by Raw Data Measurements” on page 196

“Selecting Advanced Options” on page 198

“Tooltips” on page 198

Raw Data Over Time Reports for a Business Process Monitor
Source

The Raw Data Over Time report displays raw data over time for selected
configuration items, received in the data samples from Business Process
Monitor sources for the transaction from location Cls.

You can work in two different modes by selecting the
Transactions/Locations or the Regular hierarchy for the Business Process
Monitor source. For details, see “Business Process Monitoring” in Source
Manager Administration.

If you select the Transactions/Locations hierarchy, you can select the
transaction from location in the filter. You can then triage the problem by
checking the transaction breakdowns and comparing the results of this
transaction from different locations.

If you select the Regular hierarchy, you can select only the transaction in
the report filter. The report helps you understand at what time the
transaction response time was critical and why it was critical. In the report
table and graph, the data from all the locations is displayed, sorted by time,
in the same graph or table, without location information.
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Usually, if the Response Time and Availability raw data measurements are
available for the CI, they are automatically selected. The other raw data
measurements that are listed are breakdown raw data measurements for the
Business Process Monitor transaction from location.

The table displays the following information:

Item

Description

Time

The sampling time.

Transaction Response
Time (ms)

(Business Process Monitor raw data measurement)
The transaction response time in milliseconds. This
raw data measurement is selected by default. All
measurements where the transaction was not
available are removed from the report.

Transaction Availability

(Business Process Monitor raw data measurement)
The availability of the transaction. For details, see
“About Raw Data Over Time Report” on page 183.
This raw data measurement is selected by default.
Only the unavailable transactions are displayed
(their value

is 1).

Client Time

(Business Process Monitor raw data measurement)
Displays the average amount of time (in
milliseconds) that passes while a request is delayed
on the client machine. Client-related delays can
include browser think time, CPU think time, HTML
page processing time, time needed to open sockets,
application delays caused by heavy applets, and so
forth.

Note: Client time is calculated by subtracting all
other measured times from the total
transaction time.
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Item

Description

Connection Time

(Business Process Monitor raw data measurement)
Displays the average amount of time (in
milliseconds) needed to establish an initial
connection with the Web server performing the
transaction. The connection measurement is a good
indicator of problems along the network or whether
the server is responsive to requests.

DNS Time

(Business Process Monitor raw data measurement)
Displays the average amount of time (in
milliseconds) needed to resolve the DNS name to an
IP address, using the closest DNS server. The DNS
Lookup measurement is a good indicator of slow
DNS resolution or other problems with the DNS
Server.

SSL Handshaking Time

(Business Process Monitor raw data measurement)
Displays the average amount of time (in
milliseconds) taken to establish an SSL connection
(includes the client hello, server hello, client public
key transfer, server certificate transfer, and other—
partially optional—stages). After this point, all the
communication between the client and server is
encrypted.

The SSL handshaking measurement is only
applicable for HTTPS communications.

Network Time to First
Buffer

(Business Process Monitor raw data measurement)
Displays the average amount of time (in
milliseconds) that passes from the moment the first
HTTP request is sent until receipt of ACK. The
network measurement is a good indicator of
network quality (look at the time/size ratio to
calculate download rate).
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Item Description

Server Time to First Buffer | (Business Process Monitor raw data measurement)
Displays the average amount of time (in
milliseconds) that passes from the receipt of ACK of
the initial HTTP request (usually GET) until the first
buffer is successfully received back from the Web
server. The server time to first buffer measurement is
a good indicator of Web server delay.

Note: Because server time to first buffer is being
measured from the client, network time may
influence this measurement if there is a
change in network performance from the
time the initial HTTP request is sent until the
time the first buffer is sent.

Time to First Buffer The sum of Network Time to First Buffer and Server
Time to First Buffer.

Download Time (Business Process Monitor raw data measurement)
Displays the time that passes from the receipt of the
first buffer until the last byte is received.

Download time is a combination of server and
network time, since the server typically sends data
over multiple connections, and is therefore working
while data is being transmitted over the network.

Retry Time (Business Process Monitor raw data measurement)
Displays the overall amount of time that passes
from the moment an HTTP request is started until
the moment an HTTP or TCP error message is
returned. Retry time relates only to HTTP or TCP
errors that execute a retry after the error.

All raw data measurements (except for Transaction Response Time and
Transaction Availability) are all weighted breakdowns, as they appear in the
Transaction Breakdown Report, and by default they are not selected. For
details, see “Understanding the Transaction Breakdown Reports” in Using
End User Management.
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Note:

» The BPM either reports Network and Server Time to First Buffer
separately, or reports Time to First Buffer as a whole; hence the Network
Time to First Buffer, Server Time to First Buffer, and Time to First Buffer
never return values on all three.

» The GDE Sample is trans_t for all the raw data measurements.

Best Practices for Raw Data Over Time Reports for a Business
Process Monitor Source

This section provides tips that will help you use the Raw Data Over Time
Report in the most efficient way. You must first decide whether it is worth
using the Raw Data Over Time report, then configure the data collectors,
and then analyze the report to find where the problem occurs.

To decide if you should use the Raw Data Over Time report:
» Do not use on a daily basis:

e This report should not be used on daily basis. In order to get an
overall picture about the monitored application open End User
Management reports. End User Management report shows the general
trend of the applications performance and availability.

e The Raw Data Over Time report is not efficient when the Business
Process Monitor is configured to report data at low frequency. For
example, if the Business Process Monitor agent reports data every 15
minutes, all the data can be seen in End User Management reports,
and there is no need to open the Raw Data Over Time report.

> Use the Raw Data Over Time report when there are
performance/availability problems:

e When the monitored application is actually having performance
and/or availability problems.
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e The end users complain about the bad performance, but there is no
indication of any problem in the Business Process Monitor reports in
End User Management.

e There seems to be a problem between transaction scheduled runs. To
detect when exactly the performance problem happens, increase the
frequency to every half minute.

o If the peaks appear during a specific minute, it is very difficult to
detect it in the End User Management reports, which usually display
the average of all the transactions in the specific time frame. If more
than one transaction appears in the time frame the average result may
hide the peak you are looking for.

¢ In such a case, to see all the reported data, open the Raw Data Over
Time report.
To configure the data collectors in the most efficient way:

In Monitoring Administration set Enable Breakdown for the relevant
transactions - for details, see “Adding Transaction Monitors” in End User
Management Data Collector Configuration.

To detect the peaks in application performance increase the frequency of the
Business Process Monitor. The recommended frequency is one minute.

3 Change the frequency in all the reporting locations.

Select Admin > CMDB, click Source Manager, click the Edit button to the
right of the Business Process Monitoring source adapter, and select
Transaction/Location in the Hierarchy structure list, and click OK.

To analyze the report when there is a periodic behavior:

Open the Raw Data Over Time report and select the time period where you
expect to find the problems. Since the report displays large amount of data,
it is recommended to select short time periods. A time period of one day
should be enough to find a periodic behavior.

2 To better see the results, enlarge the report size in the advanced settings.

3 Once you detect a peak, travel with the navigations buttons to a previous

day and to the day before that. Try to find out whether the bad performance
problem appears at the same time each day.
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To analyze the report when there is a problematic behavior:

To better understand the reason for the problematic behavior, open the
report for all the KPIs that available in the KPI filter.

Try to find a correlation between the server / network / performance results.

Raw Data Over Time Reports for a SiteScope Monitor Source

The Raw Data Over Time report shows data that is reported to Mercury
Business Availability Center from the Business Process Monitor. The main
goal of the report is to enable you to analyze application performance and
availability at crisis’s time. The biggest difference between the Raw Data
Over Time report and the End User Management report is that the Raw Data
Over Time report displays only raw data, which means that all the data that
was reported to Mercury Business Availability Center will be shown in the
Raw Data Over Time report. No calculations are made over the reported
data.

The Raw Data Over Time report displays raw data over time for selected
configuration items, received in the data samples from SiteScope Monitor,
SiteScope Measurement Group, and SiteScope Measurement Cls.

The SiteScope Monitor CI is used by Mercury Business Availability Center
when the SiteScope source adapter is configured not to include
Measurements. The SiteScope Measurement Group CI and the SiteScope
Measurement CI are used when the source adapter is set to include
measurements. For details about the source adapter, see “SiteScope” in Source
Manager Administration.

Different sets of KPIs are displayed in the report depending on the type of CI
you selected. The KPIs available for SiteScope Monitor or SiteScope
Measurement Group Cls are exactly the measurements that are reported by
SiteScope to Mercury Business Availability Center. The KPIs are named
according to the Measurement names. There are no explicit units for
SiteScope KPIs, but in most cases there are implicit unit indications in the
KPI name (for example, MB Free). The raw data values are all taken from the
ss_t GDE Sample and from the dValue field. For details, see “Sitescope
Measurement Rule” in Application Administration.
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The report displays the following information:

If you select a SiteScope Measurement Group CI, the measurements are used
as KPIs.

For example, if the SiteScope Measurement Group is cpu on bilbo, whose
measurements are: utilization, utilization cpu #1, and utilization cpu #2, the Raw
Data Over Time Report displays the measurements as KPIs.

Configuration Iterns Filter: cpu on bilba
Faw Data Measurements Filtkar: All

| ] t-2sefrz | | =

Tinne = utilization cpu # 2 utilization wutilization cpu # 1
12/6f05 1118 PM 4 3 2
12/86/05 1:38 PM 11 11 11
12/6/05 1:44 PM 23 23 23
12/6/05 1:54 PM 14 13 13
12/&f05 1:58 PM 14 13 132
12/6/05 2:18 PM 17 17 17
12/6/05 2:38 PM 17 16 16
12/6/05 2:58 PM g 7 7
12/6/05 3:18 PM 5 5 4
12/6/05 3:38 PM 14 15 15
12/6/05 3:58 PM 13 20 20
12/6/05 4:18 PM 20 20 20
12/6/05 4:28 PM 19 19 20

12/6/05 4:58 PM 5 =1 5
12/6/05 5:18 PM 3 4 3
12/6/05 5:38 PM 2 3 2
12/6/05 5:58 PM 2 2 2
12/6/05 6:18 PM 1 2 2
12/6/05 6:38 PM 1 2 2

195



Part 11l « Dashboard Reports

> If you select a SiteScope Measurements CI, a single KPI that corresponds
exactly to the measurement is displayed.

For example, if the SiteScope Measurement is utilization, the Raw Data Over
Time report displays the measurement as KPIs

Contiguration Iterns Filker: utilization
Faw Data Measurements Filker: All

| ] t-2sofre | M|

Time = utilization
12/6/05 1:18 PM 3
12/6/05 1:38 PM 11
12/6/05 1:44 PM 23
12/&/05 1:54 PM 1z
12/6/05 1:58 PM 13
1z/6/05 2:18 PM 17
12/&/05 2:38 PM i&
12/&/05 2:58 PM 7
12/6/05 3118 PM =1
1z/6/05 3:38 PM 15
12/&/05 3:58 PM 20
12/6/05 4:18 PM 20
12/6/05 4:38 PM 12

12/6/05 4:58 PM
12/6/05 S:18 FM
12/6/05 5:38 PM
12/6/05 5:558 PM
12/6/05 6:18 PM
12/6/05 6:38 FM

BOROR W R

Filtering by Raw Data Measurements
To filter a report for specific raw data measurements, you must select them.
If a selected CI does not have raw data measurements, the message No

applicable measurements is displayed near the Raw Data Measurements
Filter.

Availability is always 0 or 1 as each point in the report represents one
transaction run that was either successful (1) or failed (0). You can use this
capability to pinpoint exactly when the transaction failed.
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To filter by Raw Data Measurements:

1 Click Raw Data Measurements Filter to open the Raw Data Measurements
Filter dialog box.

|7 Transaction Response Time
¥ Transaction Availability

[ client Tirme

[ Download Time

I_ Server Time to First Buffer
[T Metwork Tirme to First Buffer
[T Tirne ta First Buffar

[ 550 Handshaking Time

I_ Connection Tirme

[ ons Tirme

I_ Retry Timme

| B

(114 | Cancel

2 Select the appropriate Raw Data Measurement(s).

3 Click OK to save the selection.

197



Part 11l « Dashboard Reports

198

Selecting Advanced Options

The advanced options enable you to manipulate the report size and the
report scale.

To select Advanced Options:

Click Advanced Options to open the Advanced Options dialog box.

Graph width

) fute scale graph based on content
O set fixad graph width

Oeccupy | 1) pages.

Select one of the following:

> Auto scale graph based on content. This causes the graph to auto scale
based on a fixed number of points, depending on the type of view you
selected in the View box.

> Set fixed graph width. The graph is displayed with the width you select
in the Occupy ... pages list. The values are in pages in a range from 1 to 8.
You can display the report pages one after the other by scrolling the
report horizontally.

Select OK to save the changes.

Tooltips

The tooltip displays the raw data measurement, the sampling time, the
sampling value, and its unit.

Transaction Response Time

Time 5/3/05 5:12 AM
¥alue 10002 (=)
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Change Report

This chapter describes how to generate a Change report in Mercury

Application Mapping.

This chapter describes: On page:
Understanding Change Reports 199
Generating a Change Report for a CI 201
Viewing the Change History of a Specific CI 204
Viewing the Change History of CIs Linked by a Container Link 206
Relationship

Performing a Snapshot Comparison 208
Viewing Statistics 209
Determining the Number of Rows Per Table 210

Understanding Change Reports

A Change report displays information about the changes made to the
properties of those Cls that were assigned to keep this information. The

report displays:

» Changes that occurred in a selected CI and all its descendents.

» Information about which CI with a Container link relationship was added to

or removed from a CI.
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» Information about which CI, whose relationship was defined with a

TRACK_LINK_CHANGES qualifier, was added to or removed from a CI. For
information about qualifier conditions, see “Defining Qualifier Conditions”
in View Manager Administration.

A Cl is displayed in the Change report only when the following conditions
occur:

> At least one of the history-sensitive properties of the CI has been
updated.

» The property that was changed had been assigned the Change Monitored
attribute. For details, see “Creating CITs” in CI Type Manager
Administration.

» To view this feature you must enable the Change report. For details, see
“Enabling the Change Report” in Application Administration.

» The Change Report option is disabled in the context menus if the shared
CMDB feature is not installed.

You can also display real-time changes for a CI and its children for a limited
number (twenty by default) of CIs. Changes to these CIs and their children
are indicated by Change icons in Dashboard. For details, see “Viewing Real-
Time Changes to CI Properties” on page 91.

The Change report displays the changes that occurred in a specific time
frame (1440 by default; that is 24 hours) specified in the Changes period
parameter in the Infrastructure Settings. For details, see “Specifying the
Changes Period for the Change Report” in Application Administration.
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Generating a Change Report for a Cl

This section describes how to generate a Change report within a specific
time frame. The Change report displays the changes that occurred within a
defined time frame.

Note: The Change report option is also available for any CI or CI’s
descendents whose history-sensitive properties were modified.

This section includes the following topics:

> “Generating a Change Report” on page 202
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Generating a Change Report

This section describes how to generate a Change report.

A typical Change report is as follows:

Change page size: [30] ﬂl @@

€I changes
1 4 r-aore 5
- CIT § oid -
CI label+ Name CI attribute Mew Walue value Change Date&Time Changer History
A Sun May 28 17:25:52 Discovery: B2
dancer.mercury.co.ill192,168.89,31 1P IP DMS Mame dancer.mercury.co.il None T A e [
dancer.mercury. co.il Unise Host Narne dancar None IS[‘# 2’1;;628 1743219 i uery: Host_ID_Discover
. . Host COperating Sun May 22 17:22:19 . . =0
dancer.mercury. co.il Unix St SunOS None T AT Discovery: Host_ID_Discover [
1) ) ook ]
Relationship changes
34l ] 1o ove 0]
A — Event Container's Related's
Container label = type Related label Change Date&Time Changer History History
dancer.mercury.co.il Q003BA101S00 Sun May 28 17:25:52 IDT  Discovery: [NE =1 F
(Unix) adesdier (interface) 2006 SNMP_MET_Diz_Connection ] i
dancer.mercury,co.il . Sun May 28 17:25:52 IDT  Discovery: [N E = r
(Unix) Peldies] €1 ASEAEE R ) 2006 SNMP_NET_Dis_Cennaction i s
dancer.mercury.co.il . Sun May 28 17:25:52 IDT  Discovery: Emr = r
(Unis) feldoel @8 Afftmonioes) 2006 SHMP_NET_Dis_Connaction ] i
dancer.mercury,co.il Sun May 28 17:25:52 IDT  Discovery: [N E = r
(Unis) reldzel €1 snmFlsRmR) 2006 SHMP_NET_Dis_Connaction ] 3]
(dua:if)r'me"””"c°"' added €I telnet(telnet) g;gsma"' 2FATIZAFIOT o very: Host ID_Discover st sl
dancer.mercury,co.il Mon May 29 10137144 IDT . q ELr pu—
{Unisx) Added CI  thk(t) 2006 User: adrmin st 3y
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The information in the Change report is divided into two tables:

» Cl changes. Displays information about the changes made to the properties

of ClIs, which were assigned to keep this information.

The following information is displayed in the Cl changes table:

Item Description
Cl Label The label of the path from the root to the CI.
CIT Name The name of the CIT (internal).
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Item Description

Cl Attribute The name of the CI attribute that was updated.
New Value The new value of the CI attribute.

Old Value The previous value of the CI attribute (before the

change).

Change Date & Time

The date and time at which the update was
performed.

Changer The name of the user that manually modified the
CI's property, or the name of the Discovery Probe
that automatically discovered a change made to the
CI's property.

History Click the icon to view the change history for the CI.

For details, see “Viewing the Change History of a
Specific CI” on page 204.

> Relationship changes. Contains information about which CI, with a

Container link relationship, was added to or removed from a CI.

The following information is displayed in the Relationship changes table:

Item

Description

Container Label

The label of the path from the root to the container
CL

Event type

You can have one of the following values:

» Added Cl. A contained CI was added to the
container CI using a Container link relationship.

» Removed CI. A contained CI that was linked to a
container CI using a Container link was removed.

Related label

The label of the path from the root to the contained
CL

Change Date & Time

The date and time at which the update was
performed.
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Item Description

Changer The name of the user that manually modified the
CI's property, or the name of the discovery probe
that automatically discovered a change made to the
CI's property.

History Click the icon to view the change history for the CI.
For details, see “Viewing the Change History of a
Specific CI” on page 204 and “Viewing the Change
History of CIs Linked by a Container Link
Relationship” on page 206.

Note: A backslash (\) in a CI name indicates a parent-child relationship with
the format: <parent_CI>\<child_CI>. For example, the entry
dancer.mercury.co.i\92.168.89.31 provides change information for the
192.168.89.31 CI which is the child of the dancer.mercury.co.il CI.

For details about the report’s functionality, see Working with Applications.
To view the Change report for a Cl:

1 Right-click a changed CI (as indicated by the icon) and select
Goto Report > Change Report to open the Change Report page.

2 Select the Change Report option to display the Change report for the
selected CI and its children Cls.

Viewing the Change History of a Specific CI

This section describes how to view the changes in the properties of a specific
CL

Note: To display the Change History report, make sure that popups are not
blocked in your browser.
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A typical Change History report is as follows:

1 History for 10.168.8.205 - Microsoft Internet Explore: - 10| x|

]

CI attribute New ¥alue Change Date&Time |Changer

Display Label 10,165,8,205 Tue May 23 16:04:31 ICMP_NET_Dis_IpC
IP Address 10.168.8.205 Tue May 22 16:04:31 ICMP_MET_Dis_IpC
IP Darnain Mame DefaultProbe Tue May 23 16:04:31 ICMP_NET_Dis_IpC
IP Metwork Address  10.168.2.0 Tue May 23 16:04:31 ICMP_NET_Dis_IpC
IP NS Mame labrn1qc3Z.mercury. cc Tue May 23 16:05:04 Host_ID_Discover
a5 bilki) bitia) a5

The page displays the following information:

Item

Description

Cl Attribute

The name of the CI attribute that was updated.

New Value

The new value of the CI attribute.

Change Date & Time

The date and time when the update was performed.

Changer

The name of the user that manually modified the
CI's property, or the name of the discovery probe
that automatically discovered a change made to the
CI'’s attribute.
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To view the change history of a specific Cl:

) 1 In the Change report, double-click the History icon for the required CI in
the Cl changes table (for details, see “Generating a Change Report for a CI”
on page 201). The History page opens.

For details about the report’s functionality, see Working with Applications.

Viewing the Change History of Cls Linked by a Container
Link Relationship

This section describes how to view the change history of a ClIs linked by a
Container link relationship.

Note: To display the Change History report, ensure that popups are not
blocked in your browser.
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A typical Change History report is as follows:

1 History for dancer.mercury.co.il - Microsoft Internet

=101 %]

]

Host Sperating Syster Sun< s

1111 1141

Sun May 28 17:

11411

CI attribute New ¥Walue Change Date&Time |Changer

Added CI 0003BA101500(interf: Sun May 28 17:25:52 SMMP_NET_Dis_Conne
Added €I 192,162,89.21(ip)  Sun May 28 17:25:52 SNMP_NET_Dis_Conne
Added <I 1finterface) Sun May 28 17:25:52 SHMP_NET_Dis_Conne
Added <1 shmplsnmpl Sun May 28 17:25:52 SHMP_NET_Dis_Conne
Dizplay Label dancer.mercury. co.il | Sun May 28 17:25:52 SNMP_NET_Dis_Conne
Hoszt DMS Mame dancer.rercury, co.il  Sun May 28 17:25:52 SMNMP_NET_Dis_Conne
Host SMMP Sys-Mame dancer Sun May 28 17:25:52 SNMP_MNET_Dis_Conne
Host Wendor Sun Microsysterns Sun May 28 17:25:52 SHMMP_MET_Dis_Conne
Added CI telnet(talnat) Sun May 28 17:32:19 Host_ID_Discover
Host Mame dancer Sun May 28 17:32:119 Host ID_Discover

119 Host_ID_Discowver

11411

The page displays the following information:

Item

Description

Cl Attribute

The name of the CI attribute that was updated.

New Value

The new value of the CI attribute.

Change Date & Time

The date and time when the update was performed.

Changer

The name of the user that manually modified the
CI's property, or the name of the discovery probe
that automatically discovered a change made to the
CI's attribute.

For details about the report’s functionality, see Working with Applications.

207



Change report:generating ® Dashboard Reports

To view the change history of Cls linked by a Container link relationship:

In the Change report (for details, see “Generating a Change Report for a CI”
on page 201), do the following in the Relationship changes table:

» To view the change history of the container CI, double-click the
Container’s History icon for the required CI.

» To view the change history of the contained CI, double-click the
Related’s History icon for the required CI.

The CI History page opens.

Performing a Snapshot Comparison

208

This section describes how to perform a snapshot comparison if snapshots
for the selected view were saved in Mercury Business Availability Center. For
details about snapshots, refer to Mercury Application Mapping
documentation.

To perform a snapshot comparison:

At the bottom of the Change Report window (for details, see “Generating a
Change Report for a CI” on page 201), click View Snapshots to open a
separate window in your Web browser displaying the snapshots that were
saved for the selected view.

Note: The View Snapshots option appears only if snapshots for the selected
view were saved.

2 Select the two snapshots you want to compare.

3 Click Compare to open a separate window in your Web browser. The

window is divided into two sections. Each side displays a hierarchical tree
structure of all the CIs in the topology map for that snapshot version.
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Viewing Statistics

You can view the statistics on the number of CIs that were removed from
and added to the selected view.

To view statistics regarding Cls that were added and removed from the
view:

At the bottom of the Change Report window (for details, see “Generating a
Change Report for a CI” on page 201), click View Statistics to open the View
Statistics window.

=10l x|

Wiew Statistics

Removed CIs=6

Added Relationships=2
Added CIs=3

Remowved Relationships=15

This window displays the following statistics:

Item Description

Removed Cls The number of CIs that were removed from the
view.

Added Relationships The number of relationships that were added to the
view.

Added Cls The number of ClIs that were added to the view.

Removed Relationships The number of relationships that were removed
from the view.
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Determining the Number of Rows Per Table

210

The information in a Change report is divided into pages. The number of
pages depends on how many rows appear in each table. You can determine
the maximum number of rows you want to appear in each table (Cl Changes
and Relationship Changes) of the Change report.

To determine the number of rows that appear in a table:

In the Change page size box, enter the maximum number of rows you want
to appear in each table of the Change report.

Click Set.

3 To view other pages, use the left and right arrows. The number between the

left and right arrows indicate which rows are currently being displayed. For
example, 1 - 2 of 3 means that the 1st and 2nd rows out of 3 are being
displayed.
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Report Repository

The Report Repository option in the Dashboard Reports tab enables you to

view all reports previously saved in Dashboard, Service Level Management,
and End User Management.

This chapter describes: On page:

Report Repository 211

Report Repository

The Report Repository page displays all reports previously saved in
Dashboard, Service Level Management, and End User Management (Triage
report only). For details, see “Report Repository” in Working with
Applications.
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Related Change Requests Report

This chapter describes how you can view change request information from
Change Control Management in Mercury Business Availability Center

Dashboard.
This chapter describes: On page:
About the Related Change Requests Report 213
Viewing the Related Change Requests Report for a CI 214

About the Related Change Requests Report

If you are working with Mercury Change Control Management, then
Mercury Business Availability Center provides an option that enables you to
view the impact of planned IT changes which have been submitted to the
service desk. You view this information in a Related Change Requests report,
opened in Dashboard for a specific CI.

The Related Change Requests report shows all change requests in the system
that have direct or indirect impact on the selected CI. It is generated by
Change Control Management, and provides a direct link to the original
change request ticket.

You can view the report at any time to check past, present and future change
requests. When a CI is registering a problem, by showing a status other than
OK, you can use the report to determine if the problem is due to the
planned change, before beginning more extensive research into the
problem.
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In order to enable the integration and view the report in Dashboard, you
must set up the environment, and configure settings in Mercury Business
Availability Center. For details, see “Integrating with Mercury Change
Control Management” in Application Configuration and Administration.

Viewing the Related Change Requests Report for a Cl

214

The Related Change Requests report is opened from the context menu for a
Cl in Dashboard.

Note: You can print the report, send it by e-mail, or save it in PDF or Excel
format. For details, see “Sharing and Storing Reports” in Working with
Applications.

To view a Related Change Request Report for a Cl

In Dashboard, right-click the relevant CI and select Go to Report > Related
Change Requests.

Note: The Related Change Requests option is enabled only if Mercury
Business Availability Center is configured to work with Change Control
Management. For more information, see “Integrating with Mercury Change
Control Management” in Application Configuration and Administration.
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2 The Related Change Requests report opens, listing all change requests that
impacted on the CI during the default time period. The list includes both
the change requests that caused a direct change to the CI (a CCI) and those
that affected the CI indirectly (an ACI).

&b s

Wiew Im Fram: 5/22/06 11:52 PM To: 5/29/06 11:52 PM Pacific Standard Time ilﬂ

Generate
Actual Start Time = Actual End Time Description Severity Status Contact Level
S/24/06 06:52:17 AM S/24/06 07:52:17 AM Swap SCSI 0:1 to 15K RPM gate drives CRITICAL In Progress Release
S/24/06 07 :32:22 PM S/25/06 02:59:22 AM Uparade mermory CRITICAL In Progress Releasze
S5/24/06 10:36:26 PM S/24/06 11:36:26 PM Meed to upgrade mernary for LODAP server CRITICAL In Progress Release
S/24/06 11:28:47 PM Sf25/06 02:29:47 AM Feplace HED at micrwave farm CRITICAL  In Progress Release
S/25/06 02:40:26 PM Sf25/06 03:40:26 PM LOAP Mermory upgrade CRITICAL In Progress Release
S5/25/06 03:15:58 PM S5/25/06 04:15:58 PM Upgrade Mermary CRITICAL In Progress Release
S/25/06 05:14:13 PM Sf25/06 07:14:47 PM Mew Report for Sales Forecasting CRITICAL  Pending Approval Releasze
S5/25/06 11:00:00 PM S5/25/06 11:30:00 PM Tina's test CRITICAL  Pending Approval Sanders, Gabbie Release

For information on the parameters in the report, see “Report Parameters” on

page 215.

3 You can change the time frame for the report by using the filters. For details,
see “Choosing the Tracking Range and Granularity” in Working with

Applications.

Report Parameters

The information displayed in the report is as follows:

Item

Description

Actual Start Time

The date and time the change request is
scheduled to go into effect.

Actual End Time

The date and time the change request is scheduled
to terminate.

Description

A linked description of the change request. The link
opens the change request ticket in the service desk
system, where you can see more information on the
requested change. (You may need to enter login
information for the service desk system.)
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216

Item

Description

Severity

The degree of impact of the change request. The
severity level is defined in Change Control
Management.

Status

The status of the change request in Change Control
Management. You can configure Mercury Business
Availability Center to include additional status
levels used in Change Control Management. For
details, see “Integrating with Mercury Change
Control Management” in Application Configuration
and Administration.

Contact

The owner of the selected change request.

Level

The level of the change request in the hierarchy in
Change Control Management.
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Real User Monitor Views in Dashboard

This chapter describes the content and structure of the Real User Monitor

views.

This chapter describes: On page:
About Real User Monitor Views 219
KPIs Used for Real User Monitor CIs 221
Real User Applications View 222
Real User End Users View 227
Real User Locations View 230
Real User Servers View 233
All RUM Monitors View 235

About Real User Monitor Views

The Real User Monitor views present real-time performance, availability, and
other data for your network and servers, collected by Real User Monitor by

monitoring real traffic generated by end users. The data enables you to

analyze the business impact of detected performance issues related to end
users, and helps you to identify the cause of delays. From the views, you can
access various Real User Monitor reports, where you can analyze the

collected data to isolate the root cause of detected problems.

For information on Real User Monitor functionality, see “Introducing Real
User Monitor Administration” in Real User Monitor Administration.

219




Part IV « Working with Real User Monitor Data

220

The CIs and relationships for the incoming Real User Monitor samples are
created by the Real User Monitor source adapter (described in “Real User
Monitor” in Source Manager Administration). The hierarchical structure for
each Real User Monitor view is determined by the TQL for the view
(described in “Working with Pattern Views” in View Manager Administration).

The views include information about applications, containers, pages, end
users, servers, user sessions, and so forth.

The Real User Monitor views are:

> “Real User Applications View” on page 222
> “Real User End Users View” on page 227

» “Real User Locations View” on page 230
» “Real User Servers View” on page 233
> “All RUM Monitors View"” on page 235

Note: You can also see Real User Monitor applications data in the Monitors
View and the End User Monitors View. For an explanation of the data in
these views, see “Real User Applications View” on page 222.

Tip: If you are not using Real User Monitor in your Mercury Business
Availability Center system, then it is recommended that you deactivate the
Real User Monitor views. For more information, see “Creating and Editing
Views” in View Manager Administration.
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KPIs Used for Real User Monitor Cls
The following KPI are used for the CIs in the Real User Monitor views:

» Performance. Displays information on the average download time of a page
or transaction, or the percentage of sessions with no page performance
problems, for an application monitored by Real User Monitor.

> Availability. Displays information on the average availability of a page,
transaction, or session, for an application monitored by Real User Monitor.

» Volume. Displays information on traffic volume, such as: page hits,
transaction runs, amount of sessions, errors, events.

» Latency. Displays information on the average round-trip time for packets
travelling between the end users and the server monitored by Real User
Monitor.

» Component Availability. Displays information on the percentage of
application pages without server errors for a monitored server.

» Bandwidth. Displays the amount of traffic (in bytes) between the server and
end users accessing the server (for traffic in both directions), including both
HTTP and HTTPS traffic.

For more details about the KPIs, see “Dashboard KPIs Detailed Description”
in Application Administration.
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Real User Applications View

222

The Real User Applications view displays data on the pages and transactions
accessed in the applications monitored by Real User Monitor, and data on
errors and events for the applications.

The applications are configured in Monitor Administration. For information
on configuring applications to be monitored, see “Configuring
Applications” in End User Management Data Collector Configuration.

This section includes the following topics:

» “Hierarchy” on page 223
» “CI Types and Their Context Menu Options” on page 224

Note: The hierarchies in the Real User Application view are also displayed in
the Monitoring View and the End User Monitors View.
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Hierarchy

The Real User Applications view generally contains the following
hierarchical structure:

5 12 Real User Applications
= JPetStore Application
=) application Sessions <—————— RUM Sessions Monitor
Bl %} Business Processes -————— End User Management Application Related Group
B L7 Alias-Koi <— Business Process Step
[ alias-Koi manitar <¢————— RUM Page Monitor
E=: Indesx
'f: Index to Signout .—— Business Process Step
% Index to Signout ronitar <——— RUM Transaction Monitor
ShoppingCard

o=

H

Signon

Signon - Shopping Business Process Step

2]

SignonForm
Signout
urn Errors <g———nwv———————— RUM Errors Events
[ 2FailedPages -4—————————— RUM Application Error Monitor
= pad user request
B Request not found RUM HTTP Error Monitor
= Request refused
@ Sarver error
% Rumn Info Events «¢—————— RUM Informational Events

- [

. ®
- TP

The TQL for the view is built as follows:

Dreserids O gl _aplication Dreencts On
L NE—
st Drepeands On 1= ate

st

M critwresd] By

rum_esrars rum_inia_envernis FUM s sessicen_manisor Eun_am groun
l Marutared By l M arwtared By l Drapends On
e e -
i S5 P ; ; o Dremencts On -
T3 _enror_inanion wn_Fifig_esmor_merniiar wn_iriio_erveril_rnonsian o = b _groug

Lk
Q-i Drapends On
—
-]
Motored By gy sgen  Momionad By

'_-T/- \'

FUT_pEage manisor

Note: The TQL nodes use the internal names for the CITs.
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Cl Types and Their Context Menu Options

This section provides a description of each CIT in the Real User Applications
view, and the Real User Monitor-related options that are available for each
CIT.

The Go to Report options are described in “Menu Options for CIs” on
page 93.

This section includes the following topics:

> “CITs” on page 224
> “Menu Options” on page 226

CITs
The CITs are:

Application. An Application CI is created for, and with the same name as,
each application configured in Monitor Administration.

Note: The Application CI does not show information on volume, even
though the Volume KPI is defined for each of the child CIs. Volume does not
propagate up to Application, because it shows volume of different traffic
types for each of the child groups, and these cannot be logically
amalgamated.

Business Process Group. Business Process Group Cls are created
automatically with a default name by Mercury Business Availability Center.

Business Process Step. Business Process Step Cls are added automatically by
Mercury Business Availability Center using the names of the pages and
transactions configured for the application in Monitor Administration.

End User Management Application Related Group. An End User
Management Application Related Group Cl is automatically created for each
application configured in Monitor Administration, using a default name
from Mercury Business Availability Center.
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> RUM Application Error Monitor. A RUM Application Error Monitor CI is
automatically created for, and with the same name as, each error event
configured for the application in Monitor Administration.

» RUM Errors Events. A RUM Error Event CI is created with a default name by
Mercury Business Availability Center for each application configured in
Monitor Administration which has error events defined.

» RUM HTTP Errors Monitor. A RUM HTTP Error Monitor CI is automatically
created for, and with the same name as, each HTTP error event configured
for the Real User Monitor engine in Monitor Administration. When a new
Real User Monitor engine is created in Monitor Administration, four default
HTTP error events are automatically created for the engine (bad user request,
request not found, request refused, and server error), and the corresponding
RUM HTTP Error Monitor Cls are added to the Application branch in the
views.

> RUM Informational Event Monitor. A RUM Informational Event Monitor CI
is automatically created for, and with the same name as, each informational
error event configured for the application in Monitor Administration.

» Rum Informational Events. A RUM Informational Event CI is created with a
default name by Mercury Business Availability Center for each application
configured in Monitor Administration which has informational error events
defined.

» RUM Page Monitor. A RUM Page Monitor CI is automatically created for
each page that is configured for the application in Monitor Administration.
The name of the CI comprises the page name and the word monitor (for
example, p1 monitor).

» RUM Session Monitor. RUM Session Monitor CIs are created with a default
name by Mercury Business Availability Center.

» RUM Transaction Monitor. A RUM Transaction Monitor CI is automatically
created for each transaction that is configured for the application in
Monitor Administration. The name of the CI comprises the transaction
name and the word monitor (for example, transaction1 monitor).
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Menu Options

Different menu options are available depending on the type of Cls:

Go to Report Menu Option

Type of CI

Session Analyzer
Event Count Over Time

Event Summary

Application

Event Count Over Time

Business Process Group

Event Count Over Time

Business Process Step

Event Count Over Time

End User Management Application
Related Group

Event Count Over Time

RUM Application Error Monitor

Event Summary

RUM Error Event

Event Count Over Time

RUM HTTP Error Monitor

Event Summary

RUM Informational Event Monitor

Event Summary

RUM Informational Event

Session Analyzer
Event Count Over Time

Event Summary

RUM Session Monitor

Event Count Over Time

RUM Transaction Monitor
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Real User End Users View

The Real User End Users view displays data for the end-user groups that are
configured for Real User Monitor in Monitor Administration. The data
includes information for each end-user group on the availability,
performance, and volume of sessions that were accessed by end users.

If IP addresses that have not been configured in end-user groups in Monitor
Administration are received in Real User Monitor samples, then a hidden
Dynamic Node Factory creates a separate branch for them in the view, under
a RUM End User Group CI called Unconfigured.

For information on configuring end-user groups to be monitored, see
“Configuring End-User Groups” in End User Management Data Collector
Configuration.

This section includes the following topics:

> “Hierarchy” on page 228
> “CI Types and Their Context Menu Options” on page 229
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Hierarchy

The Real User End Users view generally contains the following hierarchical
structure:

1.
= s Real User End Users

= Rurn End Users -t

-

RUM End User Groups
B T Mercury Israel [192,168,80,0-192,168,59,255 @————— RUM End User Group
=2 Mercury Israel [192.168,80,0-192,168.89, 255 ] <¢———— RUM End User Group monitor

3‘ Mercury USA [200.0,1,0-200.0,1,255] .——— RUM End User Group
= g‘ Unconfigured [MAA-N/A] -

RUM End User Group
[ PRIVATE IP ADDRESS L&N [10,168.8.0-10,168,8.255] <—— RUM End User Group monitor

The TQL for the view is built as follows:

rum_end_user_groups
Depends On l

gt

rum_end_user_group_container
[

Depends On
Depends Ol Depends O)

o 4
rum_end_user_group

Monitored By
=

=

RUM End User Group Monitor

Note: The TQL nodes use the internal names for the CITs.
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Cl Types and Their Context Menu Options

This section provides a description of each CIT in the Real User End Users
view, and of the Real User Monitor-related options that are available for
each CIT.

The Go to report options are described in “Menu Options for CIs” on
page 93.

This section includes the following topics:

» “CITs” on page 229

> “Menu Options” on page 230

CITs
The CITs are:

RUM End User Groups. RUM End User Groups Cls are created automatically
by Mercury Business Availability Center using a default name.

RUM End User Group. A RUM End User Group CI is created automatically
for each end-user group configured in Monitor Administration. The name
comprises the configured end-user group name, together with the IP range
of the end-user group.

RUM End User Group Monitor. A RUM End User Group Monitor CI is
automatically created for each end-user group configured in Monitor
Administration that has been received in Real User Monitor samples. The
name comprises the end-user group name together with the IP range of the
end-user group.

In addition, a RUM End User Group Monitor CI called Private IP Address
Lan (with an IP range) is created for IP addresses received in Real User
Monitor samples, but not included in end-user groups configured in
Monitor Administration.
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Menu Options

Different menu options are available depending on the type of Cls:

Go to Report Menu Option Type of Ci

End User Summary RUM End User Groups

End User Summary RUM End User Group

End User Summary RUM End User Group Monitor

Real User Locations View

230

The Real User Locations view displays data for end-user groups, organized by
location. The locations displayed are those configured in Monitor
Administration. The data includes information on the availability,
performance, and volume of sessions that were accessed by end users.

If IP addresses that have not been configured in end-user groups in Monitor
Administration are received in Real User Monitor samples, then a hidden
Dynamic Node Factory creates a separate branch for them in the view, under
a RUM Location Container CI called Unknown.

For information on configuring end-user groups to be monitored, see
“Configuring End-User Groups” in End User Management Data Collector
Configuration.

This section includes the following topics:

» “Hierarchy” on page 231
» “CI Types and Their Context Menu Options” on page 231
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Hierarchy

The Real User Locations view contains the following hierarchical structure:

= s Real User Lacations
= () Rum Locations -¢———— RUM Location Container
B O France - RUM Location Container
2 1sP [193.162,72,0-192, L«¢— RUM End User Group Monitor

The TQL for the view is built as follows:

[T
Locations root
l Depends On

[T

Countries
Depends On l

C1

States

lbonitared By
Depends On l

|l |_ nitored By
Cities
hbonitared B}:
Gl

EUM Mariiar

Note: The TQL nodes use the internal names for the CITs.

Cl Types and Their Context Menu Options

This section provides a description of each CIT in the Real User Locations
view, and of the Real User Monitor-related options that are available for
each CIT.

The Go to Report options are described in “Menu Options for CIs” on
page 93.
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This section includes the following topics:

» “CITs” on page 229
> “Menu Options” on page 230

CITs
The CITs are:

RUM Location Container. A RUM Location Container CI is created for each
location defined in Monitor Administration (for end-user groups), when
data is received for that location in the Real User Monitor samples. A RUM
Location Container CI called Unknown is created for samples without a
configured location.

RUM End User Group Monitor. RUM End User Group Monitor Cls are
created for each end-user group for which an IP address has been received in
the Real User Monitor samples. The name comprises the configured end-
user group name together with the IP range of the end-user group.

In addition, a RUM End User Group Monitor CI called Private IP Address
Lan (with an IP range) is created for IP addresses received in Real User
Monitor samples, but not included in end-user groups configured in
Monitor Administration.

Menu Options

Different menu options are available depending on the type of Cls:

Go to Report Menu Option Type of CI
Triage RUM Location Container
Triage RUM End User Group Monitor
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Real User Servers View

The Real User Servers view displays information on bandwidth usage and
server errors for the servers monitored by Real User Monitor.

For information on configuring servers to be monitored, see “Defining a
Server Name” in End User Management Data Collector Configuration.

This section includes the following topics:

» “Hierarchy” on page 233

» “Cl Types and Their Context Menu Options” on page 234

Hierarchy

The Real User Servers view contains the following hierarchical structure:

= 1-: Real Uszer Servers
=] E’ Rurn Servers -4—— RUM Servers
= [ 192.0.0.1 ¢——7—— Host
[ 192,0.0,14———— RUM Server monitor

The TQL for the view is built as follows:

=

rum_:servers
iDepends Cn
g
Host
iMnnitored By
2

rum_sernver_maonitor

Note: The TQL nodes use the internal names for the CITs.
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Cl Types and Their Context Menu Options

This section provides a description of each CIT in the Real User Servers view,
and of the Real User Monitor-related options that are available for each CIT.

The Go to Report options are described in “Menu Options for CIs” on
page 93.

This section includes the following topics:

» “CITs” on page 234
> “Menu Options” on page 234

CITs
The CITs are:

RUM Servers. The RUM Servers CI is automatically created with a default
name by Mercury Business Availability Center.

Host. A Host CI is automatically created for each host (server) for which
information has been received in the Real User Monitor samples. If a name
has been defined for the server in Monitor Administration, the CI uses the
that name. Otherwise, the CI name will generally be the IP address of the
host.RUM Server monitor. A RUM Server Monitor CI is automatically
created under each Host CI, using the same name.

Menu Options

Different menu options are available depending on the type of Cls:

Go to Report Menu Option Type of CI

Server Summary RUM Servers

Server Summary Host

Server Summary RUM Server Monitor
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All RUM Monitors View

The All RUM Monitors view includes all the hierarchies from other views for
Real User Monitor views. For details on these hierarchies, see the following
sections:

» “Real User Applications View” on page 222
» “Real User End Users View” on page 227
» “Real User Locations View” on page 230

» “Real User Servers View” on page 233

235



Part IV « Working with Real User Monitor Data

236



Part V

Working with the SAP Solution



238



19

Using the SAP Solution

The SAP solution of Mercury Business Availability Center enables you to
view and control your mission-critical SAP systems and applications.

This chapter describes: On page:
About Using the SAP Solution 240
SAP Solution Architecture 241
Collecting SAP System Information 242
Viewing SAP Information in Dashboard 243
Menu Options 248
Showing Impact for SAP CIs 249
Isolating a Problem for SAP ClIs 250
Viewing Changes Made to SAP System ClIs 251
Show Content 256
CCMS Counters 259
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About Using the SAP Solution

240

The SAP solution of Mercury Business Availability Center, integrating
SiteScope, Business Process Monitor, and Mercury Application Mapping (if
you are using Shared CMDB) enables you to gain visibility and control over
your mission-critical SAP systems and applications.

The SAP solution provides:

» asingle operation console consolidating all SAP monitoring information

» automatic discovery and modeling of SAP-related elements, as well as their

relations to other systems in the organization’s IT

» change discovery and notification, for quicker problem resolution

» display of transport deployment impact, for move-to-production risk

analysis

» proactive monitoring of end-user experience in SAP systems

> a bridge between IT and line-of-business people using the SAP Solution

Manager business processes’ hierarchy monitoring

> the ability to distinguish between SAP-specific problems and general ones
» examination, over time, of SAP CCMS monitoring data

» Service Level Management of SAP systems’ service level commitments

Note: You must have a SAP license to view the SAP_Systems view in Mercury
Business Availability Center.
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SAP Solution Architecture

The architecture of Mercury Business Availability Center SAP solution is
illustrated in the following diagram:

SAP System

— Mercury
¥ . = & SiteScope
Discovery % : L &
Probe 7\(
_ RFCVia

Mercur

. y =] - BPM source
Business |~ adapter
Process L[

Monitor

Mercury
Application
Mapping =
Server

Help desk/basis team/

The configuration for SAP entities is saved into the CMDB. Most of those
entities are created by automatic discovery. Some of the relations to Business
Process Monitor and SiteScope entities are created by automatic
mechanisms unique to the SAP solution.
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The architecture of the SAP solution includes the following components:

The Discovery Probe discovers SAP-related entities and the general entities
(such as hosts) that are related to them using CCMS. The Discovery Probe

communicates with the shared CMDB using a Remote Function Call (RFC)
via a Java Connector (JCO).

Mercury SiteScope SAP CCMS Solution Set communicates with the SAP
system and retrieves CCMS monitoring data using a Remote Function Call
(RFC) via a Java Connector (JCO).

Mercury Business Process Monitor collects data on the performance and
availability of Business Process Monitor transactions carried out on the SAP
system.

Mercury Application Mapping Server collects change information from the
Shared CMDB and stores it in the History database (only when you selected
to work with Shared CMDB).

Mercury Business Availability Center is used as the central console for
viewing all the data and performing analysis actions.

Collecting SAP System Information
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The Automatic Discovery component discovers the actual SAP IT entities
and stores them as Cls in the CMDB.

All configuration actions of SAP Cls are performed inside the CMDB
Administration application. All SAP CIs appear in the SAP Systems view
under a root CI called SAP Systems.

All SAP system metrics are monitored by SiteScope monitors.

SAP business processes/transactions are simulated using Business Process
Monitor pre-recorded VUGen scripts. Each script includes one or more
Business Process Steps and are executed from a specific location. All Business
Process Monitor-related Cls are stored in the CMDB as non-SAP-related Cls
with links to the appropriate SAP-related Cls.
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Information about the SAP System is available in Dashboard in all the
relevant tabs like other information.

The SAP Systems views includes information from the SAP IT entities, SAP
system metrics monitored by SiteScope monitors, and information about
the SAP business processes/transactions simulated by Business Process
Monitor scripts.

Viewing SAP Information in Dashboard

You can view SAP information in the SAP Systems view in Dashboard. For
details about how to work with the Console tab, see Chapter 5, “Dashboard
Console.”

The SAP Systems view in View Explorer is as follows:

Wiew! |S.ﬂ.P Systems J

1
E . SAP Systerns

= D MI&
Application Component:

< Businessz Processzes

*

0% Clients

=]

b Hosts

*

*. Locations

T ogap Configuration

H =

T Transports

=]
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The following graph describes the various layers and drill-downs available in
the topology of the SAP Systems view.

SAP

Application
Components
S SAP
) Application o ) SAP BP
Application Transactions ‘ Steps %
Components

—» | Locations H Location } - BPM Monitor
Business Business

— | Process P Process
Group Steps

—»| Transports ———»

Software Software
Components Component

Transport
Legend

Group/Container

| Monitor

SAP System | |  SAP b Config File — - Drill down
Configuration
— — e
uppol uppo
Packages Package
Application
% Host Gateway
Web
% Host Gateway ‘
Host
b e
Process
% Host }—b{ R/3
CCMS
% Host }—b{ Database ’—» CCMS
) Host o | SiteScope

- CCMS

it

—>‘ Clients H Client ‘

This section includes the following topics:

> “CIs” on page 245
» “KPIs” on page 248
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Cis

The CIs are as follows:

SAP System. SAP System is a logical unit, grouping together SAP-related Cls
(and possibly other ClIs as well) into one homogeneous SAP deployment.

SAP Applications. SAP Applications is a logical unit, grouping together
Application Components.

SAP Application Component. A SAP Application Components may include
other SAP Application Components and some SAP transactions with some
common denominator.

SAP Transaction. A SAP Transaction CI is part of a business process defined
in the SAP System. It is comprised of request-response couples called dialog
steps. The end user uses SAP transactions to carry out actions on the SAP
System.

Business Process Step. Business Process Steps (BPM transactions inside a
script) are emulated SAP transactions executed on a Business Process
Monitor machine. They are used to supply proactive monitoring of end user
experience.

BPM Monitor. The BPM Monitor CIs represent Business Process Monitor
entities used to monitor user experience.

Solution Manager Projects. The Solution Manager Projects CI type includes
SAP Business Project Cls, SAP Scenario Cls, SAP Business Process Cls, and
SAP Business Process Step Cls. The Solution Manager Projects hierarchy is
specified by the user in SAP Solution Manager.

Locations. The Contained Group Locations is a logical unit, grouping
together Contained Locations Cls.

Contained Locations. Location ClIs are created as part of the Business Process
Monitor hierarchy when working with the Transactions/locations option.

To separate the SAP Business Process steps locations status from the Location
CI (from the Business Process Monitor), the Contained Locations Cls are
created by the SAP solution and are connected to the SAP Business Process
steps (identified by following the naming convention or by manually
linking them).
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The regular Location CI is connected to all Business Process steps both
regular and SAP, but the Contained Location CI is connected only to the SAP
Business Process steps.

The Locations information represents the locations specified in BMP Profile
> BP Step > BPM transaction from location in Platform Administration.

Business Processes. The Contained Group called Business Processes is a
logical container that contains all the Business Process steps attached to all
the SAP transactions.

Transports. A Transport represents packaged change requests that include
the changes that are to be deployed onto the system.

Client. A client is an organizational and legal CI in the SAP system. The
main objective of the client is to keep the data isolated: the data in a client
can only be visible within that client; it cannot be displayed or changed
from another client. Each client on a system can represent a unique working
environment.

Hosts. Hosts is a logical unit, grouping together Host Cls.

A Host CI represents the physical machine on which a server is installed.
This is not a SAP-specific element.

Application Gateway. An Internet Transaction Server (ITS) component.
Establishes the connection to the R/3 System and performs the processing of
tasks that are required to move data between R/3 applications and the
Internet.

Web Gateway. An ITS component. A web server extension that establishes
the connection between ITS and the Web server and forwards user requests
to the Application Gateway.

R/3 Application Server. SAP R/3 Application Server is SAP’s integrated
software solution for client/server and distributed open systems.

R/3 Application servers and databases are displayed under Hosts. You can
also have several levels of hosts under the Hosts CI, SiteScope Monitor Cls,
and CCMS Monitor Cls.

Work Processes. Each work process CI is a logical, single-instance
representation of all the work processes of the same type existing on the R/3
server.
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Several types of work processes are available:
» Dialog Work Process. Executes dialog programs (ABAP).

» Update Work Process. Responsible for asynchronous database changes
(controlled by a COMMIT WORK statement in a dialog work process).

» Update2 Work Process. Used for statistical, non-critical updates (for
example, result calculations).

» Background Work Process. Executes time-dependent or event-controlled
background jobs.

» Enqueue Work Process. Executes locking operations (if SAP transactions
have to synchronize themselves).

» Spool Work Process. Performs print formatting (to printer, file, or
database).

Database. A database management system holding the data tier, including
all the SAP elements: SAP transactions, programs, work processes, and so
forth. This is not a SAP-specific CI.

Software Component. A software component installed on the SAP System,
for example: SAP_ABA (cross-application component), SAP_HR (human
resources), and so forth.

Support Package. A Support Package contains quality improvements for the
SAP system, or adjustments due to legal changes.

Configuration File. Configuration files are used to enter configuration
parameters into the system/servers.

CCMS Counters. CCMS Counters (also called Measurements) are pieces of
information elements, relevant to SAP, retrieved from SAP CCMS (Computer
Center Management System).

Monitor. The monitors are SiteScope entities used to monitor the various Cls
that exist in the CMDB. The monitors that are most likely to appear in the
SAP view are host monitors: CPU, memory, disk space, and so forth. These
monitors appear in the SAP view only if they are manually attached to the
Host CI.
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KPIs

Different Key Performance Indicators (KPIs) are displayed depending on the
selected CI. For details about the displayed KPIs, see “SAP Solution CIs” on
page 30S.

The SAP-related KPIs displayed in the Console tab are as follows:

SAP. The SAP KPI indicates problems related to the SAP infrastructure that
are reported by CCMS.

Transactions. At the group level, displays the worst status of all the child ClIs.

At the monitor level, displays the worst status of the Performance and
Availability KPIs for the CI.

Locations. At the group level, displays the worst status of all the child ClIs.

At the monitor level, displays the worst status of the Performance and
Availability KPIs for the CI.

The other KPIs displayed in the views are not SAP-related. For more details
about those KPIs, see “Dashboard KPIs Detailed Description” in Application
Administration.

Menu Options
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A list of all the context menu options available in the SAP Systems view is
available in Chapter 2, “About Menu Options for CIs”.

Different menu options are available depending on the type of Cls:

Context Menu Option Type of Ci

Show Impact All SAP-specific CI types

Problem Isolation All SAP-specific CI types

SAP Transport Changes Report SAP System and SAP Transports Cls

SAP Transaction Changes Report SAP System and SAP Transaction ClIs

Show Content Configuration Files, Software
Components, and Support Package Cls
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Showing Impact for SAP Cls

The Show Impact option enables you to select a CI, which is defined by a
correlation rule as a root cause CI, and to display all the ClIs that are affected
by it in a separate dialog box.

For example, a transport affects specific transactions. Using Show Impact
you can see the impact of Transport Cls on Transaction Cls and the impact
of Transaction CIs on Transport Cls.

For example, when this procedure is performed on a transport, the dialog
box displays all the elements that have been impacted by the transport:

| 5 3 |IH|erarch|caI Layout vI 7| & =» | B3 |-E5|l——:'®_?g| Q& BE ek i | ®
MIGK300370

SAP_Transport_Transaction[2]

ZMTRANSH
| SAP_Transport_Transaction[2]

inspection systen Label; inspection system for testint monitorin
Configuration Iter Type: SAP Application Component

Category Status Correlation Is new

change B Mew Bl new

To show the impact of a root cause object:

1 In Mercury Business Availability Center, click Applications > Dashboard >
Console and in the View list, select SAP Systems.

2 Click the gray arrow to the right of the element. A menu opens. Select
Application Mapping > Show Impact.

249



Part V e Working with the SAP Solution

Isolating a Problem for SAP Cls
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You can isolate a CI’s problem in a separate browser dialog box. The Problem
Isolation option enables you to retrieve root cause information for Cls that
are affected by a chain of correlation rules. The output of problem isolation
displays a logical map that describes a chain of trigger/affected CITs that
affect the CI.

For example, when the Problem Isolation procedure is performed on a
transaction, the dialog box displays the transports that have impacted the
transaction.

AR PG E N

MIBKID0370

SAP_Transport_Transaction[2]

ZNTRANST

To isolate a problem:

Select Applications > Dashboard > Console and in the View list, select SAP
Systems.

Click the gray arrow to the right of the element. A menu opens. Select
Application Mapping > Problem Isolation.
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Viewing Changes Made to SAP System Cls

Changes made to the properties of all types of Cls are discovered by
different types of discoveries. For details, see “Performing a SAP Discovery”
in Application Administration. Those changes are displayed in the Change
report available as a right-click menu option for each one of the relevant CI
types. For details about the Change report, see “Change Report” on

page 199.

Some of the changes made to the SAP Transactions Cls are caused by the
corresponding Transport Cls. Those specific changes are processed by
correlation rules in discovery and are displayed in the SAP Transaction
Changes report and the SAP Transport Changes report.

This section includes the following topics:

> “SAP Transaction Changes Report” on page 252
> “SAP Transport Changes Report” on page 254
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SAP Transaction Changes Report

You can display a SAP Transaction Changes report to track changes made to
a SAP Transaction CI when a transport was discovered. The SAP Transaction
Change report displays those changes.

To access the SAP Transaction Changes report:

Right-click a SAP System CI or a SAP Transaction CI in the View Explorer
and select Application Mapping > SAP Transaction Changes report or click
the gray arrow corresponding to a SAP System CI or a SAP Transaction CI in
the Console tab, and select Application Mapping > SAP Transaction Changes

report to display the SAP Transaction Changes report.

HE]
] MIG{SAP System)
Marne MIE
= ZMTRAMNS1{SAP Transaction)
Marme ZMTRANS1 Devclass ZIMSPECTIOM_FOR _MAM Prograrm ZMPROGL
Prograrm Wersion Screen o100
= CIT Wame = SAP Transport
Tide Namea DescHpton Creation Date User Target System
MIGK200518 [(SAP Transport) MIGK200518 2006,02.21 14:15:05:00 Sigalit Sade TR
MISK 900370 [SAP Transport) MIEKS00370 2006,01.17 11:20:49:00 Sigalit Sade
MIEKI00516 (SAP Transport) MIEKS00516 2006&,02.20 15:54:11:00 Ofer Mekrmal TR.M
MIEK200508 [SAP Transport] MIEKS00508 2006,02.20 14:52:25:00 Sigalit Sade TRM
MIGK200416 [SAP Transport) MIGKI00416 2006,01.26 10:06:15:00 Sigalit Sade
MISK 900432 [SAP Transport) MIEKS00432 2006,01.26 11:22:40:00 Sigalit Sade
MIEKI00422 [(SAP Transport] MIsKS00422 2006,01.26 11:09:22:00 Sigalit Sade
MIEKI00442 [SAP Transport] MIEKSO0442 2006.01.26 12:20:52:00 Sigalit Sade
= ZMTRANSZ2{SAP Transaction)
Mare ZMTRANSZ Devclass ZIMNSPECTION_FOR_MAM Program ZMPROGZ_2
Prograrm Wersion Screen o100
= CIT Name = SAP Transport
Titde Name Description Creation Date User Target System
MISK 900415 [(SAP Transport) MIsK=S00412 2006&,01.26 10:09:11:00 Sigalit Sade
MIEKI00434 [SAP Transport] MIEKSO0424 2006.01.26 11:29:58:00 Sigalit Sade
MIEK90051E [SAP Transport) MIEKI00516 2006,02.20 15:54:11:00 Ofer Mekmal TRM
MIGKI003F3 [SAP Transport) MIGKI00373 2006,01.17 11:38:02;:00 Sigalit Sade
MISK 900424 [SAP Transport) MIsKS00424 2006&,01.26 11:11:19:00 Sigalit Sade
MIEKI00520 (SAP Transport] MIEK300520 2006.02.21 14:37:58:00 Sigalit Sade TRH
= ZMTRANS3{SAP Transaction}
Marne ZMTRANSZ Devclass ZINSPECTION_FOR_MAM Prograrm ZMPROG2_3
Program VYersion Screen o100
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The table displays information about the SAP systems with changed
transactions, and under each transaction the SAP transports that have
changed during the past week (you can modify the default):

» The SAP System level:

Item

Description

Name

The name of the SAP system with a new transaction.

» The SAP Transaction level:

Item Description

Name The name of the SAP transaction that has changed.

Devclass The development class that includes the
transaction.

Program The name of the program that runs the transaction.

Program Version

The version of the program that runs the
transaction.

Screen

The first screen that opens when you load the
transaction.

» The SAP Transport level:

Item Description

Name The name of the transport that has changed.
Description A description of the transport.

User The name of the user who created the transport.

Creation Date

The date when the transport was created.

Target System

The target system for non-local transports.
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SAP Transport Changes Report

You can display a SAP Transport Changes report that includes the transports
discovered in the past week, the changes that are included in each transport,
and under each change the SAP transaction that is impacted by this change.

To access the SAP Transport Changes report:

Right-click a SAP System CI or a SAP Transport CI in the View Explorer,
select Application Mapping > SAP Transport Changes report or the gray

v arrow corresponding to a SAP System CI or a SAP Transport CI in the
Console tab, and select Application Mapping > SAP Transport Changes
report to display the SAP Transport Changes report.

HEE
] MIG{SAP System)
Marne MIE
E MI6GK200424(SAP Transport)
Marne MIGK200424 Deszcription Table called by Include User Sigalit Sade
& Program-
ZMTRANSZ_3
Creation Date 2006&,01.26 11:11:19:00 Target Sypstem
=l Table:ZMTAB_BY_INCLZ_3({SAP Transport Change)
Chject Hame ZMTAB_BY_IMCLZ_3 Ohjec Type Table
El CIT Name = SAP Transaction
Tide Name Devclass Program Program Wersion Screen
ZMTRANSZ (SAP Transaction) ZMTRANSZ ZINSPECTION_FOR_MAM ZMPROGZ_3 Q100
ZMTRAMNSZ (SAP Transaction) ZMTRAMSZ ZIMSPECTIOMN_FOR_MAM ZMPROG2_2 o100
=l Table:ZMTAB_BY_PROGZ_3{SAP Transport Change)
Cbject Marne ZMTAB_BY_PROGZ_2 Ohjec Type Table
El CIT Name = SAP Transaction
Tite Mame Devclass Progranm Program Wersion Screen
ZMTRANS2 (SAP Transaction) ZMTRANSZ ZINSPECTION_FOR_MAM ZMPROG2_2 o100
ZMTRANS3 (SAP Transaction) ZMTRANS3 ZINSPECTION_FOR_MAM ZMPROGZ_3 o100
[ MI6GK900516(SAP Transport)
Marne MIEKS00316 Description tranzporting inspection  User  Ofer Mekmal
of Mam
Craation Date 2006,02,20 15:54:11:00 Target Syztem TRN
=l Transaction:ZMTRANSZ{SAP Transport Change}
Object Name ZMTRANSZ Chjed Type Transaction
El CIT Mame = SAP Transaction
Tie Name Devclass Program Program Wersion Screen
ZMTRANS2 (SAP Transaction) ZMTRANSZ ZINSPECTION_FOR._MAM ZMPROGZ_= o100
-
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The table displays information about the SAP systems with the transports
discovered during the past week (this default is configurable), under each
transport the changes that are included in the transport, and under each
change the SAP transaction that is impacted by this change:

» The SAP System level:

Item

Description

Name

The name of the SAP system.

» The SAP Transport level:

Item Description

Name The name of the transport that has changed.
Description A description of the transport.

User The name of the user who created the transport.

Creation Date

The date when the transport was created.

Target System

The target system for non-local transports.

» The SAP Transport Change level:

Item Description

Object Name The change that has been made.

Object Type The object that changed.

Title The name of the transaction followed by (SAP
Transaction).

Name The real name of the transaction.

Devclass The development class that includes the
transaction.

Program The name of the program that runs the transaction.
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Item Description

Program Version The version of the program that runs the
transaction.

Screen The first screen that opens when you load the
transaction.

Note: Transports that are older than a month are automatically deleted from
the CMDB. The default is configurable.

Show Content

The Show Content option displays a configuration file details, the software
components file, or the support packages file of the SAP system discovered
by the automatic discovery process.

This section includes the following topics:

> “Configuration File Details” on page 257
> “Software Components File” on page 257

> “Support Packages File” on page 258
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Configuration File Details

Right-click a Configuration File CI and select the Show Content option to
display the corresponding configuration file. For example:

~MI6_DYEBMES00_CALDERONE (read-anly)

#parameter created by DMISSANT  17.12.2002 20:36:03
login/system_client = 300
SAPSYSTEMMAME = MI6
INSTANCE_MAME = DYEBMGS00
SAPSYSTEM = 00
SAPGLOBALHOST = calderone
rdispfwp_no_dia =&
rdispfwp_no_vb =5
rdispfwp_no_vbz =2
rdispfwp_no_eng =1
rdispfwp_no_htc =4
rdispfwp_no_spo =1
zcsalsysten_language =E
PHYS_MEMSIZE = 763

sapguifuser_scripting = TRUE

Details about the SAP configuration file are provided in the SAP product
documentation.

Software Components File

Right-click a Software Component CI and select the Show Content option to
display the software components file. For example:

software_components (read-only)

Mame = IDES

Package Level =

Twpe = Main component
Description =

Release = 4.6C

Mame =PI

Package Level = A

Twpe = Main component

Description = PI 2003_1_46C : Add-On Delka Upgrade
Release = 2003_1_46C

Marme = SAP_ABA

Package Level =

Twpe = Main component

Description = Componente multiaplicaciones
Release = 46C
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The software components file shows the following information:

Item Description

Name The name of the software component.
Package Level The level of the package.

Description A description of the package.

Release The release number.

Support Packages File

Right-click a Support Package CI and select the Show Content option to
display the support packages file. For example:

support_packages (read-only)

Marne = DM1K900013
Type = Patch has been applied
Description = Sprachenexport Z1 16,09,2002 (BUCHERT)

Marmne = SAPK-03A7GINSDF
Type = Patch has been applied
Description = Solution Toals Plugin (ST-PI 0034 _620)

Marne = SAPK-10001INLSOFE
Type = Patch has been applied
Description = LS0OFE 100 (Learning Salution - Fronk End)

The support packages file shows the following information:

Item Description

Name The name of the support package.
Type The type of support package.
Description A description of the package.




Chapter 19 ¢ Using the SAP Solution

CCMS Counters

The CCMS Counters Dynamic Nodes collect the samples from SiteScope and
display them as CIs under the elements they are monitoring.

To view SiteScope samples under a CCMS Counters node:
1 Select Applications > Dashboard, click Console.
2 In the View list, select SAP Systems.
3 Select Background.

The Console page displays the samples from SiteScope.

Background = ﬂﬂﬂﬂ

sap @+* ack @

Manwe SAP  Ack Manwe SAP  Ack
O zap coMs M., EndedWpBTo ¥ 9+* OO Spp CoME M L., berOfwpBTS @+ 8
[rTY v L

Details - SAP

£ap ccms monitor
templates/entire

system)/ misd 3
zervices/background/mis
healderone_mis_00
YoAbackground/endedwpbtc
Status: Lol

Calculation Rule: SiteScope Vertical Rule
Held status since:  2/15/06 02:57:49 AM

0,0 AP CCMSE Monitor
Ternplates/Entire
Systern/MIE/RS 3
Services/Background/MI&
Wealderone MIS_ 004, LB
ackground/EndedWpBTC

CI name:

Message !

The tooltips includes the following information:
» Cl Name. The name of the CI.

» Status. The status of the CI (calculated according to one of the status
calculation methods). It may also display:

¢ Not up to date for decayed ClIs, indicating that the CI has passed its
timeout period. (For a SiteScope CI, this status is displayed after a
SiteScope monitor is disabled.)

e Stopped when a Business Process profile is stopped.
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» Calculation Rule. The name of the rule that calculates the KPI status or

value.

Held Status Since. The date and time since which this CI has held its
current operational status.

Message. The value(s) returned by the monitor the last time it ran, as
displayed in SiteScope. This may simply be the retrieval time and file size
or it may include specific parameters for a server component.

Last Update. The date and time that the last update for the CI was
received by Dashboard. This information is not always displayed.

Measurement. The name of the measurement from SiteScope. This
information is not always displayed.

Monitor. The monitor type that the CI represents. This information is
not always displayed.
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Using the Siebel Solution

This chapter describes the specific tasks involved in using the Siebel

solution.
This chapter describes: On page:
Introducing the Siebel Solution 263
The Siebel Solution Architecture 268
Collecting Siebel System Information 269
Viewing Siebel Information in Dashboard 270
Context Menu Options 272
Viewing Changes Made to Siebel System ClIs 272
Viewing Configuration File Details 273

Introducing the Siebel Solution

This section describes the Siebel solution that you use to monitor the

performance of Siebel enterprises.

This section includes the following topics:

> “About Using the Siebel Solution” on page 264

> “Working with Business Availability Center for Siebel” on page 265
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About Using the Siebel Solution

Mercury Business Availability Center Siebel solution, integrating SiteScope,
Business Process Monitor, and Mercury Application Mapping (if you are
using Shared CMDB), enables you to gain visibility and control over your
mission-critical Siebel systems and applications.

The Siebel solution provides:

> asingle operation console consolidating all Siebel monitoring information

» automatic discovery and modeling of Siebel-related elements, as well as

their relations to other systems in the organization'’s IT

» change discovery and notification, for quicker problem resolution

» display of transport deployment impact, for move-to-production risk

analysis

» proactive monitoring of end-user experience in Siebel systems

> a bridge between IT and line-of-business people using the Siebel Solution

Manager business processes’ hierarchy monitoring

> the ability to distinguish between Siebel-specific problems and general ones
» examination, over time, of Siebel CCMS monitoring data

» Service Level Management of Siebel systems’ service level commitments

Note: You must have a Siebel license to view the Siebel view in Mercury
Business Availability Center.

Business Availability Center for Siebel consolidates Siebel components and
business processes using a dynamic topology map and status dashboard to
gain real-time visibility and control over the entire Siebel infrastructure
from a business perspective.
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Business Availability Center for Siebel also monitors, reports, and alerts on
the performance and functionality of the Siebel eBusiness applications and
servers that comprise your Siebel enterprise business process infrastructure.
Using Business Availability Center for Siebel, your IT operation can analyze
how each link in the Siebel enterprise chain is affecting the user experience
of customers, partners, suppliers, and employees. This enables your IT team
to more accurately assess the resulting impact on business performance. It
also enables the IT team, Siebel application support team, and Siebel Expert
Services to take any steps that might be necessary to maximize availability,
performance, and service levels in order to provide the best quality of
service for all Siebel applications and end users.

The automatic root-cause analysis of Siebel-related problems is performed
through auto-correlating end-user issues to Siebel components to reduce
escalation and resolution times.

Working with Business Availability Center for Siebel

You access the Business Availability Center for Siebel information in the
Applications menu.

Siebel Enterprises View. The Siebel Enterprises view is available in the
regular tabs of the Applications menu. For details, see “Viewing Siebel
Information in Dashboard” on page 270.

Reports. Siebel-related information is available in the regular tabs of the
Applications menu.

Diagnostics. The Diagnostics tab contains the following diagnostic tools:

> Database Breakdown. Enables you to determine the cause of slow
database response time by analyzing the SQL activity between a Siebel
component and the Siebel database. For detailed information on this
tool, see Chapter 21, “Using the Siebel Database Breakdown Diagnostic
Tool”.

» Tasks. Enables you to view details of the Siebel Application Server tasks,
for each monitored Siebel site. For detailed information on this tool, see
Chapter 22, “Using the Siebel Tasks Diagnostic Tool”.
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> SARM - User Trace Breakdown. Enables you to view details of the Siebel
Application Server SARM - user trace breakdown tasks, for each
monitored Siebel site. For detailed information on this tool, see
Chapter 23, “Using the SARM - User Trace Breakdown Diagnostic Tool”.

» Process. Enables you to view details of the Siebel Application Server
processes, for all monitored Siebel site. For detailed information on this
tool, see Chapter 24, “Using the Process Diagnostic Tool”.

Note: Before you can use the Siebel solution, you must set up your Siebel
monitoring environment in Admin > Siebel Configuration. For information
on defining the Siebel sites, servers, and applications that you want to
monitor, see “Configuring the Siebel Solution” in Application Administration.

Working with Firewalls
If you want to work with firewalls, you must install a firewall with Virtual
Private Network (VPN) between:

Mercury Business Availability Center and Business Process Monitor, to view
SARM - user trace breakdown and/or database breakdown information

Mercury Business Availability Center and SiteScope, to view all diagnostics
information
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The following diagram illustrates how the database breakdown diagnostic
tool operates:

«e

Siebel site
Business
Process The Internet/
Monitor WAN
% firewall
Web: y
firewall Servers a
yrs
(]
—
Application
Servers
Database
Application Management \
firewall

SiteScope
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The Siebel Solution Architecture

The architecture of Mercury Business Availability Center Siebel solution is
illustrated in the following diagram:

Real User Monitor Siebel Enterprise Mercury
Probe* _ SiteScope
RealUsor_ _ _ _ __{ = _ _ SystemMonitoring_ _ _
Monitoring » - Siebel Diagnostics »

Probe - g Business Process
sad Monitor

_ _Topolod¥ ~ - nd U,
- AR, D‘Z’ MO"fto,fn —
B eakdom;qn' *

Discovery Mercury
-~

Real User]
Monitor
Engine*

Mercury Business Availability Center
Siebel solution

Mercury
Application
Mapping |

ange; :'
Server* T

l Legend

* Optional

The configuration for Siebel ClIs is saved into the CMDB. Most of those CIs

are created by automatic discovery. Some of the relations to Business Process
Monitor and SiteScope Cls are created by automatic mechanisms unique to
the Siebel solution.

The architecture of Mercury Business Availability Center Siebel solution
includes the following components:

» The Discovery Probe discovers Siebel-related Cls and the general CIs (such as
hosts) that are related to them. The Discovery Probe communicates with the
Mercury Application Mapping if shared CMDB (optional) is installed. For
details about shared CMDB, see “Deploying the Siebel Solution” in
Application Administration.
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» Mercury Application Mapping Server collects change information from the
Shared CMDB and stores it in the History database (only when you selected
to work with Shared CMDB).

» The Real User Monitor Probe discovers Real User Monitor-related CIs
(optional).

» Mercury SiteScope Siebel solution templates communicates with the Siebel
Enterprise system and retrieves system monitoring and Siebel diagnostics
data using a Remote Function Call (RFC) via a Java Connector (JCO).

» Mercury Business Process Monitor collects data on the performance and
availability of Business Process Monitor transactions carried out on the
Siebel system, as well as end user monitoring, SARM and database
breakdown data.

» Mercury Business Availability Center is used as the central console for
viewing all the data and performing analysis actions.

Collecting Siebel System Information

The Automatic Discovery component discovers the actual Siebel IT entities
and stores them as Cls in the CMDB.

All configuration actions of Siebel CIs are performed inside the CMDB
Administration application. All Siebel Cls appear in the Siebel Enterprises
view under a root CI called Siebel Enterprises.

All Siebel system metrics are monitored by SiteScope monitors.

Siebel business processes/transactions are simulated using Business Process
Monitor pre-recorded VUGen scripts. Each script includes one or more
Business Process Steps and are executed from a specific location. All Business
Process Monitor-related Cls are stored in the CMDB as non-Siebel-related
ClIs with links to the appropriate Siebel-related Cls.
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Information about the Siebel sites is available in Dashboard in all the
relevant tabs like other information.

The Siebel Enterprises view includes information from the Siebel IT entities,
Siebel system metrics monitored by SiteScope monitors, and information
about the Siebel business processes/transactions simulated by Business
Process Monitor scripts.

Viewing Siebel Information in Dashboard

You can view Siebel information in the Siebel Enterprises view in
Dashboard.

The Siebel Systems view in View Explorer is as follows:

Wiew: |Siebe| Enterprises J

Bl 52 sSiebel Enterprizes

[ & siebel
Applications
Business Processes
.7 Hosts
.7 Locations
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The following graph describes the various layers and drill-downs available in
the topology of the Siebel Systems view.

— | Siebel > BP
| FPEEEETS 7| Application | Steps
R BPM
q Contained .
»
| Locations P | ocation - Transagtlon/
Location
Business Business
» »
- | Processes g P;;:ezs
Slebgl > P
Enterprises Legend
- Host » Web Server Group/Container
Siebel Web
Server —» Drill down
Extension
Same
B Hosts > v level link
Siebel Web
Application
- Siebel
gl Host Gateway
Siebel Siebel Siebel
Hi- Host » Application P Component Him
Component
Server Group
- Host » Database

Note: The ClIs, their hierarchy, and their KPIs are detailed in “Cls Discovered
by the Discovery Process” on page 388.
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Context Menu Options

A list of all the context menu options available in the Siebel Enterprises view
is available in Chapter 2, “Dashboard Menu Options”.

The Siebel-specific CITs that appear in the Siebel Enterprises view are Siebel
Site, Siebel Application, Siebel Application Server, Siebel Component Group,
Siebel Component, Siebel Web Server Extension, Siebel Web Application.

The right-click options available from the Siebel-specific CITs are listed in
“Go to Siebel Diagnostics” on page 35. An additional right-click option is
Cross-Performance Report. For details, see “Siebel Cross-Performance” on
page 30.

Viewing Changes Made to Siebel System Cls

272

Changes made to the properties of some types of Cls are discovered by
different types of discoveries. For details, see “Performing a Siebel
Discovery” in Application Administration. Those changes are displayed in the
Change report available as a right-click menu option for each one of the
relevant CI types. A Change report displays information about the changes
made to the properties of those Cls that were assigned to keep this
information. For details, see “Change Report” on page 199.
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Viewing Configuration File Details
The Show Content option displays configuration file details.
The following configuration files are available:

> Siebel.cfg. The siebel.cfg configuration file is taken from the application
server installation. It opens when you right-click a Configuration File CI
under a Siebel Application Server Cls and select Show Content.

—siebel (read-only)

[Internet] LI
TableCwner = SIEBEL

SqlStyle = OracleCBO

[I55CDa]

I53CDAProdDetBusCompMame = Internal Product

1S5 DAProdDetBusObiMame = Internal Produck
I53CDAProdDetviewlame = Product Detail Key Features Yiew
153CDAHeaderBusObjMame = Quote
I53CDAHeaderBusCompMame = Quaote
ISSCDAlntegrationObjiame = Quote

155 DaListIkemBusCompName = Quote Ikem
I53CDAHeaderviewMame = Quote Detail Yiew

155CDAGetMyPriceFields = List Price, Product Mame, Current Price, Pricing Comments, Met Price, Start Price

[wireless: ApplicationList]

Siebel Sales Wircless = Wireless3alesObiMar_enu

Siebel Service Wireless = WirelessServiceObjlMgr_enu

Siebel PRM Wireless = ‘wWirelesseChannelObiMar_eru

115iebel eService Wireless = wirelesseServiceObiMar_enu j
-
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> parameters.cfg. The file includes the output of the list parameters for
component command using srvrmgr. It opens when you right-click a
Configuration File CI under a Siebel Component Cls and select Show

Content.

parameters (read-only)

ActuateReportCastDormain CHANGE_ME

ActuateReportCaztHost
ActuateReportCastlang LANG_INDEPENDENT

ActuateReportPollait 30
ActuateReportServerHost

ActusteRequestPollnterval  10,0,0,10

ActusteRoxDir ISishel Reports/
ActuateServerEnabled False
AddToCan AutoGuote TRUE
AddToCanGatoiew HONE
&nanLogin False
AnshymousQuots FALSE

AssetBasedOrderingEnabled  False
AutoluoteDefaut Owner TRUE

AutoRestart True
BusinessServiceGueryAccessList

CACerFilehame

CCAEnable False
CCAMercharthd esalestest
CCAServerHost icsestic3.com
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PA_ALIAS PA_WALUE PA_DATATYPE PA_SCOPE PA_SUBSYSTEM PA_SETLEVEL PA_DISP_SETLEVEL

1EKThISpace String  Subsystem Database Access Mever zet Mever set YoM MW 16K Tak
32KThISpace String  Subsystem Database Ancess Mewver set Mever set NN NN 32K Tak
ActuateConnStr String  Subsystem Infrastructure Actuste Reports Mever et Mever set YOMONM M Act
ActuateProtocolblame String  Subsystem Infrastructure Actuste Reports Never set Mever set YN A

Shring  Subsystem Infrastructure Actuate Reports Server level Server level set

String  Subsystem Infrastructure Actuste Reports Never set Mever set NN
String  Subsystem Infrastructure Actuate Reports Server level Server level set

Integier  Subsystem Infrastructure Actuate Reports Server level  Server level set VNN
String  Subsystem Infrastructurs Actusts Reports Never sst Never set WON NN
String  Subsystem Infrastructurs Actuste Reports Defautt value  Default valus YN
String  Subsystem Infrastructurs Actuste Reports Server level  Server level sst YN
Boolean  Subsystem Infrastructure Actuate Reports Defaull value  Default value YONT
String  Subsystem Infrastructure Shopping Servic Defaul value  Default value YN N
String  Subsystem Infrastructure Shopping Servic Defaul value  Default value VN b
Boolean  Subsystem Object Manager Default value  Defaut value ¥ NN N OM -
String  Subsystem Infrastructurs Shopping Servic Defautt value  Default valus YN
Boolean  Subsystem Object Manager Default value  Defaut value YONN
String  Subsystem Infrastructure Shopping Servic Default value  Defaull value ¥ N
Boolean  Subsystem Process Management Defeutt value  Defaull value YONN N A
String  Subsystem Object Manager Mevsr set  Never sst HONN N
String  Subsystem Networking Mevsr set  Never sst NN YN CA certific
Boolean  Subsystem Infrastructure CCA subsystem Defautt value  Defaul value YN NN
String  Subsystem Infrastructurs CCA subsystem Detfaut valus  Default value YN
String  Subsystem Infrastructure CCA subsystem Defeut value  Defaul value ¥ N
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Using the Siebel Database Breakdown

Diagnostic Tool

The Siebel database breakdown diagnostic tool enables you to create and

analyze database logs that record the SQL activity between Siebel

components and the Siebel database.

This chapter describes: On page:
About Analyzing Siebel Database SQL Activity 276
Creating Siebel Database Logs 278
Analyzing the Siebel Database Breakdown 281

Note:

» The Siebel administrator creates and analyzes the database logs.

» The diagnostic tools are enabled per Mercury Managed Services customer.
At any given time, only one customer within a center can use the

diagnostic tools.
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About Analyzing Siebel Database SQL Activity

276

You analyze Siebel database SQL activity by examining information in the
Siebel database logs. These logs contain a record of SQL activity between
Siebel components and the Siebel database.

You record Siebel database logs for each Siebel component whose database
SQL activity you want to analyze. You can then drill down within these logs
on the database time for a specific component during a specific transaction
and determine which SQL operations, or parts of operations, were
responsible for slow database response time.

This section includes the following topics:

> “Before You Create and Analyze Database Log Files” on page 276
» “Steps to Perform for Each Database Log File You Want to Record and

Analyze” on page 277

Before You Create and Analyze Database Log Files

The following steps must be performed before you can begin creating and
analyzing database log files:

Set the Siebel Server Manager connectivity parameters.

To enable Mercury Business Availability Center for Siebel to retrieve
database log files from the Siebel Application Server, you must supply
certain Siebel Server Manager connectivity parameters. For information on
setting these parameters, see “Manual Configuration for Specific Siebel CIs”.

Copy files from the Siebel Application Server to the SiteScope machine.

To work with the Siebel database breakdown diagnostic tool, you must copy
the Siebel Server Manager files located in the siebsrvr\bin directory on the
Siebel Application Server to the SiteScope machine.
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Steps to Perform for Each Database Log File You Want to
Record and Analyze

The following steps are performed for each database log file you want to
record and analyze:

Create the Siebel database logs.

You create Siebel database logs by defining a component on the Siebel
Application Server and running a Business Process Monitor transaction that
involves the component you defined and the Siebel database. You perform
both these actions on the Siebel Database Breakdown: Configuration page.
For details, see “Creating Siebel Database Logs” on page 278.

Retrieve the database log file and transaction from the Siebel
Application Server.

To analyze the database log file that was created, you must first retrieve the
file from the shared folder in which it is located, on the Siebel Application
Server. You locate the file by specifying the login name of the user with
which you created the log file and the time period during which the file was
created. Business Availability Center for Siebel then sends a command to the
SiteScope machine to retrieve the file whose name you specified, or the file
that the specified user created during the time interval you selected.

Copy the database log file.

Business Availability Center for Siebel instructs the SiteScope machine to
copy the database log file to the <Core Services Server>\AppServer\
webapps\site.war\Imgs\chartTemp\offline folder.

After the above process has been completed, the database log file that was
created can be analyzed (for details, see “Analyzing the Siebel Database
Breakdown” on page 281).
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Creating Siebel Database Logs

278

You create Siebel database logs by defining a component on the Siebel
Application Server and running a Business Process Monitor transaction that
involves the component you defined and the Siebel database. You perform
both these actions on the Siebel Database Breakdown: Configuration page.

To record and analyze each database log file, you must use the following
procedure:

To create database log files, you must first define certain entities for which
you want to analyze data, such as a Siebel site and application, a Business
Process Monitor transaction, and a host machine on which you want to run
the transaction. For information on defining the entities for which you
want to analyze data, see step 1 below.

Before you can create the database log file, you must select a Siebel
component, a Siebel application server, and the SiteScope machine that will
be responsible for increasing and decreasing the database log level for the
component you selected, as well as retrieving the database log file after it is
created. For information on selecting a SiteScope machine and determining
the database log level modification method, see step 4 below.

When you click Analyze (for details, see the procedure below), Business
Availability Center for Siebel automatically increases the database log level
for the selected component and sends a command to the SiteScope machine
to instruct the Siebel Application Server to create a log file that records the
SQL activity between the Siebel database and the component you selected.

Business Availability Center for Siebel instructs the Business Process Monitor
to run the transaction you selected. During the transaction run, SQL activity
between the Siebel component you selected and the Siebel database is
recorded in a log file on the Siebel Application Server.

When the transaction has finished running, the database log level for the
selected component decreases automatically. When the database log level is
decreased, a command is sent to the SiteScope machine instructing the
Siebel Application Server to stop recording the SQL activity between the
Siebel component and database, and writing to the log file is stopped.
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To create Siebel database logs:

1 Click Applications > Business Availability Center for Siebel > Database
Breakdown to open the Siebel Database Breakdown Configuration page.

Database Breakdown | Tasks SARM - User Trace Breakdown Process
Databasze Breakdown > Configuration
Select an enterprize: Isiebel?a 'I Select an application: eEvents ;I User Mame: I

Available Transactions

® Advanced options

Select a Siebel component: IeEuents Object Manager (JPN) ;I

Select a serven I-AII Servers- 'I
Using SiteScope: Icatapultl 'I

Analyze |

You can also access this page filtered for the selected CI, when you right-
click the CI and select the Siebel Database Breakdown option. For details,
see “List of Menu Options” in Using Dashboard.

2 In the top part of the page:
a In the Select an enterprise list, select the Siebel site.

b In the Select an application list, select the Siebel application for which
you want to analyze data.

The value in the User Name box appears automatically when you select
the application. The appropriate user name has been entered manually
by your administrator after discovery has taken place. For details, see
“General Administration” in Application Administration.
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3 In the Available Transactions area, the transactions are listed when you

select an enterprise site and an application in the top part of the page:

a Click the transaction from location from which you want to run the
Business Process Monitor transaction in order to monitor the Siebel
application you selected; you must have selected a transaction first in the
Available Transactions area in the Siebel Database Breakdown:
Configuration page. (Note that the list of transactions depends on the
Siebel site and application you selected and includes only those for
which you have permissions.)

Note: For diagnostic purposes it is recommended to use a script running a
specific user from a dedicated location. This will enable performing
diagnosis only of the transactions meant to be analyzed, as well as knowing
which location they ran from.

In the Advanced options area:

a Select a Siebel component in the Select a Siebel component list on this
server whose SQL activity vis-a-vis the database you want to analyze.
When you run the selected transaction, database logs reporting the
activity between this component and the database will be created.

b Select a Siebel Application Server in the Select a server list.

c Select the SiteScope machine you want to use to monitor the Siebel
component in the Using SiteScope list.

Click Analyze to display the Siebel Tier Breakdown and Siebel Database SQL
Breakdown pie charts. For details, see “Analyzing the Siebel Database
Breakdown” on page 281.
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Analyzing the Siebel Database Breakdown

After you have created Siebel database logs, you can analyze them to
determine which of the component’s SQL operations, or parts of operations,
were responsible for slow database response time.

Click the Analyze button on the Siebel Database Breakdown: Configuration
page to open the Siebel Database Breakdown: Analysis page.

BEE
Transaction Name: siebel_login
Database source log file: SCCObjMgr_enu_166947.log (on serverisblapplq)
Siebel Tier Breakdown Siebel Database SQL Breakdown

Top 15 time-consuming 5QLs out of 33

B saoL =15
W sl ld=6
B saL ld=13
ol saL ld=18
ol saL ld=28
W saL ld=21
ol saL ld=17
ol saL ld=z0
ol saL ld=33
| saL ld=1
B saL ld=32
SQL ld=31
ol saL ld=30
| saL ld=1g
B saL ld=15

B Database Time
W Application Time

Transaction response time = 2.87 seconds Total databasze time = 0.13 seconds

The Siebel Tier Breakdown pie chart shows the component’s database time
relative to its application time.

The Siebel Database SQL Breakdown pie chart displays a breakdown of the
component’s database time in which you can view the 15 most time-
consuming SQL database operations.
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To view the breakdown of an SQL operation, click the section of the pie
representing the SQL operation. The Specific SQL Breakdown pie chart is
displayed.

glE 8|

Transaction Name: siebel_login

Database source log file: SCCObjMgr_enu_166947.l0g [on serverisblappl Q)

Specific Siebel 5QL Breakdown
SQLId = 16 (Time stamp: 2004-10-17 13:44:18)

B Prepare Time

B Execute Time

M Initial Fetch Time
ol Wirite Time

SOL respon=se time = 0.011 seconds

Measurements of Analyzed SQL Statement:

Statement

SELECT T1.COMFLICT_ID, T1.LAST_UPD, T1.CREATED, T1.LAST_URD_BY, T1.CREATED_BY. T1.MODIFICATION_MUM,
T1.ROW_ID, TL.CACHE_RSLT_FLG, TL.DESC_TEXT, T1, QUERY_STRIMNG FROM SIEBEL.S_APP_QUERY T1 WHERE
(T1,CREATED _BY = 1-80 OR T1.PRIV FLG = 'W') AMD (T1.WAME = WebcCallCenter ) ORDER BY T1,MAME, T1,DESC_TEXT

For each SQL operation, you can view the measurement data of each
analyzed SQL statement that was collected: preparation time, execution
time, initial fetch time, total time, and write time (time stamp). This enables
you to isolate the exact segment that was responsible for the delay in the
database response time. Underneath the Specific SQL Breakdown pie chart,
you can view the corresponding SQL statement.

Note: You can print the report, open it as a PDF or e-mail it by clicking one
of the icons at the top of the report (for details, see “Sharing and Storing
Reports” in Introduction to Mercury Business Availability Center Applications).
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Using the Siebel Tasks Diagnostic Tool

The Siebel tasks diagnostic tool enables you to view details of the Siebel
Application Server tasks, for each monitored Siebel site.

This chapter describes: On page:
About the Tasks Diagnostic Tool 283
Viewing Task Details 284
Using the Advanced Filter 286

Note: The diagnostic tools are enabled per Mercury Managed Services
customer. At any given time, only one customer within a center can use the
diagnostic tools.

About the Tasks Diagnostic Tool
Using SiteScope, you can:

» retrieve details of the Siebel Application Server tasks that are running, or
were run, on each Siebel site

» choose to view details of all tasks, regardless of status, or details of only
those tasks with a specific status

» choose to view task details for all components in all component groups on
all Siebel Application Servers, or for specific components in specific
component groups on specific Siebel Application Servers
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Note: To work with the Siebel tasks diagnostic tool, you must copy the
Siebel Server Manager files located in the siebsrvr\bin directory on the
Siebel Application Server to the SiteScope machine.

Viewing Task Details

To view details of Siebel Application Server tasks, you must select a Siebel
site and task status, and enter the Siebel user login name to be used by
SiteScope when retrieving task data from the Siebel Application Server. In
addition, you can use the advanced filter to select the specific
component(s), component group(s), and Siebel Application Server(s) for
which you want to view task data.

The tasks detailed information is as follows:

site: [whistle =] Status: [-Allstatuses- =] Usen

Advanced Filter: S,aruer: All servers, Component Group: All component groups, Component: All commponents, Using Apply
= SiteScope: rcald

6l 1 ] il
S5¥W_NAME CG_ALIAS CC_ALIAS TK_LABEL TK_TASKID TK_PID TK_DISP_RUNSTATE CC_RUNMOL =
whiztle Systern ServerMgr 105432 4336 Running Interactive
whistla CallCentar SCCObiMar_jpn sadmin 105431 1985 Running Interactive
whistle Systern ServerMgr 105430 Completed Interactive
whistle Systern ServerMgr 105429 Completed Interactive
whiztle Systern ServerMgr 105428 Cormpleted Interactive

SV_NAME. The name of the server on which the task is running.

>
» CG_ALIAS. The name of the component group the task belongs to.
» CC_ALIAS. The name of the component the task belongs to.

>

TK_LABEL. The name of the user who is running the tasks. Tasks belonging
to the system component group do not have a user.

» TK_TASKID. The Id of the task.
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TK_PID. The Id of the operating system process that deals with the task; the
operating system in question is where Siebel is running.

One process can deal with more than one task.

This column displays data only for tasks whose TK_DISP_RUNSTATE is
running.

TK_DISP_RUNSTATE. The state of the task: Running, Paused, Stopping,
Completed, Exited with Error, or Killed.

» CC_RUNMODE. The mode used to execute the task: Interactive or Batch.
» TK_STATUS. A description of the task—added by the task. If

Y Y Y Y Y Y Y

TK_DISP_RUNSTATE is Exited with Error, TK_STATUS displays the error
message.

TK_START_TIME. The time when the task started to execute.
TK_END_TIME. The time when the task stopped executing.
TK_PARENT_T. The task that caused this task to execute.
CC_INCARN_NO. The number of times the task was restarted.
TK_TASKTYPE. The urgency of the task.

TK_PING_TIM. For future use.

TK_IDLE. For future use.

To view task details:

Click Applications > Business Availability Center for Siebel > Tasks to open
the Task Diagnostics Tool page.

You can also access this page filtered for the selected CI, when you right-
click the CI and select the Show Tasks in Error or Show Running Tasks
option. For details, see “List of Menu Options” in Using Dashboard.

From the Enterprise box, select the Siebel site for which you want to view
task data.

From the Status box, select the specific status—Running, Paused, Stopping,
Completed, Exited with Error, or Killed. Alternatively, you can select to view
tasks of all statuses.
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The value in the User box appears automatically when you select the
application. The appropriate user name has been entered manually by your
administrator after discovery has taken place. For details, see “General
Administration” in Application Administration.

If necessary, click the Advanced Filter link to filter the list of tasks (for
details, see “Using the Advanced Filter” on page 286).

Click the Apply button. The task information you requested is retrieved
from the Siebel Application Server(s) and displayed on the Tasks Diagnostic
Tool page.

Note the following:

To sort the tasks by a specific column, click the column heading.

> To move between pages, use the First, Previous, Next, and Last arrows

W] 4] M above the table.

Using the Advanced Filter

286

Use the advanced filter to filter the list of tasks you want to display.

To use the Advanced Filter:

1 In the Task Diagnostics Tool page, click the Advanced Filter link to open the

Tasks Diagnostics Tool Advanced Filter page.

Server:

Component Group:! I-F\ll component groups- ;I
Component: I-F\ll components- ;I
Using SiteScope: Ip,DID,qg ,I

OK| Cancel | Help |

2 Select, in the Server list, the specific server whose task data you want to

view.
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Select the specific component group for which you want to view task data in
the Component group list.

Select, in the Component list, the specific component for which you want
to view task data.

Select, in the Using SiteScope list, the SiteScope machine you want to use to
retrieve task data from the Siebel Application Server, if you do not want
Business Availability Center for Siebel to use the default SiteScope machine.

Click OK to save the filter settings and close the Advanced Filter dialog box.
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Using the SARM - User Trace Breakdown

Diagnostic Tool

The Siebel Application Response Measurement (SARM) - User Trace
Breakdown diagnostic tool enables you to create and record the SQL activity

in each monitored Siebel site.

This chapter describes: On page:
About the SARM - User Trace Breakdown Diagnostic Tool 290
Using the SARM - User Trace Breakdown Diagnostic Tool 291
Running the SARM - User Trace Breakdown Diagnostic Tool 298
Results - Analysis Page 299

Note: The diagnostic tools are enabled per Mercury Managed Services
customer. At any given time, only one customer within a center can use the

diagnostic tools.
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About the SARM - User Trace Breakdown Diagnostic Tool

290

The SARM - user trace breakdown diagnostic tool processes only the data
that is received by the User Session Trace output files. It retrieves the SARM
data, for a specific user in a specific time frame. It also retrieves the data for a
specific transaction that belongs to a prerecorded script with Siebel
breakdown enabled, which is executed by the Business Process Monitor
when requested by the user. Siebel SARM Analyzer logs the data into binary
SARM files (with .sarm extension) that are made available to SARM - User
Trace diagnostic tools for later production of .csv and .xml files.

The SARM - user trace breakdown diagnostic tool is activated on demand.

Siebel SARM records logs for each Siebel transaction activity in the web
server or in the application server. SARM also records data about how long
each transaction remains in each area of the application server. You can
then drill down within these logs to determine which SQL operations, or
parts of operations, were responsible for slow database web or application
server time.

Note: To work with the SARM - user trace breakdown diagnostic tool, you
must copy the Siebel Server Manager files located in the siebsrvr\bin
directory on the Siebel Application Server to the SiteScope machine.

The Siebel administrator who wants to run a transaction and identify its
problematic areas in Siebel should use the SARM - user trace breakdown
diagnostics.

Mercury Business Availability Center interacts with SARM (a Siebel tool)
using remote API calls to SiteScope. Those calls activate a batch file, which
copies files from Siebel, and then use the SARM analyzer to generate user-
readable files from the Siebel files. The user-readable files are then copied
using SiteScope remote API to Mercury Business Availability Center.



Chapter 23 » Using the SARM - User Trace Breakdown Diagnostic Tool

The diagnostic has two stages:

> In the first stage, you provide details on the data you want to process.
Mercury Business Availability Center searches all the SARM files at the site,
looks for the sessions of the specified user, fetches the appropriate files, runs
the SARM analyzer, and lists all the sessions used by the user as well as the
time frame information. For details, see “Using the SARM - User Trace
Breakdown Diagnostic Tool” on page 291.

> In the second stage, the data is displayed. You can then generate different
views and pie charts to display the data in a user-friendly manner. For
details, see “Running the SARM - User Trace Breakdown Diagnostic Tool” on
page 298.

Note: In both options, all the data is processed within the time frame that
you specify.

Using the SARM - User Trace Breakdown Diagnostic Tool

You can run the SARM - user trace breakdown diagnostic tool on data
obtained in different ways:

> You can provide information about the site, the user, and the time frame.
Mercury Business Availability Center searches all the SARM files at the site,
looks for the sessions of the specified user, fetches the appropriate files, runs
the SARM analyzer, and lists all the sessions used by the user as well as the
time frame information (for details, see “Running the SARM - User Trace
Breakdown Diagnostic Tool” on page 293).

> You can invoke a specific Business Process Monitor script for a site, a user,
and a specific time frame. Mercury Business Availability Center searches all
the SARM files at the site, looks for the sessions of the specified user, looks
for the script transactions, fetches the appropriate files, runs the SARM
analyzer, and lists all the sessions used by the user as well as the time frame
information (for details, see “Invoking a Specific Business Process Monitor
Script” on page 294).
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> You can select specific logs by using:

» Automatically collected web and application server logs (for details, see
“Using Automatically Collected Web and Application Server Logs” on
page 296)

» The SARM logs for a specific application server and web server (for
details, see “Using the SARM Logs for a Specific Web and Application
Server” on page 297)

» An already generated user session trace .xml file for a site, a user, and a
specific time frame

When you run the SARM - User Trace Breakdown diagnostic tool, the SARM
- User Trace Breakdown page indicates the status of each step in the
procedure (for details, see “Running the SARM - User Trace Breakdown
Diagnostic Tool” on page 298).

This section includes the following topics:

» “Running the SARM - User Trace Breakdown Diagnostic Tool” on page 293
> “Invoking a Specific Business Process Monitor Script” on page 294

» “Using Automatically Collected Web and Application Server Logs” on

page 296

“Using the SARM Logs for a Specific Web and Application Server” on
page 297

“Using a Pre-generated User Session Trace .XML File” on page 297
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Running the SARM - User Trace Breakdown Diagnostic Tool

You can view data about the transactions running in the web server(s) and
application server(s) at a specific site and for a specific user, in a specified
period of time.

To run the SARM - User Trace Breakdown diagnostics tool:

Click Applications > Business Availability Center for Siebel > SARM - User
Trace Breakdown to open the SARM - User Trace Breakdown Diagnostic Tool
page.

You can also access this page filtered for the selected CI, when you right-

click the CI and select the Siebel SARM option. For details, see “List of Menu
Options”.

5ARM - User Trace Breakdown Database Breakdown Tasks Process
SARM - User Trace Breakdown
Enterprizes: Isiehel 'I Uzer: I
From: May 17 2006 10:42:32 AM To: May 17 2006 10:52:32 AM

() Invoke Business Process Maonitor Script

(¥ Advanced Options

In the Enterprises list, select the Siebel site for which you want to view
SARM user trace breakdown data.

The value in the User box appears automatically when you select the
application. The appropriate user name has been entered manually by your
administrator after discovery has taken place. For details, see “General
Administration” in Application Administration.

Click the linked date in From or To to open a calendar and select a new date
and time if you want to change the default date and time.

4 You can then:

Invoke a specific Business Process Monitor script. For details, see “Invoking a
Specific Business Process Monitor Script” on page 294.

Run the SARM - user trace breakdown diagnostic tool on:
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» automatically collected web and application server logs. For details, see

“Using Automatically Collected Web and Application Server Logs” on
page 296.

» on the SARM logs of a specific application server and web server. For
details, see “Using the SARM Logs for a Specific Web and Application
Server” on page 297.

» on an already generated user session trace .xml file for a site, a user, and a

specific time frame. For details, see “Using a Pre-generated User Session
Trace . XML File” on page 297.

» Click Run to run the diagnostic tool.

Invoking a Specific Business Process Monitor Script

You can view data about the transactions of a specific script running in the
web server(s) and application server(s) at a specific site and for a specific
user, in a specified period of time.

To invoke a specific Business Process Monitor script:

1 Expand the Invoke Business Process Monitor Script area in the SARM - User
Trace Breakdown page.

(3]

(%) Invoke Business Process Manitor Script

Application: Iauiad_bpml;l Script: Isiebel_cannon_auiad_bpm1_29_10_04;I Host: Icookie_041109;|

Tranzactions:

login_cannon_aviad_bprnl
goto_accounts_cannon_aviad_bpm1
goto_assets_cannon_aviad_bpm1
goto_orders_cannon_aviad_bpm1
logout_cannon_aviad_bpril

Invoke Script
2 In the Application list, select the application.
3 In the Script list, select the script.

4 In the Host list, select the location of the Business Process Monitor running
the script.
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5 Click Invoke Script to invoke the script transactions.
6 You can then:
» Run the SARM - user trace breakdown diagnostic tool on:

» automatically collected web and application server logs. For details, see
“Using Automatically Collected Web and Application Server Logs” on
page 296.

» on the SARM logs of a specific application server and web server. For
details, see “Using the SARM Logs for a Specific Web and Application
Server” on page 297.

» on an already generated user session trace .xml file for a site, a user, and a
specific time frame. For details, see “Using a Pre-generated User Session
Trace . XML File” on page 297.

» Click Run to run the diagnostic tool.

Note: The Virtual User Generator script must be recorded using the Siebel
Web protocol. Select the Enable Siebel Breakdown checkbox while
configuring the Business Process Monitor in Monitor Administration. For
details, see “Adding and Editing Transaction Monitors” in End User
Management Data Collector Configuration.
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Using Automatically Collected Web and Application Server
Logs

You can run the SARM - user trace breakdown diagnostic tool on
automatically collected web and application server logs.

To use automatically collected Web and Application server logs:

1 Expand the Advanced Options area in the SARM - User Trace Breakdown
page.

%) advanced Options

fnalayze data in files:
O Autornatically collect files.

O Specify the SARM logs folders:

Application Servers: I

web Servers: I

O Specify a User Session Trace File:

User Session Trace File: I

Uzing SiteScope: Icherrl,l 'I

[ram

2 Select Automatically collect files to run SARM - user trace breakdown
diagnostics on all Web and application servers at the site. This is the default.

3 Select the appropriate SiteScope in the Using SiteScope list to use that
SiteScope to collect the data.

4 Click Run to run the diagnostic tool.
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Using the SARM Logs for a Specific Web and Application Server
You can run the SARM - user trace breakdown diagnostic tool on the SARM
logs of a specific application server and web server.

To use the SARM logs for a specific Web and Application server:
Expand the Advanced Options area in the SARM - User Trace Breakdown
page.

Select Specify the SARM logs folders to run SARM - user trace breakdown
diagnostics only on the specified web and application servers for the site:

a In the Application Servers box, enter the path to the SARM logs of the
application server(s).

b In the Web Servers box, enter the path to the SARM logs of the web
server(s).

Note: The paths are relative to the SiteScope machine.

Select the appropriate SiteScope in the Using SiteScope list to use that
SiteScope to collect the data.

Click Run to run the diagnostic tool (for details, see “Running the SARM -
User Trace Breakdown Diagnostic Tool” on page 298).

Using a Pre-generated User Session Trace . XML File

You can run the SARM - user trace breakdown diagnostic tool on an already
generated user session trace .xml file for a site, a user, and a specific time
frame.

To use a pre-generated User Session Trace File:

Expand the Advanced Options area in the Access the SARM - User Trace
Breakdown page.

Select Specify a User Session Trace File to work on an already generated user
session trace .xml file and in the User Session Trace File box, enter the path
to the trace file. The path is relative to the SiteScope machine.
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3 In the Using SiteScope list, select the appropriate SiteScope to use that
SiteScope to collect the data.

4 Click Run to run the diagnostic tool (for details, see “Running the SARM -
User Trace Breakdown Diagnostic Tool” on page 298).

Running the SARM - User Trace Breakdown Diagnostic Tool

When you run the SARM - User Trace Breakdown diagnostic tool, the SARM
- User Trace Breakdown page indicates the status of each step in the
procedure.

Check SiteScopes connectivity L ]

Load Web Servers' seszion data L ]

Extract Application Servers' session data L ]

Analyze results and prepare charts L ]

Processing:

Total Progress: L ]

» Check SiteScopes connectivity. When the status indicator shows running
stripes, the SiteScopes connectivity is being checked. When the status
indicator is pink, the extraction has completed.

> Load Web Servers’ session data. When the status indicator shows running
stripes, the Web server session data is being loaded. When the status
indicator is pink, the loading has completed.
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> Extract Application Servers’ session data. When the status indicator shows
running stripes, the application server session data is being extracted. When
the status indicator is pink, the extraction has completed.

> Analyze Results and Prepare Charts. When the status indicator shows
running stripes, the results are being analyzed and charts are prepared.
When the status indicator is pink, the loading has completed.

» Processing. The number of web servers that are being processed.

» Total Progress. Indicates the total progress of the SARM - User Trace
Breakdown diagnostic tool.

After the process is complete, the page closes and the diagnostic results are
displayed on the SARM - User Trace Breakdown - Analysis page (for details,
see below).

Results - Analysis Page
In the SARM - User Trace Breakdown - Analysis page, you can view:

» A chart that displays the segmentation between the Application Server time,
Web Server time, Network time, and Database time for all the requests that
were found in the files

» All the sessions information for the user and the site

» For each transaction, the timestamp of the session it belongs to, the session
id, the application server name, the average total time of all requests that
belong to that transaction, the number of request and the maximal request
time

» For each application server, the average application server time, the average
web server time, average database time, and the average total time for each
request that was executed on that application server

» For each request, the request detailed information

This section includes the following topics:

> “Summary” on page 300

> “Sessions” on page 303
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> “Transaction” on page 306

> “Requests” on page 311

» “Application Servers” on page 309

» “Displaying Instance Details” on page 316

Summary

The chart displays the segmentation between the Application Server time,
Web Server time, Network time, and Database time for all the requests that
were found in the files. For each request, the page displays the timestamp of
its session and the average request time.

|Site: whistle, User: wran, Frorm: 10/24/04 05:00:24 PM, To: 10/24/04 08:10:24 PM

<, y 5 i Transactions Application Servers Requests

Siebel Layer Breakdown

Avg. request time = 51.59439 seconds

B Web Server

B Application Server
B Database

I Metworl:

Note: The drillable data is only accessible through the charts (not through
the tables).
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Drilling down one of the segments in the chart provides a pie chart that
displays the segmentation between the sub areas of that segment. If there is
another level of specification (available in Siebel 7.7), you can then drill
down to the sub area level. For example, you can drill down the Application
Server layer to access the segmentation between the areas of Application
Server.

Siebel Layer Breakdown

Avg. request time = 48,673 seconds

B Application Server

B Object Manager

B Communications Server Service
2l Build Web Page

You can then click segments of the Area Breakdown chart to open the
corresponding Sub Area Breakdown chart (if it exists).
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The breakdown is as follows:

Layer Breakdown Area Breakdown Sub Area Breakdown

Web Server N/A N/A

Application Server Application Manager Request Receipt (sessID SeqlD)
Object Manager Session Re-Login

Communications Server | Communications Client
Services Invoke Method

Communications Server
Invoke Method

Build Web Page Build View Layout

Show Applet, Build View Data

Build Applet

Get View Layout

Database Database Connector N/A

Network N/A N/A

If Mercury Business Availability Center knows the transaction the request
belongs to, the page displays the transaction name. The application server
time, web server time, database time, and total time are also displayed. If the
request belongs to a transaction that was executed by a user request in the
previous page, Business Availability Center for Siebel also provides the
Business Process Monitor time of that transaction. You can also run the
Transaction Analysis report for the transaction (for details, see “Transaction”
on page 306).

You can click any part of the chart to get the tooltip that indicates the time
the transaction spent in the layer, area, or sub area.
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Sessions

Click the Sessions tab to open the sessions table.

|Site: whistle, User: wrun, From: 10/25/04 03:48:00 PM, To: 10/25/04 04:58:00 PM

Summary S acci Transactions Application Servers Requests

Bl E/a|

| afara ] w]

Summary Chart |

Session ID Date Avg. Layer Breakdown No. of Max. -
Request Requests Reques|
Time Time
[ de4.174d5.417ca324 10/25/04 03:56:36 P 43,2222 [N 15 213,208
[T aes17adsa17caz7c 10/25/04 03:55:56 P 426520 [N 27 230,465
[ ide4.17447.417ca369 10/25/04 03:55:32 pu 42,2012 [N 27 232,313
[T it4e4174de.417ca358 10/25/04 03:55:20 pM 440850 [ 27 232.3%
[0 iide4.174d5.417c2347 10/25/04 02:55:02 pe 44,24 [N 26 224,70
[ it4e4.174d4.417cazsf 10/25/04 03:54:55 P 50,4227 [N 27 263,644
[ H.ded.174d3.417ca338 10;25;11}&1 oz:54:48 pe 4z.966c [N 27 238,641
[ ii4e4.i74ce417ca2bs 10/25/04 03:52:37 P 42,0232 [N 27 235.87:
[ iges174caa17c2272 10/25/04 03:51:32 p 4e.4122 ([N 27 238.49¢
[ ded.i74cra17ca751 10/25/04 03:50:56 pa 45,19z [N 27 238,261
[ 1des174bea17ca20d 10/25/04 03:43:50 P 427622 [N 27 226.128
4 »
EE@ M web Server Ml Application Server Bl DataBase | Metwork

The default view shows all the sessions for the user and the site.

The page displays the following information for each session:

» Session Id. The ID of the session. You can drill the session ID to display
information about the session requests (for details, see “Requests” on

page 311).

Date. The timestamp of the session.

> Avg. Request Time (sec). The average time the request spent in the

session.

Layer Breakdown. The breakdown of the layer into its areas relative to
the time spent by the session in each area: Web Server, Application
Server, Database, and Network. Tooltips display the average time the
session spent in each area.
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> No. of Requests. The number of requests that ran in the session.

» Max Request Time (sec). The maximum time spent by a request in the
session.

Note: Scroll to the right to see the rest of the information.

» Task ID. The ID of the task the request belongs to.

> Application Server. The name of the application server on which the
session is running.

> Web Server. The name of the web server on which the session is running.

Note: The BPM Time is displayed only when the SARM User Session Trace
breakdown diagnostics has been run after invoking a BPM script monitoring
the Siebel Application. Some additional tuning of Siebel Application\Web
Server environment variables is required. This is due to the fact that the
flush ratio of SARM files is approximately 5 times slower in the Web Server
than in the Application Server, and therefore running SARM with the
default value of SARM_MaxFileSize variable may not be enough to have the
SARM user trace breakdown diagnostic tool return data (contact Mercury
Customer Support for additional information).
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You can select one or more sessions and click Summary to display a
summary chart for the sessions you selected.

24 dfare > 0]

4
L =

Session 1D Date Avg. Layer Breakdown No. of Max. -
Request Requests Reques|
Tine Time
1.4ed4.174d9.417ca3a4 10/25/04 03:56:36 pw 43,0222 NG 15 213.20¢
11.4ed.174d8.417ca37c 10/25/04 03:55:5¢6 pM 43,6525 [N 27 230,465
[ 14es17ad7.417c2365 10/25/04 03:55:32 pv 4z.2012 [ 27 232.31%
[ 1.4e4.174ds.417ca355 10/25/04 03:55:20 pM 440352 [ 27 232,387

M web Server Ml Application Server ll DataBase

3

Metwark

Siebel Layer Brealkdown

Avg. request time = 44,9196 seconds

B web Server

W Application Server
M Database

| Netwarlk

Use the Select all, Invert selection, and Select none buttons (shown below)

to help you select the sessions.

] B2 B8

For more details on the summary chart, see “Summary” on page 300.
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Transaction

Click the Transactions tab to open the transactions table.

Site! cannon, User: aviad_bprnd, Frorm: 11/2/04 04:01:04 AM, To: 11/2/04 05:11:04 AM

e s =

Transactions Appﬁcaﬁcm Servers

8lz/8

I 5 v+ ] Tl
Transacton MName Total Layer Breakdown BPM Mo.of Max. Date A
Time Time Requests Request
Tine

|| goto_orders cannon_aviad bprmil 0,142 _ 3 0,1156 117z/0
l_ goto assets cannon aviad bprnd 0.0824 .":"Dl:'licatic'n Server: 0,0326 53':. 32 0.0697 11/2f0
I_ goto accounts cannon awiad bpmil 00,1084 _ 2 0.07zg 11.!"2.!"0?
B login cannon avisd bpmi a.2e07 [ 14 0.2087 11/2/0
1
= goto orders cannon awiad bprnl 0,172 _ 3 01404 11.!"2.!"05
l_ goto assets cannon aviad bprad n.08a4 _ 2 0.0751 11,?'2;"05
B goto sccounts cannon swiad bpril 01027 _ 30,0748 11/2/0
T login cannon aviad bpmi ozo1+ [ 14 0.2055 11/2/0)
l_ goto orders cannon aviad bprml 01761 _ 2 0.1434 11,|"2,|"DE
I goto sssets cannon awiad berma  0.0827 [ 30,0763 11/2/0)
I_ goto accounts cannon awiad bprnl 0,1053 _ 2 0,0787 1i/z40
[T login cannon aviad bpmi o.zs [ 14 0.2422 11f2/0

%5 % Ea Summary Chart | M web Server B Application Server [l DataBase | Metwork

This view is provided only for the user used by the Business Process Monitor,
and not for a real user, in order to be able to process this data (for details, see
“Adding and Editing Transaction Monitors” in End User Management Data
Collector Configuration). This way, all the requests that belong to that
transaction are identified and data can be generated.
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Note: You must enable Siebel breakdown for the Business Process Monitor
script monitoring your Siebel application. This can be done while
configuring the Business Process Monitor transaction in the Admin >
Monitors, and selecting Enable Siebel breakdown in the Transaction
Breakdown Settings area (for details, see “Adding and Editing Transaction
Monitors” in End User Management Data Collector Configuration).

The page displays the following information for each transaction:

» Transaction Name. The name of the transaction.

» Total Time. The total time the transaction ran in Siebel.

» Layer Breakdown. The breakdown of the layer into its areas relative to the

Y Y VY Y

time spend by the transaction in each area: Web Server, Application Server,
Database, and Network. Tooltips display the average time the transaction
spent in each area.

BPM Time. This column displays the time the invoked transaction ran in
Business Process Monitor (only when the transaction is invoked using
Invoke Business Process Monitor Script). This value is larger than the value
in the Total Time column as it includes client time, network time, and so
forth.

No. of Requests. The number of transaction requests that ran in this
application server.

Max. Request Time. The maximum time spent by any of the requests in the
transaction.

Date. The date when the transaction ran.
Session ID. The Id of the session.
Task ID. The Id of the task the transaction belongs to.

Application Server. The name of the application server on which the
transaction ran.

Web Server. The name of the web server on which the transaction ran.
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Drilling down a transaction will display all the requests that belong to that
transaction (for details, see “Requests” on page 311).

Note: The BPM Time is displayed only when the SARM User Session Trace
breakdown diagnostics has been run after invoking a BPM script monitoring
the Siebel Application. Some additional tuning of Siebel Application\Web
Server environment variables is required. This is due to the fact that the
flush ratio of SARM files is approximately 5 times slower in the Web Server
than in the Application Server, and therefore running SARM with the
default value of SARM_MaxFileSize variable may not be enough for the
SARM user trace breakdown diagnostic tool to return data (contact Mercury
Customer Support for additional information).
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Application Servers
Click the Application Servers tab to open the Application Server table.

|Site: whistle, User: wrun, From: 10/25/04 03:48:00 PM, To: 10/25/04 04:58:00 PM |

Summary Sessions Transachons (application Servers| Requests
B8
RN EEE
Application Server Avg. Request Time Layer Breakdown MNo. of Requests Max. Request Time
I%VIE % %E Summary Chart M web Server Ml Application Server Ml DataBase | Metwork

Each application server is drillable and displays all the requests that were
executed on that application server.

The page displays the following information for each application server:

> Application Server. The name of the application server. You can drill the
session ID to display information about the application server (for details,
see “Requests” on page 311).

> Avg. Request Time. The average time spent by a request executing in this
application server.
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> Layer Breakdown. The time consumption breakdown by layers into its areas

relative to the time spent by the request in each area: Web Server,
Application Server, Database, and Network. Tooltips display the average
time the request spent in each area.

> No. of Requests. The number of requests that ran in this application server.

> Max. Request Time. The maximum time a request spent in this application

server.

Note: The BPM Time is displayed only when the SARM User Session Trace
breakdown diagnostics has been run after invoking a BPM script monitoring
the Siebel Application. Some additional tuning of Siebel Application\Web
Server environment variables is required. This is due to the fact that the
flush ratio of SARM files is approximately 5 times slower in the Web Server
than in the Application Server, and therefore running SARM with the
default value of SARM_MaxFileSize variable may not be enough for the
SARM user trace breakdown diagnostic tool to return data (contact Mercury
Customer Support for additional information).

You can select one or more application servers and click Summary to display
a summary chart for the application servers you selected. For more details
on the summary chart, see “Summary” on page 300.

Use the Select all, Invert selection, and Select none buttons (shown below)
to help you select the sessions.

[ [ Fh
BE | | w0
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Click the Requests tab to open the requests table. You can also access this

page by clicking a session ID in the Sessions main page, or by clicking an

application name in the Applications main page.

[site: whistle, User: wrun, From: 10/25/04 03:48:00 PM, To: 10/25/04 04:55:00 PM

Summary Sessions Transactons Application Seruers,n_'—‘.L
8l Eal
4] d]rrros | w|
Request Transacton Total Layer Breakdown BPM Date Session ID -
ID Time Time
0o 7975 [ 10/25/04 02:51:01 PM 11,424,173bc 41
O 1 s=.zz7 [ 10/25/04 02:51:01 PM 1,4e4,173bc 41
Oz 20044 [N 10/25/04 02:51:01 PM 11,424,173 41
Oz 1.ze1 [ 10/25/04 02:51:01 PM 11,4e4,173bc 41
S zse.zz1 [ 10/25/04 02:54:01 PM 11,424, 173bc 41
s 1zz.950 [ 10/25/04 02:51:01 PM '1,4e4,173bc 41
| s.z7z [ 10/25/04 02:51:01 PM 11.4e4,173bc 41
Oz 1z.4s1 [ 10/25/04 02:51:01 FM 11,4e4,173bc 41
|} zs.zs [ 10/25/04 02:51:01 PM 11,4e4,173bc 41
) s.zz7 [ 10/25/04 02:51:01 PM 11,4e4,173bc 41
0 1o ss.u4: [ 10/25/04 02:51:01 PM 11,4e4,173bc 41
11 Cerr | 10/25/04 02:51:01 PM 11,4e4.173bc 417
4 »
E E ﬂ Summary Chart | B web Server Bl Application Server Ml DataBase | Network

The page displays the following information for each request:

> Request ID. The ID of the request. You can drill the request ID to display

information about the area where the request ran (for details, see

“Displaying the Area Details” on page 313).

» Transaction Name. The name of the transaction the request belongs to.

» Total Time. The total time spent to execute a request.
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> Layer Breakdown. The time consumption breakdown by layers into its areas

relative to the time the request spent in each area: Web Server, Application
Server, Database, and Network. Tooltips display the average time the request
spent in each area.

BPM Time. This column displays the time the invoked request ran in
Business Process Monitor (only when the request is invoked using Invoke
Business Process Monitor Script). This value is larger than the value in the
Total Time column as it includes client time, network time, and so forth.

» Date. The date when the request ran.

» Session ID. The ID of the session on which the request ran.

Note: Scroll to the right to see the rest of the information.

» Task ID. The ID of the task the request belongs to.

» Application Server. The name of the application server on which the task

ran.

Web Server. The name of the web server on which the task ran.

Note: The BPM Time is displayed only when the SARM User Session Trace
breakdown diagnostics has been run after invoking a BPM script monitoring
the Siebel Application. Some additional tuning of Siebel Application\Web
Server environment variables is required. This is due to the fact that the
flush ratio of SARM files is approximately 5 times slower in the Web Server
than in the Application Server, and therefore running SARM with the
default value of SARM_MaxFileSize variable may not be enough for the
SARM user trace breakdown diagnostic tool to return data (contact Mercury
Customer Support for additional information).

You can select one or more requests and click Summary to display a
summary chart for the requests you selected.
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Use the Select all, Invert selection, and Select none buttons (shown below)
to help you select the sessions.

] B2 B8

For more details on the summary chart, see “Summary” on page 300.

Displaying the Area Details

In the request details page, click a request ID to display information about
the areas where the request ran.

[site: whistle, User: wrun, From: 10/25/04 03:48:00 PM, To: 10/25/04 04:55:00 PM

Summary «, 5 Transactions Application Servers Requests
Bz
R N R
Area Mame No. of Total Awg. Max Recursive  Non Exclusive Max Max
Sub Execution Execution Execution Inwvocations Recursive Memory Response Response
Areas Time Time Time Invocations Max Time SARM Time SARM
Allocated node node
Sub Area AppStringl AppString2
Application Sarver 1 2,893 2,893 2,893 u} 1
% QE‘ %E Summary Chart M web Server M Application Server ll DataBase | Metwork

The page displays the following information:

» Area Name. The name of the area where the request ran. You can drill the
area name to display information about its sub areas (for details, see
“Displaying the Sub Area Details” on page 315).
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» No. of Sub Areas. The number of sub areas in the area.

» Total Execution Time. The total time spent by the request executing in the

area.

Avg. Execution Time. The average time spent by the request executing in the
area.

Max Execution Time. The maximum time spent by the request executing in
the area.

Recursive Invocations. The number of times requests were invoked by other
requests (recursive invocation) in the area.

Non-Recursive Invocations. The number of times requests were invoked
(non-recursive invocation) in the area.

Exclusive Memory Max Allocated Sub Area. The amount of memory used by
requests that entered only this area.

Max Response Time SARM node App String 1. The name of the method
invoked or workflow process involved.

Max Response Time SARM node App String 2. The name of the method
invoked or workflow process involved.
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Displaying the Sub Area Details

In the area details page, click the area name to display information about its
sub areas where the request ran.

e ] ]

Sub Area Name Area Name MNo. af Total Avg. Max Recursive MNon |

Instances Execulion Execution Execution Invocations Recursive |

Time Time Time Invocations |
Feguest Receipt (zezzID Seqll] Application Server 1 2,893 2,895 2,893 a 1
4 3
Lvl% Qh %E Summary Chart | B web Server Bl Application Server Bl DataBase | Metwork

The page displays the following information for each sub area:

Sub Area Name. The name of the sub area where the request ran. You can
drill the sub area name to display information about the session requests
(for details, see “Displaying Instance Details” on page 316).

» Area Name. The name of the area where the sub area is located.

> No. of Instances. The number of instances of the request.

» Total Execution Time. The total time spent by the request executing in the

sub area.

Avg. Execution Time. The average time spent by the request executing in the
sub area.

Max Execution Time. The maximum time spent by the request executing in
the sub area.
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> Recursive Invocations. The number of times requests were invoked by other

requests (recursive invocation) in the sub area.

Non-Recursive Invocations. The number of times requests were invoked
(non-recursive invocation) in the sub area.

Note: Scroll to the right to see the rest of the information.

Exclusive Memory Max Allocated Instance. The amount of memory used by
requests that entered only this sub area.

Max Response Time SARM node App String 1. The name of the method
invoked or workflow process involved.

Max Response Time SARM node App String 2. The name of the method
invoked or workflow process involved.

Displaying Instance Details

In the sub area details page, click the sub area name to display information
about the instances where the request ran.

R N
Area Mame Sub Area Name Instance Total Awg. Max Recursive MNon e
Name Execution Execution Execution Invocations Recursive R
Time Time Time Invocations Ti
m
.}
Application Server Request Receipt (zessID SeqlD) 2,895 2,895 2,895 o 1
4 3
% % %E Summary Chart W web Server Ml Application Server Bl DataBase  Network
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The page displays the following information for each instance:

Area Name. The name of the area where the request ran.
Sub Area Name. The name of the sub area where the request ran.
Instance Name. The name of the instance where the request ran.

Total Execution Time. The total time spent by the request executing in the
instance.

Avg. Execution Time. The average time spent by the request executing in the
instance.

Max Execution Time. The maximum time spent by the request executing in
the instance.

Recursive Invocations. The number of times requests were invoked by other
requests (recursive invocation) in the instance.

Non-Recursive Invocations. The number of times requests were invoked
(non-recursive invocation) in the instance.

Note: Scroll to the right to see the rest of the information.

Max Response Time SARM node App String 1. The name of the method
invoked or workflow process involved.

Max Response Time SARM node App String 2. The name of the method
invoked or workflow process involved.

317



Part VI « Working with the Siebel Solution

318



24

Using the Process Diagnostic Tool

The Siebel process diagnostic tool enables you to view details of the Siebel
Application Server processes, for each monitored Siebel site.

This chapter describes: On page:
About the Processes Diagnostic Tool 319
Viewing Process Details 320
Using the Advanced Filter 322

Note: The diagnostic tools are enabled per Mercury Managed Services
customer. At any given time, only one customer within a center can use the
diagnostic tools.

About the Processes Diagnostic Tool

Using SiteScope, you can retrieve details of the Siebel Application Server
processes that are running, or were run, on each Siebel site. You can view the
details of all processes, regardless of status, or you can view only the
processes with a specific status. Similarly, you can choose to view process
details for all components in all component groups on all Siebel Application
Servers, or for specific components in specific component groups on specific
Siebel Application Servers.
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Note: To work with the Siebel process diagnostic tool, you must copy the
Siebel Server Manager files located in the siebsrvr\bin directory on the
Siebel Application Server to the SiteScope machine.

Viewing Process Details

When an application has performance/availability issues, the application
server icon is red (in Siebel Topology View). You may use the process
diagnostics to verify that all Siebel processes are up and running and that
none of the processes is using 100% CPU.

The process diagnostics enable you to view details about process
information from specific application servers for specified sites. The tool
filters processes by site, application server, component group, component,
process type, and process id.

Process

Erterprize! Isiebel vl Server: I—AII servers- vI Cormnponent group! I-AII Companent groups- ;I
Advanced Options: Siebel Commponent: -All cormponents-, Process Tepe: -All process types-, Using SiteScope: catapultl Ap

You enter the process input information: site name, application server
name, and component group in the Process Diagnostics page. The filter
returns, based on the filter criteria, a list of processes with information about
their memory usage and the CPU percentile columns.

To view a Siebel process diagnostics:

1 Click Applications > Business Availability Center for Siebel > Process to open
the Siebel Process Diagnostics page.

You can also access this page filtered for the selected CI, when you right-
click the CI and select the Show Processes option. For details, see “List of
Menu Options”.

2 In the Enterprises list, select the name of the site.
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In the Server list, select the name of the application server. Select All servers
if you want to display the process diagnostics for all the application servers.

In the Component Group list, select the name of the component groups.
Select All applications if you want to display the process diagnostics for all
the component groups.

If necessary, click Advanced Options to open the Process Diagnostics Tool -
Advanced Filter page (for details, see “Using the Advanced Filter” on
page 322)

Click Apply to display the process diagnostic information. The process
information you requested is retrieved from the Siebel Application Server(s)
and displayed on the Tasks Diagnostic Tool page.

Note the following:

» To sort the processes by a specific column, click the column heading.

IRININ]

To move between pages, use the First, Previous, Next, and Last arrows
above the table.

The processes detailed information is as follows:

>

>

>

Site: Icannon;l Server: I-AII seruers-;l Component group: I-Allcomponent groups-;l
Advanced Options: Using sitescope: rca3 Apply |
b= el
0 = ] )
Server Component group Component + Process Type Process ID CPU(a) Memory (KB}
cannon TxnRoute siebprac 2996 o 2188
Cannon TxnMerge siebproc 2980 (1} 2008
cannon SynchMgr siebmtsh 2972 ] 2396
cannon Systern SRProc siebrntsh 2112 0 2504
cannon Systern SREroker ziebrmtzh 3052 L] 1844

Server. The name of the server.
Component Group. The name of the component group.

Component. The name of the component.
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> Process Type. The name of the operating system process that deals with the
Siebel process. If the process does not have a task attached, then the
Component Group and Component columns are empty.

» Process ID. The process identifier.

» CPU (%). The percentage of the host machine CPU that the relevant process
instance is currently using.

» Memory (KB). The amount of memory (in KB) that the relevant process
instance is currently using.

Using the Advanced Filter
Use the advanced filter to filter the list of processes you want to display.

To use the Advanced Filter:

1 In the Process Diagnostics Tool page, click the Advanced Filter link to open
the Process Diagnostics Tool - Advanced Filter page.

Siebel Component:

Corpo ts-
Process Type: I-AII process typas- vl

Process Id: I

Uszing SiteScope: IADIDAS 'I

2 Select the Siebel component in the Siebel Components list. Select All
components if you want to display the process diagnostics for all the Siebel
components.

3 Select the process type in the Process Type list. Select All process types if you
want to display the process diagnostics for all the process types.

4 In the Process Id box, enter the process Id.
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5 In the Using SiteScope list, select the SiteScope.
6 Click OK to close the Advanced Filter page.
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Working With Deep Transaction Tracing

This chapter describes the Deep Transaction Tracing data available in
Dashboard. Deep Transaction Tracing provides a monitoring layer for
collecting information about the behavior of transactions within the target

machine.
This chapter describes: On page:
Introducing Deep Transaction Tracing Monitor 327
Viewing Deep Transaction Tracing Information in Dashboard 328
Deep Transaction Tracing Reports 331

Introducing Deep Transaction Tracing Monitor

Deep Transaction Tracing enables component level breakdown for your
Business Process Monitor transactions. This is achieved through integration
with Bristol’s TransactionVision application, to provide an additional level
of business process monitoring in Mercury Business Availability Center.

TransactionVision technology enables monitoring of a transaction at the
component level within a target machine. As the transaction flows through
the target machine via CICS, JMS, EJBs, servlets, and WebSphere MQ,
TransactionVision tracks and analyzes the interaction with each
component.

327



Part VII « Working with Deep Transaction Tracing Data

TransactionVision sends the data on the transaction’s path through the
monitored components to Mercury Business Availability Center; in Mercury
Business Availability Center, the received data is mapped to a Deep
Transaction Tracing monitor that is correlated with the appropriate Business
Process Monitor transaction. In Dashboard, you can then see availability
and performance information for the transaction within the target machine,
and you can open breakdown reports for the transaction at component
level.

Viewing Deep Transaction Tracing Information in
Dashboard

328

You can view Deep Transaction Tracing information for transactions in
Dashboard in the Deep Transaction Tracing View.

Note: The Deep Transaction Tracing View is added to the Views list in View
Explorer once the Deep Transaction Tracing package is installed. If the view
is not in the Views list, contact your administrator.
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The Deep Transaction Tracing View is displayed like any other view in
Dashboard. The view contains all Business Process CI types (such as Business
Process Group, Business Process Step, Business Process Transaction from
Location), and in addition contains all Deep Transaction Tracing Monitor
Cls. Its structure is as follows:

View! |Deep Transaction Tracing J

1,
= ..: Ceep Transackion Tracing Wiew
bprn_ptf2

@ loci

@ lacz

tv_prfl

@ Checkout

D 0 - Business Process Step

{é‘o“ Login - Deep Transaction Tracing Monitor

2 Login from loci -————  BPM Transaction from Location
= Login from locz <———— BPM Transaction from Location

@ Shapping

@ SubrnitOrdar

0= ®HH

F H

The Deep Transaction Tracing Monitor Cls in the view are dynamically
created by a Dynamic Node Factory, based on the incoming samples from
TransactionVision. Each Deep Transaction Tracing Monitor CI is given the
same name as the Business Process Monitor transaction it relates to, and is
added to the hierarchy under the relevant Business Process Step CI, using its
own icon.

Under the Business Process Step, you can see information on both the
emulated user experience (as shown for the BPM Transaction from Location
Cls) and on how the transaction behaved in the target server (as shown for
the Deep Transaction Tracing Monitor CI).

Performance (L #7  Awvailability @4° DT Total Impact DT Failed Impact DT Late Impact
CI Name Performance Awvailability DT Total Impact DT Failed Impact DT Late Impact
& ~ ™ .
2 Login v s Q+* 50 30 $o
= Login from locl + i - L
=z Login from locz * e Q+*
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The KPIs for the Deep Transaction Tracing Monitor are:

KPI

Description

Performance

Displays information on the performance of the
components within the target machine. The
displayed status is calculated by the
TransactionVision application. The status is
calculated in Mercury Business Availability Center
based on a value and threshold provided by
TransactionVision.

Availability

Displays information on availability of the
components within the target machine. The
displayed status is based on the objective values
defined in Mercury Business Availability Center.

DT Total Impact

Displays information on total financial loss for the
organization. This value is calculated by adding the
values of the DT Late Impact and the DT Failed
Impact KPIs. Status is based on the objective value
defined in Mercury Business Availability Center
(default threshold = $100).

DT Failed Impact

Displays information on financial loss due to
failure of the transaction within the target
machine. Status is based on the objective value
defined in Mercury Business Availability Center
(default threshold = $100).

DT Late Impact

Displays information on financial loss due to
failure to complete the transaction within a time
limit set in the TransactionVision application.
Status is based on the objective value defined in
Mercury Business Availability Center (default
threshold = $100).
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Deep Transaction Tracing Reports

From the Deep Transaction Tracing view, you can access reports in the
TransactionVision application that provide you with breakdown
information for the transaction at component level.

The reports are opened from the menu options for a Deep Transaction
Tracing Monitor CI in the Console and Filters tabs: Select Deep Transaction
Tracing Reports, then select the required report type from the displayed list.
TransactionVision opens in a new browser dialog box, displaying the
selected report for the relevant transaction.

In order for Mercury Business Availability Center to open the reports, you
must configure the URL to point to the TransactionVision machine, and the
required user name and password . For more information, see “Configuring
Parameters to Open the TransactionVision Reports” in Configuring and
Administering Applications.

Note: Your Web browser should be set to accept all cookies when working
with Mercury Business Availability Center. If this is not done, you may
encounter problems when drilling down to the Bristol TransactionVision
reports.

This section includes the following topics:

» “Tracking Report” on page 331
» “Service Level Report” on page 333

> “Component Topology Report” on page 334

Tracking Report

The Tracking Report menu option opens the Transaction Tracking Report,
which lists information for every instance (run) of the Business Process
Monitor transaction over a specified time period. The displayed information
includes start time, response time, and the result of the run.
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To see more detailed breakdown of behavior on the target machine for a run
of the transaction, click the Tx Class link to drill down to the Transaction
Details report; from there, click an event link to drill down to an event
details report.

» Transaction Tracking Report- (Show Form) Project: TEST

Transaction Tracking Report
(17513 transactions, showing 1-20)

Response Completion Result

: Start Time Time State State Label BpmTransaction BpmScript
Login 01/26/2006 09:45:23.038 0.05 Completed Success Login webSphere -
Login 01/26/2006 09:46:23.866 0.02 Cormpleted Success Login WebSphere -
Login 01/26/2006 09:47:23,957 0.03 Completed Success Login webSphere -
Login 01/26/2006 09:4&:21.957 0.02 Cormpleted Success Login WebSphere -
Login 01/26/2006 09:49:19,832 0.02 Completed Success Login webSphere -
Login 01/26/2006 09:50:20.191 0.02 Cormpleted Success Login WebSphere -
Login 01/26/2006 09:51:20.582 0.02 Completed Success Login webSphere -
Login 01/26/2006 09:52:21.159 0.02 Cormpleted Success Login WebSphere -
Login 01/26/2006 09:53:21 487 0.02 Completed Success Login webSphere -
Login 01/26/2006 09:54:21.346 0.02 Cormpleted Success Login WebSphere -
Login 01/26/2006 09:55:21.549 0.03 Completed Success Login webSphere -
Login 01/26/2006 09:56:2Z2 628 0.00 Cormpleted Success Login WebSphere -
Login 01/26/2006 09:57:22.719 0.02 Completed Success Login webSphere -
Login 01/26/2006 09:568:23 423 0.02 Cormpleted Success Login WebSphere -
Login 01/26/2006 09:59:23.844 0.02 Completed Success Login webSphere -
Login 01/26/2006 10:00:21.173 0.00 Cormpleted Success Login WebSphere -
Login 01/26/2006 10:01:21.173 0.02 Completed Success Login webSphere -
Login 01/26/2006 10:02:22.894 0.02 Cormpleted Success Login WebSphere -
Login 01/26/2006 10:03:25.,972 0.02 Completed Success Login webSphere -
Login 01/26/2006 10:04:20.379 0.02 Cormpleted Success Login WebSphere -

Go to page: I'I 'I Mext Mext 10 Last Page

For more detailed information on the report and on how to set viewing
options, refer to the TransactionVision documentation, available from the
Help menu in the TransactionVision application.
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Service Level Report

The Service Level Report menu option opens the Service Level Analysis
report, which provides a graphical view of response time for the transaction
over time. The displayed information includes average response time,
maximum response time, and transaction volume over each reporting time
period.

Service Level Analysis

6_

"

Response Time (sec)

Now Now' Now Nov Mov MNov Nov Dec
13 16 19 22 25 28 30 03 06 09 12 15 18 21 23 26 20 01 (4 OF 10 13 15 18 21 24 27 30 02 05 ¢

[=]
[=]

ec Dec Dec Dec Dec Dec Dec Dec Dec Jan Jan Jan Jan Jan Jan Jan Jan Jan Jan Jan Feb Feb F

- A

For more detailed information on the report and on how to set viewing
options, refer to the TransactionVision documentation, available from the
Help menu in the TransactionVision application.

333



Part VII « Working with Deep Transaction Tracing Data

Note: You need Adobe SVG Viewer 3 installed on your local machine to see
the Service Level Analysis report. Download from the Adobe Web site
http://www.adobe.com/svg/viewer/install/main.html.

Component Topology Report

The Component Topology menu option opens the RTM report, which
displays a top view map for the flow of information across components in
the target machine, over a specified time period. The report shows activity
for all components on the machine during the time period, not for any
individual transaction. The report also displays statistics on the interaction
between components (for example, failed, late, and total counts for events).

» Component Topology Analysis (Static Mode - Switch to Dynamic Mode ) Proje
PI3nTs By UlaD 2phans
[E—— =amer]
ronenmz-il
00722685
Shopping Cart
0402265

Planit= By ek Sphers
senrer]
ronenmz-i
0r072265

07072285 Shopping Servlet
Planit= By ek Sphers
senrer]
ronenmz-i

0r07as30

f=hopping j=p

K1

0078060

Inizrnafiviiviy
0072263

P

T 5= = Frey =
quoub Completed. Dirplayed 10 nodes.

rarfdd HH:mm
(hrticdfyyyy ) [~ Show all statistics

i ik (0206 2006 00:00
et Time tD:ILast 48 hours .. I Display Statistics Data Fru:um: iog/
ko lnzioz/2008 00:00

A (3rouping | a Edge | & | gyouk | Run Query | Save Set... | % || A Z00m | h | | @l | :Ck: ﬁ

{Marsdd vy HH:mm)
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For more detailed information on the report and on how to set viewing
options, refer to the TransactionVision documentation, available from the
Help menu in the TransactionVision application.
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CI menu option 15
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defining 105
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